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1.0 SCOPE
See TO10 Software Test Plan.
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20 APPLICABLE DOCUMENTS

2.1 Source Documents
e TO9 Test Case AVvnFPS TAF 1.0

2.2 Reference Documents
e Legacy NWS Test Case: Baseline_ AvnFPS_TAF_0OB8.1.

e TO10 Software Test Plan for the Advanced Weather Interactive Processing
System Project, Contract #DG133W-05-CQ-1067, January 2009.

e The Silver Spring NWS AWIPS | test bed application.
e Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

Test case verifies that the 30-Hour TAF functionality works properly with or without the
transmit privilege.

3.1  Assumptions, Constraints and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX, and pgAdmin Il1 are running.
e Data has been ingested.
e The Text Workstation has been started.

e This test case is a regression test of capabilities delivered in TO9 with the
introduction of the 30-Hour TAF.

e Actions, Results, and Requirements highlighted in yellow indicate
requirements and/or capabilities to be included in the scope of future task
orders. They are included here for purposes of continuity and traceability with
the original AWIPS 1 test case documents.

3.2 Recommended Hardware
See TO10 Software Test Plan, Section 2.2.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs

The AvnFPS Monitor dialog and configuration files are displayed and the results outlined in
section 4.0 are met. The AvnFPS GUIs to be tested include:

e AvVNnFPS Menu

e AvnFPS Monitor

e AvnFPS TAF Editor

e AvVNFPS Loader

e AvNnFPS QC

e AvNFPS Transmission Queue
e Directory
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4.0 TEST SCENARIO
Step # Action Result Pass/Fail
Test User should not be able to transmit a TAF product with xmit_privilege = ‘0’
1. From the CAVE menu bar, Mouse Button The AvnFPS Menu window appears.
(MB) 1 click ‘CAVE’ -> ‘New’ -> ‘Aviation’ ->
‘AvnFPS Menu...".

2. Verify user ‘Test2' is not present. The user ‘Test2' is not present.

3. Open a terminal and navigate to the A terminal opens.
operator’s local copy of the aviation The aviation configuration file is present.
configuration file (e.g., caveletc/aviation).

4. Edit the aviationForecasterConfig.xml file, The new forecaster and transmit privilege in
adding ‘Test2’ as a new forecaster and the aviationForecasterConfig.xml file is
setting the transmit privilege to ‘0’. saved.

Save the changes to the configuration file.

5. Close the terminal window. The terminal closes.

6. Close and restart the AvnFPS Menu (refer | The AvnFPS Menu window appears.
to step 1).

7. Verify user ‘Test2' is present. The user ‘Test2' is present.

8. Select the user ‘Test2'. The AvnFPS Monitor window opens.

With ‘local’ highlighted on the lower list,
MBL click the ‘TAFs’ button.

9. Verify that the following buttons are The listed buttons are enabled. The XMIT-
enabled: TAF Editor, Climate, Plot, and px2f, DATA-px2f, INGEST-px2f and Queue
Backup. button are displayed green.

Verify the following items are displayed in
green color:

XMIT-px2f, DATA-px2f, INGEST-px2f and
Queue button.

10. Select the TAF Editor button to edit the The AvnFPS TAF Editor window displays
TAF. without loading a TAF forecast (blank

screen).

11. Verify the Editor recipe tab near the top of No ‘Send’ button is present.
the TAF Editor is selected. The top row of buttons is in the stated order.
Verify that there is no ‘Send’ button in the The Viewer tab displays in the AvnFPS TAF
top row of buttons. Editor window.

Verify that the buttons appear in the
following order: ‘Load’, ‘Syntax’, ‘QC’,
‘Save’, and ‘Restore’.
Note that for TO 10, the ‘Send’ button
appears between the ‘QC’ and ‘Save’
buttons.
MBL click the Viewer tab.
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Step # Action Result Pass/Fail

12. Select ‘File’ -> ‘Close’ in the AvnFPS TAF The AvnFPS TAF Editor, AvnFPS Monitor,
Editor. and AvnFPS Menu windows close.
Select ‘File’ -> ‘Quit’ in the AvnFPS Monitor.
Click on the X’ in the AvnFPS Menu
window.

Test User is able to transmit a TAF product with xmit_privilege = ‘1’

13. Open a terminal and navigate to the aviation | A terminal opens.
configuration file (e.g., /cave/etc/aviation). The aviation configuration file is present.

14. Edit the aviationForecasterConfig.xml file by | The transmit privilege in the
setting the transmit privilege for user ‘Test' | aviationForecasterConfig.xml file is saved.
to ‘1"
Save the changes to the configuration file.

15. On the terminal, select ‘File’ -> ‘Close’. The terminal closes.

16. Restart the AvnFPS Menu by repeating step | The AvnFPS Menu window appears.
1 above.

17. Select the user ‘Test2'. The AvnFPS Monitor window opens.
With ‘local’ highlighted on the lower list,
MBL click the ‘TAFs’ button.

18. Verify that the following buttons are The listed buttons are enabled. The XMIT-
enabled: TAF Editor, Climate, Plot, and px2f, DATA-px2f, INGEST-px2f and Queue
Backup. button are displayed green.
Verify that the following items are displayed
in green color:
XMIT-px2f, DATA-px2f, INGEST-px2f and
Queue button.

19. Select the TAF Editor button to edit the The AvnFPS TAF Editor window displays
TAF. without loading forecast (blank screen).

20. Verify that the Editor tab near the top of the | The top row of buttons is in the stated order
TAF Editor is selected.
Verify that the following appear in the top
row of buttons, in the following order: ‘Load’,
‘Syntax’, ‘QC’, ‘Send’, ‘Save’, and ‘Restore’.
Verify the TAF Editor's menu bar contains
the ‘File’, ‘Options’, ‘Edit’, and ‘Help’ pull-
down menus.

21. Select the ‘Load’ button to load the TAF The AvnFPS Loader window displays along
forecast. with the different products and sites.

Verify the Forecast Type ‘Routine’ radio
button is selected.
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22. From the AvnFPS Loader window, select The AvnFPS Loader window closes.
any combination of products and sites. Then | The selected product and site data displays
select ‘latest’ from the ‘Initialize from:" drop- | and the associated site id displays on the
down menu and MBL1 click the ‘OK’ button. | first tab.
Note: If you want to select more than one The TAF(s) is/are editable.
products or sites, either MB1 click and drag
the cursor (this works for consecutive
items), MB1 click at the items while pressing
down the Ctrl key, or MB1 click and drag the
cursor while pressing down the Shift key.
Edit the TAF(s).

23. In the ‘Tools’ text field, use the pull-down One or more group Vvalid times changed to
menu to select the ‘AdjustTimes’ tool. reflect current hour.
Then MBL1 click the ‘Apply’ button to update
the TAF start times.

24, In the ‘Tools’ text field, use the pulldown One or more TAFs changed to reflect the
menu to select the ‘UseMetarForPrevailing’ | current METAR.
tool.
Then MBL1 click the ‘Apply’ button to update
the TAFs.

25. Select the ‘Syntax’ button to perform the The system attempts to decode all forecasts
Syntax Quality Control for TAF. and check their syntax.
If an error is found, continue to step #26. If any errors are found, the whole relevant
Otherwise continue to step #27. phrase is highlighted in‘color according to the

type of errors.

26. To view an explanatory message, MB1 the | An explanatory message displays in the
message display button at the very bottom | message log.
right corner of the 'AvnFPS TAF Editor'
dialog.
Verify an explanatory message displays.

217. To check the Quality Control (QC) of The AvnFPS QC pop-up window displays.
individual TAFs, MB3 click the ‘QC’ button.

28. To perform a current weather check, select | The system performs a quick check for

the Current Wx check box.
If Error found, continue to step #29, else
continue to step #30.

changing conditions while forecasts are
prepared or when a routine issue forecast is
prepared well in advance of the transmission
window. If there are no invalid entries found
during the checking process then the “Wx
QC - OK” message displays on the status
bar at the bottom of the screen. If current
observation and the weather in the first line
of the forecast do not match, an explanatory
message displays in the message log.
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29. To view a message of the highlighted text, The balloon message shows output of the
MB1 while pointing at the offending text. current weather check.
Note: If you have an error flagged, but are
certain that the forecast is correct and either
the software or directive is wrong, MB1
‘Clear Errors’ (located under the ‘File’ menu)
before MBL clicking ‘Send'.
30. Note: The forecast must successfully pass | The AvnFPS Send dialog window displays
QC in order to be sent. and verifies the Transmit time.
Select the ‘Send’ button.
3L Select a forecaster from the list and setthe | The AvnFPS Send dialog closes.
‘Transmit at’ time. The forecast is transmitted to the Queue in
Then MBL1 click the ‘OK’ button. the pending section.
Record the transmittime.
32. To view the transmission log file, select Verify that the file is in the pending directory.
‘Open Terminal window’ and type in the
following:
cd /awips/adapt/avnfps/3.4/xmit/pending
33. To view the forecast that was transmitted, The AvnFPS Transmission Queue dialog
MBL click the ‘Queue’ button on the displays with the following buttons are
AvnFPS Monitor GUI. enabled:
Close, Refresh, View, Remove, Retransmit,
and Help.
34. Under the Directory section, select the The forecast entry transmitted from Step 30
‘Pending’ pop-up button. displays on the list of the products waiting for
a specific time before they are transmitted.
35. Note: The transmission server checks the Verify that the transmitted forecast entry
queue every 15 seconds. When the displays on the list of the products that were
transmission time recorded in step 31 is successfully sent.
reached, the forecast is sent to the NWS
gateway. It may take awhile for the product
from the pending directory to appear in the
sent directory.
To verify the forecast entry that was
transmitted from Step 31 was sent
successfully, select the ‘Send’ pop-up
button under the Directory section.
36. To view the transmission log file, select Verify that the file is in sent directory.
‘Open Terminal window' and type in the
following:
cd /awips/adapt/avnfps/3.4/xmit/sent
37. MBL click the ‘Close’ button from the The AvnFPS Transmission Queue dialog

AvnFPS Transmission Queue dialog.

closes.
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38. In the AvnFPS TAF Editor window, MB1 The current TAF bulletin is saved into a

click the ‘Save’ button to save the current temporary text database product,

TAF. ‘CCCWRKTAF', where CCC is your node id
(provided the Text Workstation has been
started from the ‘CAVE’ -> ‘New' menu prior
to MB1 clicking the ‘Save’ button to save the
current TAF).

39. MBL click the ‘Clear’ button. The current TAF bulletin is removed.

40. Select the ‘Restore’ button to restore the The saved current TAF bulletin is restored

previously saved current TAF bulletin. and displayed on the screen (provided the

Text Workstation is started from the ‘CAVE’ -
> ‘New' menu prior to clicking the ‘Restore’
button to restore the previously saved current
TAF bulletin from the text database).

41. MBL click the ‘Clear’ button. The restored current TAF bulletin is
removed.

42. Select ‘Restore From’ under the ‘File’ menu. | The saved current TAF bulletin is restored
and displayed on the screen (provided the
Text Workstation is started from the ‘CAVE’ -
> ‘New' menu prior to clicking the ‘Restore’
button to restore the previously saved current
TAF bulletin from the text database).

43. Select a filename. The pop-up window displays along with the
filename.

44, MBL1 click the ‘OK’ button. The saved current TAF is restored and
displays on the screen.

45. Close all opened windows and exit the All windows close.

AvnFPS application.
46. End of test.
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50 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)

AvnFPS TAF Monitor Window's File pulldown's Quit selection shall provide the

SYSR2073.40 capability to close of AvnFPS TAF Monitor Window. 12

SYSR2073.48 The T_AF Edltor shall provide forecaster-spe_mﬁc functionality including syntax 25.29
checking, climate and current weather consistency checks.

SYSR2073.49 The TAF Editor Shi.i" a]low the user ;he capability to invoke the editor in either of 10-11
two distinct modes: edit mode and view mode.

SYSR2073.51 The TAF Edltor sha]l allow the user the capability to apply predefined operations 91.22
to the text in the editor.

SYSR2073.52 The TAF Editor shgll prpwde the predefined Load capability, which shall invoke 21
the forecast selection dialog.
The Forecast Selection Dialog shall provide the user the capability to load a text

SYSR2073.53 product based on the parameters of: product identifier, site, initialization option, | 22
and forecast type.
The TAF Editor shall provide the predefined Syntax Quality Check capability,

SYSR2073.54 | \yhich shall follow the guidance specified by NWSI 10-813. e
The TAF Editor shall provide the predefined Weather Check capability, which

SYSR2073.55 shall provide an indication of whether the current observation and the weather in | 28
the first line of the forecast are consistent.

SYSR2073.56 If inconsistent, Weather Check shall highlight the first line of the forecast. 28
The TAF Editor shall provide the predefined Climate Quality Check capability,

SYSR2073.57 which shall follow the prescribed algorithm cited in Appendix C of Aviation 27
Forecast Preparation System: System and User Guide, V3.5, 15 June 2007.

SYSR2073.60 The TAF Edltor shall provide }he predefined Save capability to save the current 38, 42-44
TAF bulletin as a temporary file.

SYSR2073.61 The TAF Editor shall provide the predefined Restore capability to restore a TAF 0
bulletin previously stored as a temporary file.

SYSR2073.62 gﬂﬁew Editor shall provide the predefined Send capability to send a TAF 30-31
The TAF Editor shall provide the predefined Clear capability to clear the current

e G TAF bulletin from the text editor. 39

SYSR2073.65 The TAF Editor shall allow the.user the capability to apply user-defined 99.94
operations to the text in the editor.

SYSR2073.70 The TAF' Editor's Merju Bar shall provide the user three distinct pulldown menus: 20
File, Options, and Edit.

SYSR2073.77 The TAF Editor's File pulldown's Close selection shall shut down the TAF Editor. | 12

SYSR2073.157 The aviation plug-in shall provide the operator the capability to configure the 9.7
names of the forecasters.
The AWIPS System shall create the TAF product as produced by the Aviation

SYSR2937 Services AVNFPS Application. ALL
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1.0 SCOPE
See TO10 Software Test Plan.
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3.0 TEST CASE DESCRIPTION

Test case verifies that the 30-Hour TAF functionality works properly with or without the
transmit privilege.

3.1  Assumptions, Constraints and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX, and pgAdmin Il1 are running.
e Data has been ingested.
e The Text Workstation has been started.

e This test case is a regression test of capabilities delivered in TO9 with the
introduction of the 30-Hour TAF.

e Actions, Results, and Requirements highlighted in yellow indicate
requirements and/or capabilities to be included in the scope of future task
orders. They are included here for purposes of continuity and traceability with
the original AWIPS 1 test case documents.

3.2 Recommended Hardware
See TO10 Software Test Plan, Section 2.2.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs

The AvnFPS Monitor dialog and configuration files are displayed and the results outlined in
section 4.0 are met. The AvnFPS GUIs to be tested include:

e AvVNnFPS Menu

e AvnFPS Monitor

e AvnFPS TAF Editor

e AvVNFPS Loader

e AvNnFPS QC

e AvNFPS Transmission Queue
e Directory
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4.0 TEST SCENARIO
Step # Action Result Pass/Fail
Test User should not be able to transmit a TAF product with xmit_privilege = ‘0’
1. From the CAVE menu bar, Mouse Button The AvnFPS Menu window appears.
(MB) 1 click ‘CAVE’ -> ‘New’ -> ‘Aviation’ ->
‘AvnFPS Menu...".

2. Verify user ‘Test2' is not present. The user ‘Test2' is not present.

3. Open a terminal and navigate to the A terminal opens.
operator’s local copy of the aviation The aviation configuration file is present.
configuration file (e.g., caveletc/aviation).

4. Edit the aviationForecasterConfig.xml file, The new forecaster and transmit privilege in
adding ‘Test2’ as a new forecaster and the aviationForecasterConfig.xml file is
setting the transmit privilege to ‘0’. saved.

Save the changes to the configuration file.

5. Close the terminal window. The terminal closes.

6. Close and restart the AvnFPS Menu (refer | The AvnFPS Menu window appears.
to step 1).

7. Verify user ‘Test2' is present. The user ‘Test2' is present.

8. Select the user ‘Test2'. The AvnFPS Monitor window opens.

With ‘local’ highlighted on the lower list,
MBL click the ‘TAFs’ button.

9. Verify that the following buttons are The listed buttons are enabled. The XMIT-
enabled: TAF Editor, Climate, Plot, and px2f, DATA-px2f, INGEST-px2f and Queue
Backup. button are displayed green.

Verify the following items are displayed in
green color:

XMIT-px2f, DATA-px2f, INGEST-px2f and
Queue button.

10. Select the TAF Editor button to edit the The AvnFPS TAF Editor window displays
TAF. without loading a TAF forecast (blank

screen).

11. Verify the Editor recipe tab near the top of No ‘Send’ button is present.
the TAF Editor is selected. The top row of buttons is in the stated order.
Verify that there is no ‘Send’ button in the The Viewer tab displays in the AvnFPS TAF
top row of buttons. Editor window.

Verify that the buttons appear in the
following order: ‘Load’, ‘Syntax’, ‘QC’,
‘Save’, and ‘Restore’.
Note that for TO 10, the ‘Send’ button
appears between the ‘QC’ and ‘Save’
buttons.
MBL click the Viewer tab.
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Step # Action Result Pass/Fail

12. Select ‘File’ -> ‘Close’ in the AvnFPS TAF The AvnFPS TAF Editor, AvnFPS Monitor,
Editor. and AvnFPS Menu windows close.
Select ‘File’ -> ‘Quit’ in the AvnFPS Monitor.
Click on the X’ in the AvnFPS Menu
window.

Test User is able to transmit a TAF product with xmit_privilege = ‘1’

13. Open a terminal and navigate to the aviation | A terminal opens.
configuration file (e.g., /cave/etc/aviation). The aviation configuration file is present.

14. Edit the aviationForecasterConfig.xml file by | The transmit privilege in the
setting the transmit privilege for user ‘Test' | aviationForecasterConfig.xml file is saved.
to ‘1"
Save the changes to the configuration file.

15. On the terminal, select ‘File’ -> ‘Close’. The terminal closes.

16. Restart the AvnFPS Menu by repeating step | The AvnFPS Menu window appears.
1 above.

17. Select the user ‘Test2'. The AvnFPS Monitor window opens.
With ‘local’ highlighted on the lower list,
MBL click the ‘TAFs’ button.

18. Verify that the following buttons are The listed buttons are enabled. The XMIT-
enabled: TAF Editor, Climate, Plot, and px2f, DATA-px2f, INGEST-px2f and Queue
Backup. button are displayed green.
Verify that the following items are displayed
in green color:
XMIT-px2f, DATA-px2f, INGEST-px2f and
Queue button.

19. Select the TAF Editor button to edit the The AvnFPS TAF Editor window displays
TAF. without loading forecast (blank screen).

20. Verify that the Editor tab near the top of the | The top row of buttons is in the stated order
TAF Editor is selected.
Verify that the following appear in the top
row of buttons, in the following order: ‘Load’,
‘Syntax’, ‘QC’, ‘Send’, ‘Save’, and ‘Restore’.
Verify the TAF Editor's menu bar contains
the ‘File’, ‘Options’, ‘Edit’, and ‘Help’ pull-
down menus.

21. Select the ‘Load’ button to load the TAF The AvnFPS Loader window displays along
forecast. with the different products and sites.

Verify the Forecast Type ‘Routine’ radio
button is selected.
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Test Case AvnFPS TAF 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0001

22. From the AvnFPS Loader window, select The AvnFPS Loader window closes.
any combination of products and sites. Then | The selected product and site data displays
select ‘latest’ from the ‘Initialize from:" drop- | and the associated site id displays on the
down menu and MBL1 click the ‘OK’ button. | first tab.
Note: If you want to select more than one The TAF(s) is/are editable.
products or sites, either MB1 click and drag
the cursor (this works for consecutive
items), MB1 click at the items while pressing
down the Ctrl key, or MB1 click and drag the
cursor while pressing down the Shift key.
Edit the TAF(s).

23. In the ‘Tools’ text field, use the pull-down One or more group Vvalid times changed to
menu to select the ‘AdjustTimes’ tool. reflect current hour.
Then MBL1 click the ‘Apply’ button to update
the TAF start times.

24, In the ‘Tools’ text field, use the pulldown One or more TAFs changed to reflect the
menu to select the ‘UseMetarForPrevailing’ | current METAR.
tool.
Then MBL1 click the ‘Apply’ button to update
the TAFs.

25. Select the ‘Syntax’ button to perform the The system attempts to decode all forecasts
Syntax Quality Control for TAF. and check their syntax.
If an error is found, continue to step #26. If any errors are found, the whole relevant
Otherwise continue to step #27. phrase is highlighted in‘color according to the

type of errors.

26. To view an explanatory message, MB1 the | An explanatory message displays in the
message display button at the very bottom | message log.
right corner of the 'AvnFPS TAF Editor'
dialog.
Verify an explanatory message displays.

217. To check the Quality Control (QC) of The AvnFPS QC pop-up window displays.
individual TAFs, MB3 click the ‘QC’ button.

28. To perform a current weather check, select | The system performs a quick check for

the Current Wx check box.
If Error found, continue to step #29, else
continue to step #30.

changing conditions while forecasts are
prepared or when a routine issue forecast is
prepared well in advance of the transmission
window. If there are no invalid entries found
during the checking process then the “Wx
QC - OK” message displays on the status
bar at the bottom of the screen. If current
observation and the weather in the first line
of the forecast do not match, an explanatory
message displays in the message log.
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29. To view a message of the highlighted text, The balloon message shows output of the
MB1 while pointing at the offending text. current weather check.
Note: If you have an error flagged, but are
certain that the forecast is correct and either
the software or directive is wrong, MB1
‘Clear Errors’ (located under the ‘File’ menu)
before MBL clicking ‘Send'.
30. Note: The forecast must successfully pass | The AvnFPS Send dialog window displays
QC in order to be sent. and verifies the Transmit time.
Select the ‘Send’ button.
3L Select a forecaster from the list and setthe | The AvnFPS Send dialog closes.
‘Transmit at’ time. The forecast is transmitted to the Queue in
Then MBL1 click the ‘OK’ button. the pending section.
Record the transmittime.
32. To view the transmission log file, select Verify that the file is in the pending directory.
‘Open Terminal window’ and type in the
following:
cd /awips/adapt/avnfps/3.4/xmit/pending
33. To view the forecast that was transmitted, The AvnFPS Transmission Queue dialog
MBL click the ‘Queue’ button on the displays with the following buttons are
AvnFPS Monitor GUI. enabled:
Close, Refresh, View, Remove, Retransmit,
and Help.
34. Under the Directory section, select the The forecast entry transmitted from Step 30
‘Pending’ pop-up button. displays on the list of the products waiting for
a specific time before they are transmitted.
35. Note: The transmission server checks the Verify that the transmitted forecast entry
queue every 15 seconds. When the displays on the list of the products that were
transmission time recorded in step 31 is successfully sent.
reached, the forecast is sent to the NWS
gateway. It may take awhile for the product
from the pending directory to appear in the
sent directory.
To verify the forecast entry that was
transmitted from Step 31 was sent
successfully, select the ‘Send’ pop-up
button under the Directory section.
36. To view the transmission log file, select Verify that the file is in sent directory.
‘Open Terminal window' and type in the
following:
cd /awips/adapt/avnfps/3.4/xmit/sent
37. MBL click the ‘Close’ button from the The AvnFPS Transmission Queue dialog

AvnFPS Transmission Queue dialog.

closes.
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38. In the AvnFPS TAF Editor window, MB1 The current TAF bulletin is saved into a

click the ‘Save’ button to save the current temporary text database product,

TAF. ‘CCCWRKTAF', where CCC is your node id
(provided the Text Workstation has been
started from the ‘CAVE’ -> ‘New' menu prior
to MB1 clicking the ‘Save’ button to save the
current TAF).

39. MBL click the ‘Clear’ button. The current TAF bulletin is removed.

40. Select the ‘Restore’ button to restore the The saved current TAF bulletin is restored

previously saved current TAF bulletin. and displayed on the screen (provided the

Text Workstation is started from the ‘CAVE’ -
> ‘New' menu prior to clicking the ‘Restore’
button to restore the previously saved current
TAF bulletin from the text database).

41. MBL click the ‘Clear’ button. The restored current TAF bulletin is
removed.

42. Select ‘Restore From’ under the ‘File’ menu. | The saved current TAF bulletin is restored
and displayed on the screen (provided the
Text Workstation is started from the ‘CAVE’ -
> ‘New' menu prior to clicking the ‘Restore’
button to restore the previously saved current
TAF bulletin from the text database).

43. Select a filename. The pop-up window displays along with the
filename.

44, MBL1 click the ‘OK’ button. The saved current TAF is restored and
displays on the screen.

45. Close all opened windows and exit the All windows close.

AvnFPS application.
46. End of test.
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50 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)

AvnFPS TAF Monitor Window's File pulldown's Quit selection shall provide the

SYSR2073.40 capability to close of AvnFPS TAF Monitor Window. 12

SYSR2073.48 The T_AF Edltor shall provide forecaster-spe_mﬁc functionality including syntax 25.29
checking, climate and current weather consistency checks.

SYSR2073.49 The TAF Editor Shi.i" a]low the user ;he capability to invoke the editor in either of 10-11
two distinct modes: edit mode and view mode.

SYSR2073.51 The TAF Edltor sha]l allow the user the capability to apply predefined operations 91.22
to the text in the editor.

SYSR2073.52 The TAF Editor shgll prpwde the predefined Load capability, which shall invoke 21
the forecast selection dialog.
The Forecast Selection Dialog shall provide the user the capability to load a text

SYSR2073.53 product based on the parameters of: product identifier, site, initialization option, | 22
and forecast type.
The TAF Editor shall provide the predefined Syntax Quality Check capability,

SYSR2073.54 | \yhich shall follow the guidance specified by NWSI 10-813. e
The TAF Editor shall provide the predefined Weather Check capability, which

SYSR2073.55 shall provide an indication of whether the current observation and the weather in | 28
the first line of the forecast are consistent.

SYSR2073.56 If inconsistent, Weather Check shall highlight the first line of the forecast. 28
The TAF Editor shall provide the predefined Climate Quality Check capability,

SYSR2073.57 which shall follow the prescribed algorithm cited in Appendix C of Aviation 27
Forecast Preparation System: System and User Guide, V3.5, 15 June 2007.

SYSR2073.60 The TAF Edltor shall provide }he predefined Save capability to save the current 38, 42-44
TAF bulletin as a temporary file.

SYSR2073.61 The TAF Editor shall provide the predefined Restore capability to restore a TAF 0
bulletin previously stored as a temporary file.

SYSR2073.62 gﬂﬁew Editor shall provide the predefined Send capability to send a TAF 30-31
The TAF Editor shall provide the predefined Clear capability to clear the current

e G TAF bulletin from the text editor. 39

SYSR2073.65 The TAF Editor shall allow the.user the capability to apply user-defined 99.94
operations to the text in the editor.

SYSR2073.70 The TAF' Editor's Merju Bar shall provide the user three distinct pulldown menus: 20
File, Options, and Edit.

SYSR2073.77 The TAF Editor's File pulldown's Close selection shall shut down the TAF Editor. | 12

SYSR2073.157 The aviation plug-in shall provide the operator the capability to configure the 9.7
names of the forecasters.
The AWIPS System shall create the TAF product as produced by the Aviation

SYSR2937 Services AVNFPS Application. ALL
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1.0 SCOPE
See TO10 Software Test Plan.
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20 APPLICABLE DOCUMENTS

2.1 Source Documents
e None

2.2 Reference Documents
e Legacy NWS Test Cases: OHD HydroGen-DCS3397-OB8.1.

e Software Test Plan for the Advanced Weather Interactive Processing System
Project, Contract #DG133W-05-CQ-1067, January 2009.

e Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

This test case demonstrates the creation of the XML file and a hydrograph for a point using
HydroGen.

3.1  Assumptions, Constraints and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX and pgAdmin Il are running.

e Actions, Results, and Requirements highlighted in yellow indicate
requirements and/or capabilities to be included in the scope of future task
orders. They are included here for purposes of continuity and traceability
with the original AWIPS | test case documents.

3.2 Recommended Hardware
See TO10 Software Test Plan.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs
The results outlined in section 4.0 are met.
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4.0

TEST SCENARIO

Step #

Action

Result

Pass/Fail

Note: This test case will need to be revised as the HydroG
paths, optional use of pgAdmin lIl).

en application is created (e.g., entering the correct directory

1. Open a terminal window. A terminal window opens.
Setup environment variables by executing the The environment variables are set to those
following commands: specifics input.
export db_name=<database> [Enter] (e.g.,
hd_ob81xxx)
export PGHOST=<database host> [Enter] (e.g.,
dx1)
export PGUSER=pguser [Enter]
3. Identify candidate test stations and SHEF codes for | A list of stations will be given.
generating a hydrograph by executing the following
query:
psql —d <database> -c
“select distinct (lid)
from fcstheight
where pe="HG' and ts="FF’ and lid in (select lid
from rating group by 1 having count(*) > 0);”
4. Perform the query below: Note the lid and pe for the selected station.
For the rest, the lid will be referred to as <lid>
Psql -d <database> - and pe as <pe>. If you are able to find a
“select * station, Skip to Step 6.
from HgStation;”
If you are unable to find a station that exists in
Note: Select one station that exists in both the list | 0oth lists, then pick a location id from the list
from Step 2 and the output from the query above. | 9enerated in Step 2, and not its lid.
5. Identify one type source for the selected station in | Query generated.
the height table by performing this query:
Psqgl —d <database> -c
“select distinct (ts)
from Height
where lid="<lid>";"
6. Insert a record for the selected location into the A record with the specified value is inserted
HgStation table: into the HgStation table.
psql —d <database> -c
“insert into HgStation
value (‘<lid>', ‘HG', ‘<obs ts>', ‘FE);”
7. For the station, insert an observation that is below | Query is generated, from the output list of

the rating curve by executing the following query:

observation, select the observation for which

the obstime column is the most recent. For this
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Step #

Action

Result

Pass/Fail

Note: This test case will need to be revised as the HydroGen application is created (e.g., entering the correct directory
paths, optional use of pgAdmin IlI).

psql —d <database> -c

“select *

from height

where lid = ‘<lid>" and pe="HG’ and ts="<obs ts>;"

observation note its value as <old stage> and
its obstime as <obstime>.

8. Perform the query below: Query is generated, based on the output list of
rating curve points, choose a stage below the
psql —d <database> -c smallest stage value. This stage will be
“select * referred to as <new stage>.
from rating
where lid="<lid>";"

9. Put the stage chosen in Step 7 into the observation | The observation chosen in Step 6 will change

chosen in Step 6 by perform the following query: such that its value is that chosen in Step 7.
Perform the query in next step (step 9) to

psql —d <database> -c verify.

“update height set value=<new stage>

where lid='<lid>" and ts='<obs ts>" and

obstime="<obstime>";"

10. Psql —d <database> -c Note the returned values for the columns as
Select hsa, rfc, rb <hsa>, <rfc>, and <rb>, respectively. They are
From location used in the next step.

Where lid="<lid>";

11. Create necessary ‘FE’ type source data by running | A window with the title of “Filter IDs” displays.
the following command:
<DIRECTORY> [Enter]

12. From the HSASs list in the window, select <hsa>. The window closes and output is sent to
From the RFCs list, select <rfc>. From the RBs list, | stdout. The first line of the output starts with,
select <rb> and click the “Done” button. “executing: <DIRECTORY>. The execution

finishes after a few seconds.

13. Edit the data in the test database to be for a Data in the database for the two tables are
duration other than instantaneous by executing the | edited so that the dur column is equal to
following queries: ‘1006’
psql —d <database> -c
“update height set dur= 1006
where lid ='<lid>’, and pe = ‘<pe>";”
psql —d <database> -c
“update fcstheight set dur = 1006
where lid = ‘<lid>" and pe = ‘<pe>’ and ts = ‘FE';"

14. Create the hg.cfg file to generate hydrographs for | The file hg.cfg is created.

the selected forecast point:
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Step #

Action

Result

Pass/Fail

Note: This test case will need to be revised as the HydroGen application is created (e.g., entering the correct directory
paths, optional use of pgAdmin IlI).

cd <DIRECTORY> [Enter]

cp hg.cfg.baseline hg.cfg [Enter]

15.

Edit the hg.cfg file as follows:

Replace “xxx" with “<wfo>" after the equal sign in
the lines setting the values for wfoXMLIist,
wfoHGlist, wfoHistoryList, and wfo. Be sure to set
it to be all caps for the wfo line.

Set the value for DBname to be equal to
<database>

Comment out the lines setting rb, Idad, and
webserver, by inserting a ‘#' at the beginning of the
lines.

Insert the following two lines at the end of the file:
Fdo = “<space bar>TEST DISCLAIMER<space
bar>" [Enter]

Title = “TEST TITLE" [Enter]

The hg.cfg file updates.

16.

Execute HydroGen to generate an XML file and a
hydrograph for the chosen forecast point:

cd /awips/hydroapps/HydroGen/bin [Enter]

run_hg-genXML

HydroGen executes. After completion, files
are placed in each of these two directories:

<DIRECTORY>
<DIRECTORY>

17.

In the images directory, open up the file that has a
name that includes the station’s lid." Verify the
following:

e It should be a hydrograph with a NOAA
water mark in the background.

o Inthe graphic, a box in the upper left
corner of the plot area should contain
within it the phrase “TEST DISCLAIMER”
in green.

e Inthe graphic, the title, located at the top
of the graphic, should say “TEST TITLE".

o If the graphic is produced, this
requirement is verified, since the duration
for the data was changed from 0 to 1006.

Verified.

18.

In the xml directory, open up the file that has a
name that includes the station’s lid and look at the

Verified.
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Step #

Action

Result

Pass/Fail

Note: This test case will need to be revised as the HydroGen application is created (e.g., entering the correct directory

paths, optional use of pgAdmin IlI).

entry for the changed observation. The easiest way
to find the entry is to search for <new stage>. The
flow value corresponding to the <new stage> value
should be -999.
19. Undo the changes made in Step 7 and 13 by The original duration code and observed value
executing the following queries: are recovered.
psql —d <database> -c
“update height set dur=0
where lid ='<lid>", and pe = ‘<pe>'";”
psql —d <database> -c
“update fcstheight set dur =0
where lid = ‘<lid>" and pe = ‘'<pe>’ and ts = ‘FE';"
“psgl —d <database> -c
update the height set value=<old stage>
where lid="<lid>" and ts="<obs ts>" and
obstime="<obstime>";"
20. Exit the terminal Terminal exits.
End of Hydroview Test
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5.0 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)
SYSR TBD
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1.0 SCOPE
See TO10 Software Test Plan.
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20 APPLICABLE DOCUMENTS

2.1 Source Documents
e Text Products 1.0

2.2 Reference Documents

e Legacy NWS GFE Test Cases: Acceptance Test Case ID Number: ac010;
tp001-tp031; ui029-ue031; and ui45.

e Legacy NWS GFE Test Cases for Test Areas AC — VP.
e Section 3.1.3 of the AWIPS D-2D User’s Manual Build 8.1.

e Software Test Plan for the Advanced Weather Interactive Processing System
Project, Contract #DG133W-05-CQ-1067, January 2009.

e The Silver Spring NWS AWIPS | test bed application.
e Release OB8.2 of the Weather Event Simulator (WES).
e Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

This test case demonstrates the capability of the Text Products functionality contained in GFE.
Products include the Area Forecast Discussion (AFD); Area Forecast Matrices (AFM); Coded
Cities Forecast (CCF); Fire Weather Forecast (FWF); Fire Weather Forecast Tabular
(FWFTabular); Fire Weather Matrices (FWM); Point Forecast Matrices (PFM); Tabular State
Forecast (SFT); Special Weather Statement (SPS); Hazardous Weather Outlook (Hazard_ HWO);
Non-Precipitation (Hazard_NPW); FireWx Watch/Warning (Hazard_RFW); Convective Watch
(Hazard_WCN); and Winter Wx Product (Hazard_WSW).

3.1  Assumptions, Constraints, and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX and pgAdmin Il are running.
e The GFE Perspective is displayed.
e Data has been ingested.
e Several weather elements are loaded.

e There are multiple grids available for the weather elements (at minimum T,
Td, Wind, Wx, and Hazards weather elements).

e Grids are populated with model data and all interpolation processes have been
done. In addition, the forecast has been saved.

e The edit areas for CCF, FWM PFM and SFT text products have been created.

e A Convective Watch (e.g., Severe Thunderstorm or Tornado Watch) has been
ingested.

e Actions, Results, and Requirements highlighted in yellow indicate
requirements and/or capabilities to be included in the scope of future task
orders. They are included here for purposes of continuity and traceability with
the original AWIPS 1 test case documents.

3.2 Recommended Hardware
See TO10 Software Test Plan, Section 2.2.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs
The Text Products will be returned and the results outlined in section 4.0 are met.
3.4.1 GFE GUIs Tested
e Publish To Official
e Process Monitor
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e Formatter Launcher
e Local Formatter
e Define Text Products
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40 TEST SCENARIO

Step # Action Result Pass/Fail
Product Generation
1. Bring up the Process Monitor dialog by The Process Monitor dialog opens.
selecting ‘Products’ -> ‘Process Monitor'.
2. Bring up the Formatter Launcher dialog by As each product is chosen, a new tab
selecting ‘Products’ -> ‘Formatter Launcher'. appears in the Formatter Launcher
Select each of the following products in the dialog.

Products list:

- Area Forecast Discussion (AFD)

- Coded Cities Forecast (CCF)

- Hydrologic Outlook (ESF)

- Fire Weather Forecast (FWF)

- Fire Weather Forecast Tabular (FWFTabular)
- Fire Weather Matrices (FWM)

- Spot Forecast (FWS)

- NowCast (NOW)

- Point Forecast Matrices (PFM)

- Public Information Statement (PNS)

- Fire Danger Statement (RFD)

- Tabular State Forecast (SFT)

- Special Weather Statement (SPS)

- Zone Forecast Product (ZFP)

- Flood Watch (Hazard_FFA)

- Hazardous Weather Outlook (Hazard_HWQO)
- Non-Precipitation (Hazard_NPW)

- FireWx Watch/Warning (Hazard_RFW)
- Convective Watch (Hazard_WCN)

- Winter Wx Product (Hazard WSW)

3. Cycle through each tab in the Formatter Each product is run through the Formatter
Launcher dialog, set a zone selection for those | Launcher. After each formatter has
products that require one, MB1 click the ‘Run finished, the output text displays in the

Formatter' S5€ icon, then select default entries | 12t Window.

from the individual dialogs for each product.

4. Note in the Process Monitor Dialog that all of
the items are queued to run, and one is running.

5. Look at each product and verify that it seems Verified.

reasonable. Look at the log using the @ The tab closes.

icon. Scan the log for any errors. If a product
fails, the output text will not be displayed; rather
the log window will be displayed with the error.
After each product has been verified, click the
red ‘X’ to dismiss that tab.
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Test Case Text Products 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0003

Step #

Action

Result

Pass/Fail

6.

Repeat steps 3 - 5 for the Site Specific
Forecasts (SPOT), FWS product.

The product is run through the Formatter
Launcher. After each formatter has
finished, the output text displays in the
text window.

Repeat steps 3 - 5 for the Area Forecast
Matrices, AFM product.

The product is run through the Formatter
Launcher. After each formatter has
finished, the output text displays in the
text window.

After all of the products have been run without
errors, complete steps 9 — 10. Then repeat
steps 1 — 2, except change the issuance time
and other options on each product generation
Values dialog that is presented.

As expected.

Publish all data to the Official database
selecting ‘Products’ -> ‘Publish To Official’.
From the Publish To Official dialog, select ‘Set
Selected’ and then select ‘Publish’.

The ‘Publish To Official’ dialog appears.

The selected grids are published. The
‘Publish To Official’ dialog closes.

10.

Initialize the required edit areas for this test by
opening up a terminal window, changing your
directory to the GFESuite "bin" directory, and
running this command:

run/setupTextEA

11.

Test the Baseline and Region versions of the
formatters:

From the Local Formatter dialog, MB1 click on
‘Products’ -> ‘Baseline’. Run each Baseline
product to completion and verify that it produces
reasonable output. From the Local Formatter
dialog, MB1 click on ‘Products’ -> ‘Region’.

Run each Region product to completion and
verify that it produces reasonable output.

As expected.

12.

Create a new table product by selecting ‘GFE’ -
> ‘Define Text Products’. This brings up the
Define Text Products dialog. Over the left
column (Text Products), MB3 popup and select
‘New.... Enter ac010 as the name of the
product, and ensure that the type is ‘table’.
MB1 click ‘OK’.

A table template is displayed in the
python window.

13.

Modify the edit areas. From the Python editor
window, MB1 click on ‘File’ -> ‘Save’, then ‘File’
-> ‘Exit’. Close the Define Text Products dialog
after verifying that ‘ac010’ appears in the dialog
window.

Verified.

14.

From the Formatter Launcher dialog's Product
menu, select only the ‘ac010’ entry. Then run
the product.

The product is generated and the output
appears in a new Python window.
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Step # Action Result Pass/Fail

15. | Delete the ‘ac010’ table product by selecting The entry is deleted after the confirmation
‘GFE’ -> ‘Define Text Products’. This brings up | message is answered.

the Define Text Products dialog. Over the left
column ‘ac010’ entry, MB3 popup and select
‘Delete...". A confirmation dialog is displayed.

Press ‘OK..
16. | Close the External Programs (e.g., Process The External Programs/Process Monitor
Monitor) dialog. Close the Formatter Launcher | and Formatter Launcher dialogs close.
dialog.
End of Test
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50 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)
SYSR2069 The AWIPS system shall implement the GFE Formatter Launcher.
SYSR2070 The AWIPS system shall implement the GFE Formatter Data Interface.

The AWIPS System shall create the FWS - Site Specific Forecasts (SPOT)
product as produced by the Public and Fire Weather Services GFE

SYSR2997 Application.

The AWIPS System shall create the NOW - Short Term Forecast product as
SYSR2998 produced by the Public and Fire Weather Services GFE Application.

The AWIPS System shall create the AFM - Area Forecast Matrices product as
SYSR3004 produced by the Public and Fire Weather Services GFE Application.

The AWIPS System shall create the RFD — Rangeland Fire Danger product
as produced by the Public and Fire Weather Services Text Workstation Editor
SYSR3049 Application.
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1.0 SCOPE
See the TO10 Software Test Plan.
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2.0 APPLICABLE DOCUMENTS

2.1  Source Documents
e Derived Parameters-Gridded

2.2 Reference Documents

e TO10 Software Test Plan for the Advanced Weather Interactive Processing
System Project, Contract #DG133W-05-CQ-1067, January 2009.

e The AWIPS D-2D User’s Manual Build 8.1.

e The Silver Spring NWS AWIPS 1 test bed application.
e Release OB8.2 of the Weather Event Simulator (WES).
e Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

This test case demonstrates the display of derived parameters from gridded data developed as
part of the TO10 tasking. Display of the parameters infers database storage completed. In
addition, changes to the baselined volume browser implemented during TO10 will be tested.

3.1  Assumptions, Constraints, and Preconditions

TO10 software has been installed successfully.

CAVE, EDEX and pgAdmin Il1 are running.

An internet connection is available.

Live gridded data flow. Canned data can be substituted if the live data flow
does not contain the data required to test specific implemented derived
parameters.

e Localization previously set.

e A random sample of derived parameters will be demonstrated.

e TO10 testing will begin with step 45 of these procedures. Regression testing
of steps 1-44 will occur prior to DT (during PDT). Results of these procedures
will be included in the Final TO10 test report.

3.2 Recommended Hardware
See TO10 Software Test Plan, Section 2.2.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4 - Test Outputs
The images and data will be displayed in CAVE.
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DCN AWP.TE.SWCTR/T10-0004

4.0 TEST SCENARIO

Step Action Result Pass/Fail

1. From the test workstation open CAVE. CAVE successfully launches. The 5-D panel (4

smaller panels on the left and one larger main panel)
displays.

2. Zoom so that a CONUS-sized area The main panel displays an area centered on the
displays centered on approximately CONUS that includes some of Mexico and Canada.
Kansas City.

3. Open the Volume Browser by selecting | Volume Browser opens. The user is able to make
‘Volume’, ‘Browser...". selections from Sources, Fields, and Planes.

Thickness (dz)

4, Ensure the browser is in Plan view. The derived parameter 1000-500mb thickness is
Under Sources select ‘Grid’ and ‘GFS displayed in the main CAVE window.

40'. For Fields select ‘Hgt...Pres’ and
‘Thickness'. In Planes select ‘Pres’, ‘Misc
Layers’, '1000-500mb’. Select ‘Load'".
Note: If there are multiple entries under
the Product Selection List, select a single
entry and then ‘Load’.

5. Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE

window.

6. In the Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all".

Relative Humidity (RH)

7. In the Volume Browser, under Sources, | The derived parameter relative humidity is displayed
select ‘Grid’ and ‘NAM 40'. For Fields in the main CAVE window.
select ‘Moist’ and ‘RH'. In Planes select
‘Pres’, ‘500mb’. Select ‘Load’. Note: If
there are multiple entries under the
Product Selection List, select a single
entry and then ‘Load".

8. Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE

window.

9. In the Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'.

Wind Speed (wSp)

10. | Inthe Volume Browser, under Sources, | The derived parameter 250mb wind isotachs is
select ‘Grid’ and ‘GFS 90'. For Fields displayed in the main CAVE window.
select ‘Wind’ and ‘Wind Isotachs’. In
Planes select ‘Pres’, 250 mb'’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load’.

11. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE

window.
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DCN AWP.TE.SWCTR/T10-0004

Step Action Result Pass/Fail
12. | In the Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'".
Dewpoint Dep (DpD)
13. | In the Volume Browser, under Sources, | The derived parameter dewpoint dep is displayed in
select ‘Grid’ and ‘NAM40'. For Fields the main CAVE window.
select ‘Moist’ and ‘Dewpoint Dep’. In
Planes select ‘Pres’, ‘850mb’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load’.
14. | Select ‘Clear from the menu bar. The prior display is cleared from the main CAVE
window.
15. | Inthe Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'.
Dewpoint Temperature (DpT)
16. | Inthe Volume Browser, under Sources, | The derived parameter dewpoint is displayed in the
select ‘Grid’ and ‘NAM12'. For Fields main CAVE window.
select ‘Moist’ and ‘Dewpoint’. In Planes
select ‘Pres’, ‘700mb’. Select ‘Load'.
Note: If there are multiple entries under
the Product Selection List, select a single
entry and then ‘Load’.
17. | Select ‘Clear from the menu bar. The prior display is cleared from the main CAVE
window.
18. | In the Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'.
Specific Humidity (SHx)
19. | In the Volume Browser, under Sources, | The derived parameter specific humidity is displayed
select ‘Grid’ and ‘RUCS80'. For Fields in the main CAVE window.
select ‘Moist’ and *Specific Humidity’. In
Planes select ‘Pres’, ‘1000mb’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load".
20. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
21. | Inthe Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'.
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DCN AWP.TE.SWCTR/T10-0004

Step Action

Result

Pass/Fail

Equiv Potential Temperature (EPT)

22. | Inthe Volume Browser, under Sources,
select ‘Grid’ and ‘NAM40'. For Fields
select ‘Moist’ and ‘ThetaE'. In Planes
select ‘Pres’, ‘925mb’. Select ‘Load'.
Note: If there are multiple entries under
the Product Selection List, select a single
entry and then ‘Load’.

The derived parameter equiv. potential temperature
is displayed in the main CAVE window.

23. | Select ‘Clear’ from the menu bar.

The prior display is cleared from the main CAVE
window.

24. | In the Volume Browser select ‘Edit’,
‘Clear all'.

The prior Volume Browser selections are cleared.

Potential Temperature (PoT)

25. | Inthe Volume Browser, under Sources,
select ‘Grid’ and ‘GFS40'. For Fields
select ‘Temp’ and ‘Potential Temp'. In
Planes select ‘Pres’, ‘925mb’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load’.

The derived parameter potential temperature is
displayed in the main CAVE window.

26. | Select ‘Clear’ from the menu bar.

The prior display is cleared from the main CAVE
window.

27. | Inthe Volume Browser select ‘Edit’,
‘Clear all'.

The prior Volume Browser selections are cleared.

Mixing Ratio (mixRat)

28. | In the Volume Browser, under Sources,
select ‘Grid’ and ‘RUCA40'. For Fields
select ‘Moist and ‘Mixing Ratio’. In
Planes select ‘Pres’; ‘1000mb’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load".

The derived parameter mixing ratio is displayed in
the main CAVE window.

29. | Select ‘Clear’ from the menu bar.

The prior display is cleared from the main CAVE
window.

30. | Inthe Volume Browser select ‘Edit’,
‘Clear all'.

The prior Volume Browser selections are cleared.

Wet Bulb Temperature (TW)

31. | Inthe Volume Browser, under Sources,
select ‘Grid’ and ‘GFS40'. For Fields
select ‘Temp’ and ‘Wet Bulb Temp. In
Planes select ‘Pres’, ‘925mb’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load’.

The derived parameter wet bulb temperature is
displayed in the main CAVE window.
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Step Action Result Pass/Fail
32. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
33. | Inthe Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'.
Streamline Analysis
34. | Inthe Volume Browser, under Sources, Isotachs for 250mb display.
select ‘Grid’ and ‘GFS40'. For Fields
select ‘Wind Isotachs'’. In Planes select
‘Pres’, '250'. Select ‘Load’.
35. | RMB click and hold over the wind speed | Streamlines for 250mb display. The isotach display
legend. Select “Load as Streamline”. is removed from the display.
Turn off (Unload) the isotach display.
36. | RMB click and hold over the Streamline | Image of isotach speeds for 250mb displays under
legend. Select “Load as Image”. the streamlines. The streamlines should roughly
follow the main band of jet stream winds.
37. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
38. | Inthe Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'.
39. | Repeat steps 34-38 using the NAM40 Image of isotach speeds for 700mb displays under
grid and 700mb for the pressure level. the streamlines. The streamlines should roughly
follow the main band of jet stream winds.
40. | From the menu bar change the density The number of streamlines either decreases or
of the streamlines. increases depending on the density chosen.
41. | Repeat steps 34 and 35 (don't display as | Streamlines for 1000mb display.
an image) using the NAM12 grid and
1000mb.
42. | Zoom over a feature such as a “L" or “H” | Streamlines increase in density and detalil.
pressure center.
43. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
44, | Inthe Volume Browser select ‘Edit’, The prior Volume Browser selections are cleared.
‘Clear all'.
End of TO9 Test
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Test Case Derived Parameters-Gridded 3.0 (Draft)

DCN AWP.TE.SWCTR/T10-0004

Step Action Result Pass/Fail
Begin TO10 Test
The following steps will request data via the Baseline Volume Browser
Potential Vorticity
45, | Inthe Volume Browser, under Sources, The derived parameter Potential Vorticity is
select ‘Grid’ -> ‘GFS40'. For Fields select | displayed in the main CAVE window.
‘Derived’ -> ‘Pot Vorticity'. In Planes
select ‘Pres’ -> ‘500mb’. Select ‘Load'.
Note: If there are multiple entries under
the Product Selection List, select a single
entry and then ‘Load'".
46. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
47. | In the Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all".
Relative Vorticity
48. | In the Volume Browser, under Sources, | The derived parameter Relative Vorticity is displayed
select ‘Grid’ -> ‘NAM12'. For Fields in the main CAVE window.
select ‘Derived’ -> ‘Rel Vorticity'. In
Planes select ‘Misc’ -> ‘Surface’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load’".
49. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
50. | Inthe Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all".
3-Hour Precipitation Accumulation
51. | Inthe Volume Browser, under Sources, | The derived parameter 3 Hr Precipitation
select ‘Grid’ -> ‘RUC80'. For Fields Accumulation is displayed in the main CAVE
select ‘Sfc/2D’ -> '3 Hr Precip Accum’. In_{ window.
Planes select ‘Misc’ -> ‘Surface’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load'".
52. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
53. | Inthe Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all".
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DCN AWP.TE.SWCTR/T10-0004

Step Action Result Pass/Fail
Storm Relative Flow Right Mover
54. | Inthe Volume Browser, under Sources, | The derived parameter Storm Relative Flow RM is
select ‘Grid’ -> ‘NAM80'. For Fields displayed in the main CAVE window.
select ‘Other’ -> ‘Storm Rel Flow RM'. In
Planes select ‘Misc’ -> ‘Surface’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load’.
55. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
56. | Inthe Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all".
Moisture Flux & Moisture Flux Magnitude
57. | In the Volume Browser, under Sources, | The derived parameters Moisture Flux and Moisture
select ‘Grid’ -> ‘GFS90'. For Fields select | Flux Magnitude are displayed in the main CAVE
‘Basic’ -> ‘Moisture Flux'. Also select window.
‘Basic’ -> ‘Moisture Flux Mag'. In Planes
select ‘Pres’, ‘850mb’. Select ‘Load'.
Note: If there are multiple entries under
the Product Selection List, select a single
entry and then ‘Load’.
58. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
59. | Inthe Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all".
Shear Magnitude Cross Section
60. | Setthe display type to Cross Section. The Volume Browser menus modify to display
menus and menu items associated with Cross
Section displays.
61. | Inthe Volume Browser, under Sources, | The derived parameter Shear Magnitude is
select ‘Grid’ -> ‘GFS40'. For Fields select | displayed on a Cross Section chart in the main
‘Other’ -> ‘Shear Mag'. In Planes select | CAVE window.
‘Specified’ -> ‘Line A’. Select ‘Load’.
Note: If there are multiple entries under
the Product Selection List, select a single
entry and then ‘Load".
62. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
63. | Inthe Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all".
Computed CAPE Time Height
64. | Setthe display type to Time Height. The Volume Browser menus modify to display
menus and menu items associated with Time Height
displays.
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DCN AWP.TE.SWCTR/T10-0004

Step Action Result Pass/Fail
65. | Inthe Volume Browser, under Sources, The derived parameter Computed CAPE is
select ‘Grid’ -> ‘GFS40'. For Fields select | displayed on a Time Height chart in the main CAVE
‘Other’ -> ‘Computed CAPE'. In Planes window.
select ‘Points’ -> ‘TsectA'. Select ‘Load'".
Note: If there are multiple entries under
the Product Selection List, select a single
entry and then ‘Load'".
66. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
67. | Inthe Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all".
ThetaE Lapse Rate Var vs Hgt
68. | Setthe display type to Var vs Hgt. The Volume Browser menus modify to display
menus and menu items associated with Var vs Hgt
displays.
69. | Inthe Volume Browser, under Sources, The derived parameter ThetaE Lapse Rate for Point
select ‘Grid’ -> ‘GFS40'. For Fields select | Ais displayed on a Var vs Hgt chart in the main
‘Basic’ -> ‘ThetakE Lapse Rate’. In Planes | CAVE window.
select ‘Points’ -> ‘VarHgt A’. Select
‘Load’. Note: If there are multiple entries
under the Product Selection List, select a
single entry and then ‘Load’.
70. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
71. | Inthe Volume Browser select ‘Edit’" -> The prior Volume Browser selections are cleared.
‘Clear all".
Temperature (Radar Elevation) Time Series
72. | Setthe display type to Time Series. The Volume Browser menus modify to display
menus and menu items associated with Time Series
displays.
73. | In the Volume Browser, under Sources, | The temperature for the 0.5 degree elevation is
select ‘Grid’ -> ‘Radar’. For Fields select | displayed on a Time Series chart in the main CAVE
‘Basic’ -> ‘Temperature’. In Planes select | window.
Tilts"-> 0.5 deg’. Select ‘Load'. Note: If
there are multiple entries under the
Product Selection List, select a single
entry and then ‘Load'".
74. | Select ‘Clear’ from the menu bar. The prior display is cleared from the main CAVE
window.
75. | In the Volume Browser select ‘Edit’ -> The prior Volume Browser selections are cleared.
‘Clear all'.
End of TO10 Test
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DCN AWP.TE.SWCTR/T10-0004

5.0 TO9 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)
SYSR2095 The AWIPS system shall implement a Meteo Library Extension for ALL
access by uEngine Tasks.
SYSR2096 The AWIPS system shall implement Derived Parameters for grid and ALL
point data.
SYSR1584 The user shall be able to display streamlines for wind data. 34-44
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6.0 TO10 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)
SYSR TBD
SYSR
SYSR
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1.0 SCOPE
See TO10 Software Test Plan.
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20 APPLICABLE DOCUMENTS

2.1 Source Documents

TOS8 Test Case WarnGen 1.0
TO9 Test Case WarnGen 2.0

2.2 Reference Documents

TO10 Software Test Plan for the Advanced Weather Interactive Processing System
Project, Contract #DG133W-05-CQ-1067, January 2009.

Section 5 of the AWIPS D-2D User’s Manual Build 8.1.
The Silver Spring NWS AWIPS 1 test bed application.
Release OB8.2 of the Weather Event Simulator (WES).
Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

This test case demonstrates the extensions and WarnGen templates (including life cycle controls)
for a Convective Flash Flood Warning, Extreme Wind Warning, Extreme Wind Warning SVS
(FOLLOWUP), Flash Flood with Svr Tstm, Flash Flood Statement, non-convective FFW (Dam
Break), non-convective Flash Flood Statement, Areal Flood Warning, Areal Flood Warning
FOLLOWUP, Areal Flood Advisory, and Areal Flood Advisory FOLLOWUP.

3.1  Assumptions, Constraints and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX and pgAdmin Il are running.
e Data has been ingested.
e The Text Workstation has been started.
e The clock is set to local time.
e Localization is set to OAX.

e Actions, Results, and Requirements highlighted in yellow indicate requirements
and/or capabilities to be included in the scope of future task orders. They are included
here for purposes of continuity and traceability with the original AWIPS | test case
documents.

3.2 Recommended Hardware
See TO10 Software Test Plan, Section 2.2.

3.3 Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4 Test Outputs
The data will be displayed using CAVE capabilities.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

4.0 TEST SCENARIO
Step Action Result Pass/Fail
Duration Configuration
1. | Mouse Button (MB) 1 click ‘CAVE’ -> ‘New’ -> ‘Text | The Text Workstation and Text 1
Workstation’ windows open. (Note: The Text 1
window may be closed.)
2. | MB1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen GUI appears.
3. | Inthe WarnGen GUI, MBL1 click the ‘Other’ radio The ‘Areal Flood Advisory’ template is
button. selected.
Select ‘Areal Flood Advisory’ from the dropdown
menu.
4. | Verify a ‘20’ minute option is not available under the | Verified.
‘Duration’ dropdown menu.
5. | Open a Konsole and navigate to the ‘fla_default.cfg’ | The ‘fla_default.cfg’ file is modified and
file (cave/etc/warngen). the changes are saved.
Then edit the file (e.g., vi) by adding a ‘20’ minute
duration period.
Save the file (e.g., :wq).
6. | Inthe WarnGen GUI, select another template from The WarnGen template is toggled back
the dropdown menu (e.g., Areal Flood Warning) and | to the Areal Flood Advisory.
toggle back to the Areal Flood Advisory option. This
refreshes the WarnGen GUI window.
7. | Expand the ‘Duration” dropdown menu and verify a Verified.
‘20" appears as an option.
8. | Inthe D2D display, note the default storm speed (kts) | Noted.
and direction (degrees).
9. | Close the WarnGen GUI. The WarnGen GUI closes.
Storm Track Direction and Speed Configuration
10. | Inthe Konsole, navigate to the The ‘severethunderstorm_OAX.cfg’ file
severethunderstorm_OAX.cfg (cave/etc/warngen). is modified and the changes are saved.
Then edit the file (e.g., vi) by changing the
defaultSpeedKt and defaultDirection values.
Save the file (e.g., :wq).
11. | MBI click on the "‘WarnGen’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen GUI appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

12. | In the main pane, click and hold MB1 on the ‘Drag
me to Storm’ point and drag it to another location.
Compare the vector orientation and speed with that
noted in step 8.

A vector appears with the point near DR #813
the center of the line, tick marks, and
time values at the starting point,
current/endpoint, and arrowhead.

The default settings modified in step 9
are reflected in the initial vector's storm
speed and direction.

An initial warning area hatched box
appears.

13. | Close the WarnGen GUI.

The WarnGen GUI closes.

14. | In the Konsole, navigate to the
severethunderstorm_OAX.cfg (cave/etc/warngen).
Then edit the file (e.g., vi) by reverting the changes
back to the original defaultSpeedKt and
defaultDirection values (20kts and 225 degrees
respectively).

Save the file (e.g., :wq).

The ‘severethunderstorm_OAX.cfg' file
is modified and the changes are saved.

15. | MB1 click on the ‘WarnGen’ button in the tool bar.

The WarnGen application loads.

A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This pointis in edit mode.
The WarnGen GUI appears.

16. | In the main pane, click and hold MB1 on the ‘Drag
me to Storm’ point and drag it to another location.

A southwest-northeast oriented vector | DR #813
appears with the point near the center
of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.

An initial warning area hatched box
appears.

17. | Close the WarnGen GUI.

The WarnGen GUI closes.

18. | Close the Konsole.

The WarnGen GUI closes.

19. | Clear anything displayed in the main pane.

The main pane displays a blank map.

Initial Setup
20. | Change the scale from the tool bar drop down menu | The WFO scale displays in the main
to ‘WFO'. pane, focusing on the OAX CWA.
21. | From the ‘Maps’ dropdown menu, select ‘County The county names appear in the
Names'. associated county.

22. | MB3 click and hold on the County Names product ID
in the product legend and select ‘Change Color'.

Select the color red and MBL1 click ‘OK’.

The County Names change to red.

23. | From the ‘Maps’ dropdown menu, select ‘CWAS'.

The CWASs appear in the main pane.

24. | MB3 click and hold on the CWA product ID in the
product legend and select ‘Change Color'.

Select the color yellow and MB1 click ‘OK'.

The CWA boarders change to yellow.
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DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
25. | From the ‘Maps’ dropdown menu, select ‘Cities’. The Cities appear in the main pane.
26. | MBL1 click the Density dropdown menu on the tool bar | The number of cities displayed in the

and select ‘0.5". main pane is reduced.

27. | MB1 click ‘koax’ -> ‘koax 4 Bit Products’ -> ‘koax 4bit | The ‘koax 0.5 Reflectivity (Z)' product
Reflectivity’ -> ‘0.5 Refl". displays in the main pane.

Tornado Warning

Issuing initial Tornado Warning
28. | MBL1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads.

A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen GUI appears.

29. | In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector | DR #813
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values

at the starting point, current/endpoint,
and arrowhead.

An initial warning area hatched box
appears.

30. | Press the right arrow key on the keyboard once. The oldest radar image in the loop
displays. The point is relabeled ‘Drag
me to Storm’ and appears at the
starting point of the vector.

31. | MB1 click and hold the ‘Drag me to Storm’ pointand | The vector rotates accordingly. The

drag it to another location. spacing between the tick marks adjusts
accordingly.
The hatched warning box remains at its
current position.

32. | Inthe ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.

-Edit: Box and Track

33. | Click MB1 on the ‘Track’ button under the ‘Redraw The hatched box is redrawn on the
Box on Screen from:” section. vector.

34. | MBL1 click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.

Multiple KOAX counties are included in
the polygon.

Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
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Step Action

Result Pass/Fail

35. | MB1 click on the ‘Warned/Hatched Area’ button
under the ‘Redraw Box on Screen from:' section.

The polygon’s vertices are redrawn on
the vector snapping back to the CWA
border while creating additional
vertices.

Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.

36. | MBL1 click on ‘Tornado’ in the ‘Product type’ section.

The selection is made as indicated by
the radio button. The BASIS FOR
WARNINGS and CALLS TO ACTION
sections update to display items
applicable for Tornado Warnings.

37. | Select the ‘Duration:’ to 20 min.

The duration is set to 20 min. The DR #3813
ending time of the warning updates
with the change in duration.

The vector contracts and the time at
the arrowhead modifies.

38. | MBL1 within the Optional bullets section, select items
such that the following Tornado Template
Parameters are highlighted:

BASIS FOR WARNING: Confirmed large
tornado

CALLS TO ACTION: Severe Tornado
CALLS TO ACTION: If caught outside

CALLS TO ACTION: Don't outrun in car
Then click MB1 on the ‘Create Text button.

The Tornado Warning text appears in a
‘Text Warngen’ window.

An ‘AWIPS Header Block’ window
appears.

39. | Inthe AWIPS Header Block, verify the following
selections are set:

TTAAIi: SAUS43

CCCC: KOAX

BBB: NOR

BBB Version: A (grayed out)
WSFO ID: OMA

Product Category: TOR
Product Designator: OAX

Addressee: 000
Then MB1 click the ‘Enter’ button.

The Tornado Warning text remains DR #868
displayed in the text window in edit DR #870
mode.
The AWIPS Header Block window
closes.

40. | Verify the Tornado Warning text contains the
Tornado Template Parameters selected.

The BASIS FOR WARNING and
CALLS TO ACTION exist in the
Tornado Warning statement.

41. | Verify the Tornado Warning text contains the current
date and time attributes and the correct header
information.

The date and time attributes exist. DR #782
The header information is correct.
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Step Action Result Pass/Fail

42. | Verify the Tornado Warning text contains the The counties are listed in the Tornado | DR #869
counties encompassed by the polygon. Warning statement.

Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.

43. | Verify the Tornado Warning text contains the VTEC | The VTEC code exists and is accurate.
code above the BULLETIN section. The VTEC code
should be in the following format:

/O.NEW.KOAX.TO.W.0001.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/

Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).

44, | Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).

45. | Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.

46. | Verify the text warning contains a presence of closing | The Tornado Warning text contains a
$3. presence of closing $3$.

47. | Inthe text window, replace the ™NAME/INITIALS**!" | The Tornado Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.

Then MBL1 click the ‘Send’ button.

48. | MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the

‘Text WarnGen: OMATOROAX'’
window (not in edit mode).

49. | Note the VTEC code (the ‘TO.W.xxxx' portion in
particular). TO.W.

50. | Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lawips/edex/opt/data/shn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

51. | Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX

window closes.

52. | MBL click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Tornado’ radio button. observing that the ingested warning
Then MBL click the ‘Correct/Reissue’ dropdown can be corrected (COR) or reissued
menu to verify the created warning is able to be (NEW).
corrected (COR) or reissued (NEW).

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0005 / 21 Nov. 2008 8

Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.

HARD COPY UNCONTROLLED




Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail

53. | Create another Tornado Warning by repeating steps | The new Tornado Warning displays in
11-30, but choosing different options within the the text window.

‘WarnGen: Operational’ window.

54. | Verify the VTEC code in the warning is different from | The VTEC code from the first warning
the first Tornado Warning (e.g., TO.W.0001 becomes | was persisted. The second Tornado
TO.W.0002). Warning contains updated VTEC

coding.

55. | Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

56. | Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX

window closes.

57. | MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Tornado’ radio button. observing that the ingested warning
Then MBL click the ‘Correct/Reissue’ dropdown can be corrected (COR) or reissued
menu to verify the created warning is able to be (NEW).
corrected (COR) or reissued (NEW). Verify two lines
similar to the following appear:

COR.KOAX.TO.W.xxxx(NEW)
NEW.KOAX.TO.W.xxxx
Correcting a Tornado Warning (COR)

58. | Inthe WarnGen GUI, from the ‘Correct/Reissue’ The storm vector and polygon appear.
dropdown, select the ‘COR’ product. The polygon is uneditable as indicated

by the square vertex points.

59. | Change the duration and bulletins to be displayed in-| The Tornado Warning text appears in a
the warning text product. ‘Text Warngen’ window.

Then MBL1 click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
60. | Inthe AWIPS Header Block, verify the following The Tornado Warning text remains DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.

BBB: NOR
BBB Version: A (grayed out)
WSFOID: OMA
Product Category: TOR
Product Designator: OAX
Addressee: 000

Then MBL1 click the ‘Enter’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
61. | Verify the Tornado Warning text contains the The BASIS FOR WARNING and
Tornado Template Parameters selected. CALLS TO ACTION exist in the
Tornado Warning statement.
62. | Verify the Tornado Warning text contains the current | The date and time attributes exist. DR #782
date and time attributes and the correct header The header information is correct.
information.
63. | Verify the Tornado Warning text contains the The counties are listed in the Tornado | DR #869
counties encompassed by the polygon. Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
64. | Verify the Tornado Warning text contains the VTEC | The VTEC code exists and is accurate.
code above the BULLETIN section. The VTEC code
should be in the following format:
/0.COR.KOAX.TO.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
65. | Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
66. | Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
67. | Verify the text warning contains a presence of closing | The Tornado Warning text contains a
$3. presence of closing $3.
68. | Inthe text window, replace the ‘**NAME/INITIALS**I' | The Tornado Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save' button. warning.
Then MBL click the ‘Send’ button.
69. | MBL click the ‘Cancel’ button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMATOROAX'
window (not in edit mode).
70. | Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
71. | MB1 click the WarnGen button in the toolbar, select Verified.
the Tornado radio button, and verify a line similar to
the following appears:
‘COR.KOAX.TO.W.xxxx(NEW)'
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
72. | Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX
window closes.
Continuing a Tornado Warning (CON) by Issuing a Follow-Up for a Tornado Warning (SVS)
73. | Inthe WarnGen GUI, MB1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. menu.
74. | MBL1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
75. | MBL1 click the ‘CON'’ option. The vector and polygon of the original
warning appear on the main pane.
76. | Modify the warning polygon, but do not remove any | The Tornado Warning text appears in a
counties from the original warning polygon. ‘Text Warngen’ window.
MBL1 click the ‘Warned/Hatched Area’ button. An ‘AWIPS Header Block’ window
Note: The polygon can only be reduced in size. appears.
Select additional warning bulletins.
Then MBL click the ‘Create Text' button.
77. | Inthe AWIPS Header Block, verify the following The Tornado Warning text remains DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter" button.
78. | Verify the Tornado Warning text contains the The BASIS FOR WARNING and
Tornado Template Parameters selected. CALLS TO ACTION exist in the
Tornado Warning statement.
79. | Verify the Tornado Warning text contains the current | The date and time attributes exist. DR #782
date and time attributes and the correct header The header information is correct.
information.
80. | Verify the Tornado Warning text contains the The counties are listed in the Tornado | DR #869
counties encompassed by the polygon. Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail

81. | Verify the Tornado Warning text contains the VTEC | The VTEC code exists and is accurate.
code above the BULLETIN section. The VTEC code
should be in the following format:

/0.CON.KOAX.TO.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/

Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).

82. | Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).

83. | Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.

84. | Verify the text warning contains a presence of closing | The Tornado Warning text contains a
$$. presence of closing $$.

85. | In the text window, replace the ‘™*NAME/INITIALS**!" | The Tornado Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.

Then MBL click the ‘Send’ button.

86. | MB1 click the ‘Cancel button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the

‘Text WarnGen: OMATOROAX'’
window (not in edit mode).

87. | Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lawips/edex/opt/data/shn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

88. | Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX

window closes.

89. | MBL1 click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button, and MB1 click the
‘FOLLOWUP’ dropdown menu.

Verify a line similar to the following appears:
‘COR.KOAX.TO.W.xxxx(CON)
Continuing/Canceling a Tornado Warning (CON/CAN)
9 In the WarnGen GUI, MB1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
" | button. menu.

91. | MB1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.

92. | MBL1 click the ‘CON'’ option. The vector and polygon of the original

warning appear on the main pane.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

93. | Modify the warning polygon to remove at least one
county from the original warning polygon.

Select additional warning bulletins.
Then MBL1 click the ‘Create Text’ button.

The Tornado Warning text appears in a
‘Text Warngen’ window.

An ‘AWIPS Header Block’ window
appears.

94. | Inthe AWIPS Header Block, verify the following
selections are set:

TTAAIi: SAUS43

CCCC: KOAX

BBB: NOR

BBB Version: A (grayed out)
WSFO ID: OMA

Product Category: SVS
Product Designator: OAX

Addressee: 000
Then MB1 click the ‘Enter’ button.

The Tornado Warning text remains DR #868
displayed in the text window in edit DR #870
mode.
The AWIPS Header Block window
closes.

95. | Verify the Tornado Warning text contains the
Tornado Template Parameters selected.

The BASIS FOR WARNING and
CALLS TO ACTION exist in the
Tornado Warning statement.

96. | Verify the Tornado Warning text contains the current
date and time attributes and the correct header
information.

The date and time attributes exist. DR #782
The header information is correct.

97. | Verify the Tornado Warning text contains the
counties encompassed by the polygon.

Verify cities near the warning vector are included in
the pathcast.

The counties are listed in the Tornado | DR #869
Warning statement.

The cities near the warning vector are
included in the warning.

98. | Verify the Tornado Warning text contains the VTEC
code above the BULLETIN section. The 2 lines of
VTEC code should be in the following format:
/0.CAN.KOAX.TO.W.xxxx.Y YMMDDTHHMmMZ-
YYMMDDTHHmmZ/
/0.CON.KOAX.TO.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/

Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(UTC).

The VTEC code exists and is accurate.

99. | Verify the Lat/Lon coordinates appear in the text
warning product (E.g., LAT...LON 4471 9981 4488
9977...).

The Lat/Lon information exists in the
text product.

100.| Verify the location and motion of the weather event
exists below the LAT...LON line in the text warning

The location and motion of the weather | DR #782
event exists below the LAT...LON line.

product.
101.| Verify the text warning contains a presence of closing | The Tornado Warning text contains a
$$. presence of closing $3.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
102.| In the text window, replace the ‘**NAME/INITIALS**!" | The Tornado Warning is saved.
line with the user’s initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
103.| MB1 click the ‘Cancel’ button and MBL1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMATOROAX'
window (not in edit mode).
104.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
105.| Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX
window closes.
106.| MB1 click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button, and MBL1 click the
‘FOLLOWUP’ dropdown menu.
Verify two lines similar to the following appear:
‘COR.KOAX.TO.W.xxxx(CONY
‘COR.KOAX.TO.W.xxxx(CAN)’
Reissuing a Tornado Warning (NEW)
107.| In the WarnGen GUI, MBL1 click on the ‘Tornado’ ‘Update List’ appears in the dropdown
radio button. menu.
108.| From the ‘Update List’ dropdown, select the ‘NEW’ The storm vector and polygon appear.
product. The polygon is editable.
109.| Modify the polygon, duration and for the warning text | The Tornado Warning text appears in a
product. ‘Text Warngen’ window.
Then MBL1 click the ‘Create Text’ button. An ‘AWIPS Header Block’ window
appears.
110.| In the AWIPS Header Block, verify the following The Tornado Warning text remains DR #868
selections are set: displayed in the text window in edit DR #870
TTAAii; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: TOR
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
111.| Verify the Tornado Warning text contains the The BASIS FOR WARNING and
Tornado Template Parameters selected. CALLS TO ACTION exist in the
Tornado Warning statement.
112.| Verify the Tornado Warning text contains the current | The date and time attributes exist. DR #782
date and time attributes and the correct header The header information is correct.
information.
113.| Verify the Tornado Warning text contains the The counties are listed in the Tornado | DR #869
counties encompassed by the polygon. Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
114.| Verify the Tornado Warning text contains the VTEC | The VTEC code exists and is accurate.
code above the BULLETIN section. The VTEC code
should be in the following format:
[O.NEW.KOAX.TO.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
115.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
116.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
117.| Verify the text warning contains a presence of closing | The Tornado Warning text contains a
$3. presence of closing $$.
118.| In the text window, replace the ‘**NAME/INITIALS**!" | The Tornado Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save' button. warning.
Then MBL click the ‘Send’ button.
119.| MBI click the ‘Cancel’ button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMATOROAX'
window (not in edit mode).
120.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
121.| Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX
window closes.
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Test C

ase WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
122.| MB1 click the WarnGen button in the toolbar, select | Verified.
the Tornado radio button, and verify two lines similar
to the following appear:
‘COR.KOAX.TO.W.xxxx(NEW)
‘NEW.KOAX.TO.W.xxxx’
Cancelling a Tornado Warning (CAN)
123.| In the WarnGen GUI, MBL1 click the ‘Other’ radio The storm vector and polygon appear.
button. Select ‘Severe Weather Statement’ from the | The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. From | by the square vertex points.
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN' | Tha pulletins are grayed out.
product.
124.| MBL1 click the ‘Create Text' button. The Tornado Warning text appears in a
‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
125.| In the AWIPS Header Block, verify the following The Tornado Warning text remains DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
126.| Verify the Tornado Warning text contains the current | The date and time attributes exist. DR #782
date and time attributes and the correct header The header information is correct.
information.
127.| Verify the Tornado Warning text contains the The counties are listed in the Tornado | DR #869
counties encompassed by the polygon. Warning statement.
128.| Verify the Tornado Warning text contains the VTEC | The VTEC code exists and is accurate.
code above the BULLETIN section. The VTEC code
should be in the following format:
/0.CAN.KOAX.TO.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
129.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

130.| Verify the location and motion of the weather event
exists below the LAT...LON line in the text warning

The location and motion of the weather | DR #782
event exists below the LAT...LON line.

product.
131.| Verify the text warning contains a presence of closing | The Tornado Warning text contains a
$$. presence of closing $3.

132.| In the text window, replace the ‘**NAME/INITIALS**!
line with the user's initials.

MB1 click the ‘Save’ button.
Then MB1 click the ‘Send’ button.

The Tornado Warning is saved.

The text window displays the saved
warning.

133.| MBL1 click the ‘Cancel’ button and MBL1 click the ‘Yes’
button in the message box that states ‘Any unsaved
changes will be lost. Cancel anyway?'.

A Confirm Cancel window opens.
The Confirm Cancel window closes.

The warning remains displayed in the
‘Text WarnGen: OMATOROAX'
window (not in edit mode).

134.| Ingest the warning text file into the ‘warning’ endpoint
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

The warning is ingested.

135.| Close the Text Warngen: OMATOROAX window.

The Text Warngen: OMATOROAX
window closes.

136.| MBI click the WarnGen button in the toolbar, select
the Tornado radio button, and verify a line similar to
the following appears:

‘COR.KOAX.TO.W.xxxx(CAN)

Verified.

137.| Close the WarnGen GUI.

The WarnGen GUI closes.

Expiring a Tornado Warning (EXP)

138.| MBL1 click on the ‘WarnGen’ button in the tool bar.

The WarnGen application loads.

A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.

139.| In the main pane, click and hold MB1 on the ‘Drag
me to Storm’ point and drag it to another location
(ideally on a feature picked up by the radar).

A first guess vector appears with the DR #813
point near the center of the line, tick
marks, and time values at the starting
point, current/endpoint, and arrowhead.
An initial warning area hatched box
appears.

140.| Press the right arrow key on the keyboard once.

The oldest radar image in the loop
displays. The point is relabeled ‘Drag
me to Storm’ and appears at the
starting point of the vector.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
141.| MB1 click and hold the ‘Drag me to Storm’ pointand | The vector is redrawn. The spacing
drag it to another location. between the tick marks adjusts
accordingly.
The hatched warning box remains at its
current position.
142.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
143.| Click MB1 on the ‘Track’ button under the ‘Redraw The hatched box is redrawn on the
Box on Screen from:’ section. vector.
144.| MB1 click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax’s CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.
Multiple KOAX counties are included in
the polygon.
145.| MB1 click on the ‘Warned/Hatched Area’ button The polygon’s vertices are redrawn on
under the ‘Redraw Box on Screen from:" section. the vector snapping back to the CWA
border while creating additional
vertices.
146.| MBL1 click on ‘Tornado’ in the ‘Product type’ section. | The selection is made as indicated by
the radio buttons. The BASIS FOR
WARNINGS and CALLS TO ACTION
sections update to display items
applicable for Tornado Warnings.
147.| Select the ‘Duration:’ to 10 min. The duration is set to 10 min. The DR #813
ending time of the warning updates
with the change in duration.
The vector contracts and the time at
the arrowhead modifies.
148.| Using Control and MB1 within the Optional bullets The Tornado Warning text appears in a
section, select or deselect items such that the ‘Text Warngen’ window.
following Tornado Template Parameters are An ‘AWIPS Header Block’ window
highlighted: appears.
BASIS FOR WARNING: Confirmed large
tornado
CALLS TO ACTION: Severe Tornado
CALLS TO ACTION: If caught outside
Then click MB1 on the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
149.| In the AWIPS Header Block, verify the following The Tornado Warning text remains DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: TOR
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
150.| In the text window, replace the ‘"*NAME/INITIALS*!" | The Tornado Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL click the ‘Send’ button.
151.| MBI click the ‘Cancel button and MBL1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMATOROAX'
window (not in edit mode).
152.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
153.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Select ‘Severe Weather Statement’ from the can be expired (EXP).
dropdown menu below the ‘Other’ radio button and
verify the created warning is able to be expired
(EXP).
154.| Select the EXP product. The storm vector and polygon appear.
The polygon is uneditable as indicated
by the square vertex points.
The bulletins are grayed out.
155.| MBI click the ‘Create Text' button. The Tornado Warning text appears in a
‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
156.| In the AWIPS Header Block, verify the following The Tornado Warning text remains DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
157.| Verify the Tornado Warning text contains the current | The date and time attributes exist. DR #782
date and time attributes and the correct header The header information is correct.
information.
158.| Verify the Tornado Warning text contains the The counties are listed in the Tornado | DR #869
counties encompassed by the polygon. Warning statement.
159.| Verify the Tornado Warning text contains the VTEC | The VTEC code exists and is accurate.
code above the BULLETIN section. The VTEC code
should be in the following format:
10.EXP.KOAX.TO.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ /
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
160.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
161.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
162.| Verify the text warning contains a presence of closing | The Tornado Warning text contains a
$3. presence of closing $3.
163.| In the text window, replace the ‘**NAME/INITIALS**!" | The Tornado Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL click the ‘Send’ button.
164.| MBI click the ‘Cancel button and MBL1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMATOROAX'
window (not in edit mode).
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
165.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
166.| Close the Text Warngen: OMATOROAX window. The Text Warngen: OMATOROAX
window closes.
167.| MB1 click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button. observing that the expired product
Select ‘Severe Weather Statement’ from the (EXP) exists in the FOLLOWUP
dropdown menu below the ‘Other’ radio button. dropdown menu.
Verify in the ‘FOLLOWUP’ dropdown menu that an
expired product (EXP) line similar to the following
appears:
‘COR.KOAX.TO.W.xxxx(EXP)’
168.| Close the WarnGen GUI. The WarnGen GUI closes.
Severe Thunderstorm Warning
Issuing a Severe Thunderstorm Warning
169.| MBL1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
170.| In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector | DR #813
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.
An initial warning area hatched box
appears.
171.| Press the right arrow key on the keyboard once. The oldest radar image in the loop
displays. The point is relabeled ‘Drag
me to Storm’ and appears at the
starting point of the vector.
172.| MBI click and hold the ‘Drag me to Storm’ pointand | The vector rotates accordingly. The
drag it to another location. spacing between the tick marks adjusts
accordingly.
The hatched warning box remains at its
current position.
173.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
174.] Click MB1 on the ‘Track’ button under the ‘Redraw The hatched box is redrawn on the
Box on Screen from:’ section. vector.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
175.| MBL1 click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.
Multiple KOAX counties are included in
the polygon.
Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
176.| MB1 click on the ‘Warned/Hatched Area’ button The polygon's vertices are redrawn on
under the ‘Redraw Box on Screen from:’” section. the vector snapping back to the CWA
border while creating additional
vertices.
Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.
177.| MB1 click on ‘Severe Thunderstorm’ in the ‘Product | The selection is made as indicated by
type’ section if not selected by default. the radio button. The BASIS FOR
WARNINGS and CALLS TO ACTION
sections update to display items
applicable for Severe Thunderstorm
Warnings.
178.| Select the ‘Duration;’to 20 min. The duration is set to 20 min. The DR #813
ending time of the warning updates
with the change in duration.
The vector contracts and the time at
the arrowhead modifies.
179.| MB1 within the Optional bullets section, selectitems | The Tornado Warning text appears in a
such that the following Severe Thunderstorm ‘Text Warngen’ window.
Template Parameters are highlighted: An ‘AWIPS Header Block’ window
BASIS FOR WARNING: Doppler radar appears.
indicated
THREAT: 60mph wind
THREAT: Penny size hail
CALLS TO ACTION: Svr t-storms can
produce tornadoes...
Then click MB1 on the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
180.| In the AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAIi: SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVR
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
181.| Verify the Severe Thunderstorm Warning text The BASIS FOR WARNING, THREAT
contains the Severe Thunderstorm Template and CALLS TO ACTION exist in the
Parameters selected. Severe Thunderstorm Warning
statement.
182.| Verify the Severe Thunderstorm Warning text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
183.| Verify the Severe Thunderstorm Warning text The counties are listed in the Severe DR #869
contains the counties encompassed by the polygon. | Thunderstorm Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
184.| Verify the Severe Thunderstorm Warning text The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/O0.NEW.KOAX.SV.W.0001.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(UTC).
185.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
186.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
187.| Verify the text warning contains a presence of closing | The Severe Thunderstorm Warning
$3. text contains a presence of closing $$.
188.]| In the text window, replace the ‘™*NAME/INITIALS**!" | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MBL click the ‘Send’ button. warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
189.| MBL1 click the ‘Cancel button and MBL1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMATOROAX'’
window (not in edit mode).
190.| Note the VTEC code (the ‘SV.W.xxxx" portion in
particular). SV.W.
191.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
192.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
193.| MB1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Severe Thunderstorm’ radio button. observing that the ingested warning
Then MBL click the ‘Correct/Reissue’ dropdown can be corrected (COR) or reissued
menu to verify the created warning is able to be (NEW).
corrected (COR) or reissued (NEW).
194.| Create another Severe Thunderstorm Warning by The new Severe Thunderstorm
repeating steps 152-171, but choosing different Warning displays in the text window.
options within the ‘WarnGen: Operational’ window.
195.| Verify the VTEC code in the warning is different from | The VTEC code from the first warning
the first Severe Thunderstorm Warning (e.g., was persisted. The second Severe
SV.W.0001 becomes SV.W.0002). Thunderstorm Warning contains
updated VTEC coding.
196.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
197.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
198.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Severe Thunderstorm'’ radio button. observing that the ingested warning
Then MB1 click the ‘Correct/Reissue’ dropdown can be corrected (COR) or reissued
menu to verify the created warning is able to be (NEW).
corrected (COR) or reissued (NEW). Verify two lines
similar to the following appear:
COR.KOAX.SV.W.xxxx(NEW)
NEW.KOAX.SV.W.xxxx
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Correcting a Severe Thunderstorm Warning (COR)
199.| In the WarnGen GUI, from the ‘Correct/Reissue’ The storm vector and polygon appear.
dropdown, select the ‘COR’ product. The polygon is uneditable as indicated
by the square vertex points.
200.| Change the duration and bulletins to be displayed in | The Severe Thunderstorm Warning
the warning text product. text appears in a ‘Text Warngen’
Then MB1 click the ‘Create Text’ button. window.
An ‘AWIPS Header Block’ window
appears.
201.| In the AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAii- SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVR
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
202.| Verify the Severe Thunderstorm Warning text The BASIS FOR WARNING, THREAT
contains the Severe Thunderstorm Template and CALLS TO ACTION exist in the
Parameters selected. Severe Thunderstorm Warning
statement.
203.| Verify the Severe Thunderstorm Warning text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
204.| Verify the Severe Thunderstorm Warning text The counties are listed in the Severe DR #869
contains the counties encompassed by the polygon. | Thunderstorm Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
205.| Verify the Severe Thunderstorm Warning text The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/0.COR.KOAX.SV.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
206.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
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Test C

ase WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
207.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
208.| Verify the text warning contains a presence of closing | The Severe Thunderstorm Warning
$$. text contains a presence of closing $$.
209.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MBL click the ‘Send’ button. warning.
210.| MBL1 click the ‘Cancel button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMASVROAX'
window (not in edit mode).
211.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
212.| MB1 click the WarnGen button in the toolbar, select | Verified.
the Severe Thunderstorm radio button, and verify a
line similar to the following appears:
‘COR.KOAX.SV.W.xxxx(NEW)'
213.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
Continuing a Severe Thunderstorm Warning (CON) by Issuing a Follow-Up for a
Severe Thunderstorm Warning (SVS)
214.| In the WarnGen GUI, MB1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Severe Weather Statement’ from the | menu.
dropdown menu below the ‘Other’ radio button.
215.| MBL click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
216.| MBI click the ‘CON’ option. The vector and polygon of the original
warning appear on the main pane.
217.| Modify the warning polygon, but do not remove any | The Severe Thunderstorm Warning
counties from the original warning polygon. text appears in a ‘Text Warngen’
MB1 click the ‘Warned/Hatched Area’ button. window.
Note: The polygon can only be reduced in size. An ‘AWIPS Header Block’ window
Select additional warning bulletins. appears.
Then MBL1 click the ‘Create Text’ button.
Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/T010-0005 / 21 Nov. 2008 26

Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.

HARD COPY UNCONTROLLED




Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
218.| In the AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAIi: SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
219.| Verify the Severe Thunderstorm Warning text The BASIS FOR WARNING, THREAT
contains the Severe Thunderstorm Template and CALLS TO ACTION exist in the
Parameters selected. Severe Thunderstorm Warning
statement.
220.| Verify the Severe Thunderstorm Warning text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
221.| Verify the Severe Thunderstorm Warning text The counties are listed in the Severe DR #869
contains the counties encompassed by the polygon. | Thunderstorm Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
222.| Verify the Severe Thunderstorm Warning text The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/0.CON.KOAX.SV.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(UTC).
223.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
224.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
225.| Verify the text warning contains a presence of closing | The Severe Thunderstorm Warning
$3. text contains a presence of closing $$.
226.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MBL click the ‘Send’ button. warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
227.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMASVROAX'
window (not in edit mode).
228.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
229.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
230.| MB1 click the WarnGen button in the toolbar, select Verified.
the ‘Other’ radio button, and MB1 click the
‘FOLLOWUP’ dropdown menu.
Verify a line similar to the following appears:
‘COR.KOAX.SV.W.xxxx(CON)
Continuing/Canceling a Severe Thunderstorm Warning (CON/CAN)
231.| In the WarnGen GUI, MBL1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Severe Weather Statement’ from the | menu.
dropdown menu below the ‘Other’ radio button.
232.| MBL1 click on the ‘FOLLOWUP’ dropdown menuand- | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
233.| MBL click the ‘CON'’ option. The vector and polygon of the original
warning appear on the main pane.
234.| Modify the warning polygon to remove at least one The Severe Thunderstorm Warning
county from the original warning polygon. text appears in a ‘Text Warngen’
Select additional warning bulletins. window.
Then MB1 click the ‘Create Text’ button. An ‘AWIPS Header Block’ window
appears.
235.| Inthe AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAIi: SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO'ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
236.| Verify the Severe Thunderstorm Warning text The BASIS FOR WARNING, THREAT
contains the Severe Thunderstorm Template and CALLS TO ACTION exist in the
Parameters selected. Severe Thunderstorm Warning
statement.
237.| Verify the Severe Thunderstorm Warning text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
238.| Verify the Severe Thunderstorm Warning text The counties are listed in the Severe DR #869
contains the counties encompassed by the polygon. | Thunderstorm Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
239.| Verify the Severe Thunderstorm Warning text The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The 2 lines of VTEC code should be in the
following format:
/0.CAN.KOAX.SV.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/0.CON.KOAX.SV.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
240.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
241.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
242.| Verify the text warning contains a presence of closing | The Severe Thunderstorm Warning
$$. text contains a presence of closing $$.
243.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MBL click the ‘Send’ button. warning.
244.| MBL click the ‘Cancel’ button and MBL click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMASVROAX’
window (not in edit mode).
245.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
246.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
247.] MBL click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button.
Select ‘Severe Weather Statement’ from the
dropdown menu below the ‘Other’ radio button and
MBL1 click the ‘FOLLOWUP’ dropdown menu.
Verify two lines similar to the following appear:
‘COR.KOAX.SV.W.xxxx(CONY
‘COR.KOAX.SV.W.xxxx(CANY
Reissuing a Severe Thunderstorm Warning (NEW)
248.| In the WarnGen GUI, MB1 click on the ‘Severe ‘Update List’ appears in the dropdown
Thunderstorm’ radio button. menu.
249.| From the ‘Update List' dropdown, select the ‘NEW’ The storm vector and polygon appear.
product. The polygon is editable.
250.| Modify the polygon, duration and for the warning text | The Severe Thunderstorm Warning
product. text appears ina ‘Text Warngen’
Then MBL click the ‘Create Text’ button. window.
An ‘AWIPS Header Block’ window
appears.
251.| In the AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAIi: SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVR
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
252.| Verify the Severe Thunderstorm Warning text The BASIS FOR WARNING and
contains the Severe Thunderstorm Template CALLS TO ACTION exist in the Severe
Parameters selected. Thunderstorm Warning statement.
253.| Verify the Severe Thunderstorm Warning text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
254.| Verify the Severe Thunderstorm Warning text The counties are listed in the Severe DR #869
contains the counties encompassed by the polygon. | Thunderstorm Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
255.| Verify the Severe Thunderstorm Warning text The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/O.NEW.KOAX.SV.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
256.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
257.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
258.| Verify the text warning contains a presence of closing | The Severe Thunderstorm Warning
$$. text contains a presence of closing $$.
259.| In the text window, replace the ‘™*NAME/INITIALS*!I" | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
260.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?". The warning remains displayed in the
‘Text WarnGen: OMASVROAX’
window (not in edit mode).
261.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
262.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
263.| MB1 click the WarnGen button in the toolbar, select | Verified.
the Severe Thunderstorm radio button, and verify two
lines similar to the following appear:
‘COR.KOAX.SV.W.xxxx(NEW)'
‘NEW.KOAX.SV.W.xxxx'
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Cancelling a Severe Thunderstorm Warning (CAN)
264.| In the WarnGen GUI, MB1 click the ‘Other’ radio The storm vector and polygon appear.
button. Select ‘Severe Weather Statement’ from the | The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. by the square vertex points.
From the ‘FOLLOWUP’ dropdown menu, select the The bulletins are grayed ou.
‘CAN'’ product.
265.| MBL1 click the ‘Create Text' button. The Severe Thunderstorm Warning
text appears in a ‘Text Warngen’
window.
An ‘AWIPS Header Block’ window
appears.
266.| In the AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAii- SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter” button.
267.| Verify the Severe Thunderstorm Warning text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
268.| Verify the Severe Thunderstorm Warning text The counties are listed in the Severe DR #869
contains the counties encompassed by the polygon. | Thunderstorm Warning statement.
269.| Verify the Severe Thunderstorm Warning text The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/0.CAN.KOAX.SV.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
270.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
271.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
272.| Verify the text warning contains a presence of closing | The Severe Thunderstorm Warning
$$. text contains a presence of closing $$.
273.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
274.| MBL click the ‘Cancel’ button and MBL click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMASVROAX'
window (not in edit mode).
275.] Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
276.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
277.| MB1 click the WarnGen button in the toolbar, select Verified.
the Severe Thunderstorm radio button, and verify a
line similar to the following appears:
‘COR.KOAX.SV.W.xxxx(CAN)’
278.| Close the WarnGen GUI. The WarnGen GUI closes.
Expiring a Severe Thunderstorm Warning (EXP)
279.| MBL1 click on'the ‘WarnGen’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
280.| In the main pane, click and hold MB1 on the ‘Drag A first guess vector appears with the DR #813
me to Storm’ point and drag it to another location point near the center of the line, tick
(ideally on a feature picked up by the radar). marks, and time values at the starting
point, current/endpoint, and arrowhead.
An initial warning area hatched box
appears.
281.| Press the right arrow key on the keyboard once. The oldest radar image in the loop
displays. The point is relabeled ‘Drag
me to Storm’ and appears at the
starting point of the vector.
282.| MBL click and hold the ‘Drag me to Storm’ point and | The vector is redrawn. The spacing
drag it to another location. between the tick marks adjusts
accordingly.
The hatched warning box remains at its
current position.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
283.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
284.| Click MB1 on the ‘Track’ button under the ‘Redraw The hatched box is redrawn on the
Box on Screen from:” section. vector.
285.| MBL1 click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.
Multiple KOAX counties are included in
the polygon.
286.| MBL click on the ‘Warned/Hatched Area’ button The polygon’s vertices are redrawn on
under the ‘Redraw Box on Screen from:’ section. the vector snapping back to the CWA
border while creating additional
vertices.
287.| MBL click on ‘Severe Thunderstorm’ in the ‘Product | The selection is made as indicated by
type’ section. the radio button. The BASIS FOR
WARNINGS and CALLS TO ACTION
sections update to display items
applicable for Severe Thunderstorm
Warnings.
288.| Select the ‘Duration:’ to 10 min. The duration is set to 10 min. The DR #813
ending time of the warning updates
with the change in duration.
The vector contracts and the time at
the arrowhead modifies.
289.| Using Control and MB1 within the Optional bullets The Severe Thunderstorm Warning
section, select or deselect items such that the text appears in a ‘Text Warngen’
following Severe Thunderstorm Template window.
Parameters are highlighted: An ‘AWIPS Header Block’ window
BASIS FOR WARNING: Confirmed large appears.
Severe Thunderstorm
CALLS TO ACTION: Severe Thunderstorm
CALLS TO ACTION: If caught outside
Then click MB1 on the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
290.| In the AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAIi: SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVR
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
291.| In the text window, replace the ‘™*NAME/INITIALS**!I' | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
292.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMASVROAX'
window (not in edit mode).
293.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
294.| MBL click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Select ‘Severe Weather Statement’ from the can be expired (EXP).
dropdown menu below the ‘Other’ radio button and
verify the created warning is able to be expired
(EXP).
295.| Select the EXP product. The storm vector and polygon appear.
The polygon is uneditable as indicated
by the square vertex points.
The bulletins are grayed out.
296.| MBL1 click the ‘Create Text’ button. The Severe Thunderstorm Warning
text appears in a ‘Text Warngen’
window.
An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
297.| In the AWIPS Header Block, verify the following The Severe Thunderstorm Warning DR #868
selections are set: text remains displayed in the text DR #870
TTAAIi: SAUS43 window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
298.| Verify the Severe Thunderstorm Warning text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
299.| Verify the Severe Thunderstorm Warning text The counties are listed in the Severe DR #869
contains the counties encompassed by the polygon. | Thunderstorm Warning statement.
300.| Verify the Severe Thunderstorm Warning text The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
10.EXP.KOAX.SV.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ /
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(uTC).
301.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
302.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
303.| Verify the text warning contains a presence of closing | The Severe Thunderstorm Warning
$$. text contains a presence of closing $$.
304.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Severe Thunderstorm Warning is
line with the user’s initials. saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
305.| MBL1 click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMASVROAX'
window (not in edit mode).
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
306.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
307.| Close the Text Warngen: OMASVROAX window. The Text Warngen: OMASVROAX
window closes.
308.| MBL1 click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button. Select ‘Severe Weather observing that the expired product
Statement’ from the dropdown menu below the (EXP) exists in the FOLLOWUP
‘Other’ radio button. dropdown menu.
Verify in the ‘FOLLOWUP’ dropdown menu that an
expired product (EXP) that appears as follows:
‘COR.KOAX.SV.W.xxxx(EXP)’
309.| Close the WarnGen GUI. The WarnGen GUI closes.
Flash Flood Warning
Issuing a Flash Flood Warning
310.| MBL1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point s in edit mode.
The WarnGen window appears.
311.| In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector | DR #813
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.
An initial warning area hatched box
appears.
312.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
313.| MB1 click on ‘Flash Flood' in the ‘Product type’ The selection is made as indicated by
section. the radio button. The REPORTED BY
and CALLS TO ACTION sections
update to display items applicable for
Flash Flood Warnings.
The storm motion vector is removed
from the main display, leaving only the
hatched polygon.
314.| Select the ‘Duration:’” to 20 min. The duration is set to 20 min. The DR #813
ending time of the warning updates
with the change in duration.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
315.| MBL click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.
Multiple KOAX counties are included in
the polygon.
Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
316.| In the WarnGen GUI, MBL1 click on the The polygon’s vertices are redrawn on
‘Warned/Hatched Area’ button under the ‘Redraw the vector snapping back to the CWA
Box on Screen from:’ section. border while creating additional
vertices.
Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.
317.| MBL1 within the Optional bullets section, select items | The Flash Flood Warning text appears
such that the following Flash Flood Template in a ‘Text Warngen’ window.
Parameters are highlighted: An ‘AWIPS Header Block’ window
REPORTED BY: Doppler radar indicated appears.
CALLS TO ACTION: Urban flooding...
CALLS TO ACTION: Nighttime flooding...
CALLS TO ACTION: Camper safety...
Then click MB1 on the ‘Create Text' button.
318.| In the AWIPS Header Block, verify the following The Flash Flood Warning text remains | DR #868
selections are set: displayed in the text window in edit DR #870
TTAAji; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
319.| Verify the Flash Flood Warning text contains the The REPORTED BY and CALLS TO
Flash Flood Template Parameters selected. ACTION exist in the Flash Flood
Warning statement.
320.| Verify the Flash Flood Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
321.| Verify the Flash Flood Warning text contains the The counties are listed in the Flash DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
322.| Verify the Flash Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/O.NEW.KOAX.FF.W.0001.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.ER.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
323.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
324.| Verify the text warning contains a presence of closing | The Flash Flood Warning text contains
$$. a presence of closing $3.
325.| In the text window, replace the ‘**REPORT**!' line The Flash Flood Warning is saved.
with a word or phrase. The text window displays the saved
Replace the ‘"*NAME/INITIALS**!" line with the warning.
user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
326.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'’
window (not in edit mode).
327.| Note the VTEC code (the ‘FF.W.xxxx" portion in
particular). FF.W.
328.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lawips/edex/opt/data/shn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
329.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

330.| MB1 click the WarnGen button in the toolbar and
select the ‘Flash Flood' radio button.

Then MBL1 click the ‘Correct/Reissue’ dropdown
menu to verify the created warning is able to be

Verify three lines similar to the following appear:
NEW.KOAX.FF.W.xxxx
EXT.KOAX.FF.W.xxxx
COR.KOAX.FF.W.xxxx(NEW)

corrected (COR), extended (EXT) or reissued (NEW).

The warning is ingested as verified by
observing that the ingested warning
can be corrected (COR), extended
(EXT) or reissued (NEW).

331.| Create another Flash Flood Warning by repeating
steps 293-308, but choosing different options within
the ‘WarnGen: Operational’ window.

The new Flash Flood Warning displays
in the text window.

332.| Verify the VTEC code in the warning is different from
the first Flash Flood Warning (e.g., FF.W.0001
becomes FF.W.0002).

The VTEC code from the first warning
was persisted. The second Flash
Flood Warning contains updated VTEC
coding.

333.| Ingest the warning text file into the ‘warning’ endpoint
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

The warning is ingested.

334.| Close the Text Warngen: OMAFFWOAX window.

The Text Warngen: OMAFFWOAX
window closes.

335.| MB1 click the WarnGen button in the toolbar and
select the ‘Flash Flood' radio button.

Then MBL1 click the ‘Correct/Reissue’ dropdown
menu to verify the created warning is able to be

Verify three lines similar to the following appear:
COR.KOAX.FF.W.xxxx(NEW)
NEW.KOAX.FF.W.xxxx
EXT.KOAX.FF.W.xxxx

corrected (COR), extended (EXT) or reissued (NEW).

The warning is ingested as verified by
observing that the ingested warning
can be corrected (COR), extended
(EXT) or reissued (NEW).

Correcting a Flash Flood Warning (COR)

336.| In the WarnGen GUI, from the ‘Correct/Reissue’
dropdown, select the ‘COR’ product.

The polygon appears.

The polygon is uneditable as indicated
by the square vertex points.

337.| Change the duration and bulletins to be displayed in
the warning text product.

Then MB1 click the ‘Create Text' button.

The Flash Flood Warning text appears
in a ‘Text Warngen’ window.

An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
338.| In the AWIPS Header Block, verify the following The Flash Flood Warning text remains | DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
339.| Verify the Flash Flood Warning text contains the The BASIS FOR WARNING and
Flash Flood Template Parameters selected. CALLS TO ACTION exist in the Flash
Flood Warning statement.
340.| Verify the Flash Flood Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
341.| Verify the Flash Flood Warning text contains the The counties are listed in the Flash DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
342.| Verify the Flash Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.COR.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.ER.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(UTC).
343.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
344.| Verify the text warning contains a presence of closing | The Flash Flood Warning text contains
$$. a presence of closing $3.
345.| In the text window, replace the ‘**REPORT**!' line The Flash Flood Warning is saved.
with a word or phrase. The text window displays the saved
Replace the ‘*™*NAME/INITIALS**!" line with the warning.
user’s initials.
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.
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Test C

ase WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
346.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'
window (not in edit mode).
347.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
348.| MBL click the WarnGen button in the toolbar, select | Verified.
the Flash Flood radio button, and verify a line similar
to the following appears:
‘COR.KOAX.FF.W.xxxx(NEW)’
349.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
Continuing a Flash Flood Warning (CON) by Issuing a Follow-Up for a Flash Flood Warning (FFS)
350.| In the WarnGen GUI, MBL1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Flash Flood Statement’ from the menu.
dropdown menu below the ‘Other’ radio button.
351.| MB1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
352.| MBL click the ‘CON' option. The vector and polygon of the original
warning appear on the main pane.
353.| Modify the warning polygon, but do not remove any | The Flash Flood Statement text
counties from the original warning polygon. appears in a ‘Text Warngen’ window.
MBL1 click the ‘Warned/Hatched Area’ button. An ‘AWIPS Header Block’ window
Note: The polygon can only be reduced in size. appears.
Select the following warning bulletins:
SVR THREAT: Trained spotters reported
THREAT: 70 mph wind
CALLS TO ACTION: Turn around...dont
drown
Then MBI click the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
354.| In the AWIPS Header Block, verify the following The Flash Flood Statement text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAi; SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
355.| Verify the Flash Flood Statement text contains the The SVR THREAT, THREAT and
Flash Flood Template Parameters selected. CALLS TO ACTION exist in the Flash
Flood Statement text.
356.| Verify the Flash Flood Statement text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
357.| Verify the Flash Flood Statement text contains the The counties are listed in the Flash DR #869
counties encompassed by the polygon. Flood Statement text.
358.| Verify the Flash Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.CON.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.ER.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(UTC).
359. Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
360.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
361.| Verify the text warning contains a presence of closing | The Flash Flood Statement text
$3. contains a presence of closing $$.
362.| In the text window, replace the ‘™*NAME/INITIALS**!I" | The Flash Flood Statement is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
363.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX’ window
(not in edit mode).
364.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
365.| Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX
window closes.
366.| MBL1 click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button,
Select ‘Flash Flood Statement’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL click the ‘FOLLOWUP’ dropdown menu.
Verify a line similar to the following appears:
‘COR.KOAX.FF.W.xxxx(CON)
Extending a Flash Flood Warning (EXT)
367.| Inthe WarnGen GUI, MBL1 click the ‘Flash Flood' The polygon appears.
radio button. The polygon is uneditable as indicated
Then MBL1 click the ‘Correct/Extend /Reissue’ by the square vertex points.
dropdown menu and select the ‘EXT’ product.
368.| Modify the polygon, the duration and bulletins to be The Flash Flood Warning text appears
displayed in the warning text product. in a ‘Text Warngen’ window.
Then MBL click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
369.| In the AWIPS Header Block, verify the following The Flash Flood Warning text remains | DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
370.| Verify the Flash Flood Warning text contains the The BASIS FOR WARNING and
Flash Flood Template Parameters selected. CALLS TO ACTION exist in the Flash
Flood Warning statement.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
371.| Verify the Flash Flood Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
372.| Verify the Flash Flood Warning text contains the The counties are listed in the Flash DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
373.| Verify the Flash Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
[10.EXT.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.ER.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
374.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
375.| Verify the text warning contains a presence of closing | The Flash Flood Warning text contains
$$. a presence of closing $3.
376.| In the text window, replace the ‘**REPORT**!' line The Flash Flood Warning is saved.
with a word or phrase. The text window displays the saved
Replace the ‘**NAME/INITIALS*!" line with the warning.
user’s initials.
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send" button.
377.| MB1 click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?". The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'’
window (not in edit mode).
378.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lawips/edex/opt/data/shn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
379.| MB1 click the WarnGen button in the toolbar, select Verified.
the Flash Flood radio button, MB1 click the
‘Correct/Extend/Reissue’ dropdown menu and verify
a line similar to the following appears:
‘COR.KOAX.FF.W.xxxx(EXT)’
380.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
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Test C

ase WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Continuing/Canceling a Flash Flood Warning (CON/CAN)
381.| In the WarnGen GUI, MBL1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Flash Flood Statement’ from the menu.
dropdown menu below the ‘Other’ radio button.
382.| MBL1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
383.| MBL1 click the ‘CON’ option. The vector and polygon of the original
warning appear on the main pane.
384.| Modify the warning polygon to remove at least one The Flash Flood Warning text appears
county from the original warning polygon. in a ‘Text Warngen’ window.
Select the following warning bulletins: An ‘AWIPS Header Block’ window
SVR THREAT: Doppler radar indicated appears.
THREAT: 70 mph wind
THREAT: Penny size halil
CALLS TO ACTION: Nighttime flooding...
Then MBL1 click the ‘Create Text’ button.
385.| In the AWIPS Header Block, verify the following The Flash Flood Warning text remains | DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
386.| Verify the Flash Flood Warning text contains the The SVR THREAT, THREAT and
Flash Flood Template Parameters selected. CALLS TO ACTION exist in the Flash
Flood Warning statement.
387.| Verify the Flash Flood Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
388.| Verify the Flash Flood Warning text contains the The counties are listed in the Flash DR #869
counties encompassed by the polygon. Flood Warning statement.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
389.| Verify the Flash Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The 2
lines of VTEC code should be in the following format:
10.CAN.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.ER.000000T0000Z.000000T0000Z.
000000T0000Z.00/
/0.CON.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.ER.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
390.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
391.| Verify the text warning contains a presence of closing | The Flash Flood Warning text contains
$$. a presence of closing $3.
392.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Flash Flood Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
393.| MBL1 click the ‘Cancel’ button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX’ window
(not in edit mode).
394. | Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lawips/edex/opt/data/shn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
395.| Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX
window closes.
396.| MBL1 click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button. Select ‘Flash Flood
Statement’ fromthe dropdown menu below the
‘Other’ radio button. Then MBL click the
‘FOLLOWUP’ dropdown menu.
Verify two lines similar to the following appear:
‘COR.KOAX.FF.W.xxxx(CON)’
‘COR.KOAX.FF.W.xxxx(CANY
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Reissuing a Flash Flood Warning (NEW)
397.| In the WarnGen GUI, MBL1 click on the ‘Flash Flood’ | ‘Extend/Reissue’ appears in the
radio button. dropdown menu.
398.| From the ‘Extend/Reissue’ dropdown, select the The polygon appears.
‘NEW" product. The polygon is editable.
399.| Modify the polygon, duration and bulletins for the The Flash Flood Warning text appears
warning text product. in a ‘Text Warngen’ window.
Then MBL1 click the ‘Create Text’ button. An ‘AWIPS Header Block’ window
appears.
400.| In the AWIPS Header Block, verify the following The Flash Flood Warning text remains | DR #868
selections are set: displayed in the text window in edit DR #870
TTAAii: SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
401.| Verify the Flash Flood Warning text contains the The BASIS FOR WARNING and
Flash Flood Template Parameters selected. CALLS TO ACTION exist in the Flash
Flood Warning statement.
402.| Verify the Flash Flood Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
403.| Verify the Flash Flood Warning text contains the The counties are listed in the Flash DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
404.| Verify the Flash Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.NEW.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
405.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
406.| Verify the text warning contains a presence of closing | The Flash Flood Warning text contains
$$. a presence of closing $3.
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Test C

ase WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
407.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Flash Flood Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
408.| MBL1 click the ‘Cancel’ button and MBL1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'’
window (not in edit mode).
409.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
410.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
411.| MBL1 click the WarnGen button in the toolbar, select | Verified.
the Flash Flood radio button, and verify three lines
similar to the following appear:
‘COR.KOAX.FF.W.xxxx(NEW)’
‘NEW.KOAX.FF.W.xxxx’
‘EXT.KOAX.FF.W.xxxX’
Cancelling a Flash Flood Warning (CAN)
412.| In the WarnGen GUI, MBL click the ‘Other’ radio The polygon appears.
button. Select ‘Flash Flood Statement’ from the The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. From | by the square vertex points.
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ The bulletins are grayed out.
product.
413.| MBL1 click the ‘Create Text' button. The Flash Flood Statement text
appears in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
414.| In the AWIPS Header Block, verify the following The Flash Flood Statement text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAi; SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
415.| Verify the Flash Flood Statement text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
416.| Verify the Flash Flood Statement text contains the The counties are listed in the Flash DR #869
counties encompassed by the polygon. Flood Statement text.
417.| Verify the Flash Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.CAN.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
418.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
419. | Verify the text warning contains a presence of closing | The Flash Flood Statement text
$3. contains a presence of closing $$.
420.| In the text window, replace the ‘**NAME/INITIALS**!I" | The Flash Flood Statement is saved.
line with the user's initials. The text window displays the saved
MB1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
421.| MB1 click the ‘Cancel button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX’ window
(not in edit mode).
422.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/T010-0005 / 21 Nov. 2008 50

Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.

HARD COPY UNCONTROLLED




Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
423.| Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX
window closes.
424.| MBL1 click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button.
Select ‘Flash Flood Statement’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL click the ‘FOLLOWUP’ dropdown menu
and verify a line similar to the following appears:
‘COR.KOAX.FF.W.xxxx(CANY)
425.| Close the WarnGen GUI. The WarnGen GUI closes.
Expiring a Flash Flood Warning (EXP)
426.| MBL click on the ‘WarnGen'’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
427.| In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector | DR #813
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.
An initial warning area hatched box
appears.
428.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
429.| MBL1 click on ‘Flash Flood' in the ‘Product type’ The selection is made as indicated by
section. the radio button. The REPORTED BY
and CALLS TO ACTION sections
update to display items applicable for
Flash Flood Warnings.
The storm motion vector is removed
from the main display, leaving only the
hatched polygon.
430.| Select the ‘Duration:’ to 15 min. The duration is set to 15 min. The DR #813
ending time of the warning updates
with the change in duration.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

431.| MBL1 click and hold on a vertex and dragging it to
another location outside the koax's CWA boundary.
At the same time, ensure that multiple KOAX
counties are included in the warning polygon.

The hatched area expands within the
enclosed box up to the CWA boundary
but does not cross over the CWA
boundary.

Multiple KOAX counties are included in
the polygon.

Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.

432.1 In the WarnGen GUI, MB1 click on the
‘Warned/Hatched Area’ button under the ‘Redraw
Box on Screen from:’ section.

The polygon’s vertices are redrawn on
the vector snapping back to the CWA
border while creating additional
vertices.

Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.

433.| MB1 within the Optional bullets section, select items
such that the following Flash Flood Template
Parameters are highlighted:

REPORTED BY: Doppler radar indicated
CALLS TO ACTION: Urban flooding...
CALLS TO ACTION: Nighttime flooding...

CALLS TO ACTION: Camper safety...
Then click MB1 on the ‘Create Text' button.

The Flash Flood Warning text appears
in a ‘Text Warngen’ window.

An ‘AWIPS Header Block’ window
appears.

434.| In the AWIPS Header Block, verify the following
selections are set:

TTAAIi: SAUS43

CCCC: KOAX

BBB: NOR

BBB Version: A (grayed out)
WSFO ID: OMA

Product Category: FFW
Product Designator: OAX

Addressee; 000
Then MB1 click the ‘Enter’ button.

The Flash Flood Warning text remains | DR #868
displayed in the text window in edit DR #870
mode.
The AWIPS Header Block window
closes.

435.| In the text window, replace the ‘™*REPORT**!' line
with a word or phrase.

The Flash Flood Warning is saved.
The text window displays the saved

Replace the ‘**NAME/INITIALS**!" line with the warning.
user's initials.
MBL1 click the ‘Save’ button.
Then MB1 click the ‘Send’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
436.| MBL click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX’
window (not in edit mode).
437.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
438.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
439.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Select ‘Flash Flood Statement’ from the dropdown can be expired (EXP).
menu below the ‘Other’ radio button.
Then MBL1 click the ‘FOLLOWUP’ dropdown menu to
verify the created warning is able to expired (EXP).
EXP.KOAX.FF.W.xxxx
440.| Select the EXP product. The polygon appears.
The polygon is uneditable as indicated
by the square vertex points.
The bulletins are grayed out.
441.| MBL1 click the ‘Create Text' button. The Flash Flood Warning text appears
in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
442.| In the AWIPS Header Block, verify the following The Flash Flood Statement text
selections are set: remains displayed in the text window in
TTAAi; SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
443.| Verify the Flash Flood Statement text contains the The date and time attributes exist.
current date and time attributes and the correct The header information is correct.
header information.
444.| Verify the Flash Flood Statement text contains the The counties are listed in the Flash
counties encompassed by the polygon. Flood Statement text.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
445.| Verify the Flash Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
[10.EXP.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ /
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
446.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
447.| Verify the location and motion of the weather event The location and motion of the weather
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
448.| Verify the text warning contains a presence of closing | The Flash Flood Statement text
$$. contains a presence of closing $$.
449.| In the text window, replace the ‘**REPORT**!' line The Flash Flood Statement is saved.
with a word or phrase. The text window displays the saved
Replace the ‘™*NAME/INITIALS**!" line with the warning.
user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
450.| MBL click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?". The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX’ window
(not in edit mode).
451.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/fawips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
452.| Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX
window closes.
453.| MBL1 click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button. observing that the expired product
Select ‘Flash Flood Statement’ from the dropdown (EXP) exists in the Update List
menu below the ‘Other’ radio button. dropdown menu.
Verify in the ‘FOLLOWUP’ dropdown menu that an
expired product (EXP) similar to the following
appears:
‘COR.KOAX.FF.W.xxxx(EXP)’
454.| Close the WarnGen GUI. The WarnGen GUI closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Extreme Wind Warning
Issuing an Extreme Wind Warning
455.| MBL click on the ‘WarnGen'’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
456.| In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector | DR #813
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.
An initial warning area hatched box
appears.
457.| Press the right arrow key on the keyboard once. The oldest radar image in the loop
displays. The point is relabeled ‘Drag
me to Storm’ and appears at the
starting point of the vector.
458.| MBL1 click and hold the ‘Drag me to Storm’ point and | The vector rotates accordingly. The
drag it to another location. spacing between the tick marks adjusts
accordingly.
The hatched warning box remains at its
current position.
459.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
460.| Click MB1 on the ‘Track’ button under the ‘Redraw The hatched box is redrawn on the
Box on Screen from:’ section. vector.
461.| MBL1 click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.
Multiple KOAX counties are included in
the polygon.
Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
462.| MBL click on the ‘Warned/Hatched Area’ button The polygon’s vertices are redrawn on
under the ‘Redraw Box on Screen from:’” section. the vector snapping back to the CWA
border while creating additional
vertices.
Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
463.| MBL click on ‘Other" in the ‘Product type’ section. The selection is made as indicated by
Then select ‘Extreme Wind Warning' from the the radio button. The BASIS FOR
dropdown menu below the ‘Other’ radio button. WARNINGS and CALLS TO ACTION
sections update to display items
applicable for Extreme Wind Warnings.
464.| Select the ‘Duration:’ to 20 min. The duration is set to 20 min. The DR #813
ending time of the warning updates
with the change in duration.
The vector contracts and the time at
the arrowhead modifies.
465.| MB1 within the Optional bullets section, selectitems | The Extreme Wind Warning text
such that the following Extreme Wind Warning appears ina ‘Text Warngen” window.
Template Parameters are highlighted: An ‘AWIPS Header Block’ window
BASIS FOR WARNING: Doppler radar appears.
indicated
CALLS TO ACTION: CTA — Take cover now
Then click MB1 on the ‘Create Text' button.
466.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAii: SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: EWW
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
467.| Verify the Extreme Wind Warning text contains the The BASIS FOR WARNING and
Extreme Wind Warning Template Parameters CALLS TO ACTION exist in the
selected. Extreme Wind Warning statement.
468.| Verify the Extreme Wind Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
469. | Verify the Extreme Wind Warning text contains the The counties are listed in the Extreme | DR #869
counties encompassed by the polygon. Wind Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
470.| Verify the Extreme Wind Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/O.NEW.KOAX.EW.W.0001.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
471.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
472.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
473.| Verify the text warning contains a presence of closing | The Extreme Wind Warning text
$$. contains a presence of closing $$.
474.| In the text window, replace the ™*NAME/INITIALS**!" | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
475.| MBL1 click the ‘Cancel’ button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'’
window (not in edit mode).
476.| Note the VTEC code (the ‘EW.W.xxxx' portion in
particular). EW.W.
477.| Ingest the warning text file into the ‘warning” endpoint | The warning is ingested.
(lawips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
478.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX
window closes.
479.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Then MBL click the ‘Correct/Reissue’ dropdown can be corrected (COR) or reissued
menu to verify the created warning is able to be (NEW).
corrected (COR) or reissued (NEW).
480.| Create another Extreme Wind Warning by repeating | The new Extreme Wind Warning
steps 438-457, but choosing different options within | displays in the text window.
the ‘WarnGen: Operational’ window.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
481.| Verify the VTEC code in the warning is different from | The VTEC code from the first warning
the first Extreme Wind Warning (e.g., EW.W.0001 was persisted. The second Extreme
becomes EW.W.0002). Wind Warning contains updated VTEC
coding.
482.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
483.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX
window closes.
484.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Then MBL click the ‘Correct/Reissue’ dropdown can be corrected (COR) or reissued
menu to verify the created warning is able to be (NEW).
corrected (COR) or reissued (NEW). Verify two lines
similar to the following appear:
COR.KOAX.EW.W.xxxx(NEW)
NEW.KOAX.EW.W.xxxx
Correcting an Extreme Wind Warning (COR)
485.| In the WarnGen GUI, from the ‘Correct/Reissug’ The storm vector and polygon appear.
dropdown, select the ‘COR’ product. The polygon is uneditable as indicated
by the square vertex points.
486.| Change the duration and bulletins to be displayed in | The Extreme Wind Warning text
the warning text product. appears in a ‘Text Warngen’ window.
Then MBL1 click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
487.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAii: SAUS43 edit moge. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: EWW
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
488.| Verify the Extreme Wind Warning text contains the The BASIS FOR WARNING and
Extreme Wind Warning Template Parameters CALLS TO ACTION exist in the
selected. Extreme Wind Warning statement.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
489.| Verify the Extreme Wind Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
490.| Verify the Extreme Wind Warning text contains the The counties are listed in the Extreme | DR #869
counties encompassed by the polygon. Wind Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
491.| Verify the Extreme Wind Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.COR.KOAX.EW.W xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
492.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
493.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
494.| Verify the text warning contains a presence of closing { The Extreme Wind Warning text
$3. contains a presence of closing $3.
495. | In the text window, replace the ‘™*NAME/INITIALS**!" | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
496.| MBL click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'
window (not in edit mode).
497.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/shn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
498.| MBL1 click the WarnGen button in the toolbar, select Verified.
the Other radio button, and verify a line similar to the
following appears:
‘COR.KOAX.EW.W.xxxx(NEW)'
499.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step

Action

Result

Pass/Fail

Contin

uing an Extreme Wind Warning (CON) by Issuing a Follow-Up for an Extreme Wind Warning (SVS)

500.

In the WarnGen GUI, MBL1 click on the ‘Other’ radio
button.

‘FOLLOWUP’ appears in the dropdown
menu.

501.

MBL1 click on the ‘FOLLOWUP’ dropdown menu and
verify the ‘CON’ and ‘CAN’ options are available.

The list includes the ‘CON’ and ‘CAN’
options.

502.

MBL1 click the ‘CON’ option.

The vector and polygon of the original
warning appear on the main pane.

503.

Modify the warning polygon, but do not remove any
counties from the original warning polygon.

MBL1 click the ‘Warned/Hatched Area’ button.
Note: The polygon can only be reduced in size.
Select additional warning bulletins.

Then MBL1 click the ‘Create Text’ button.

The Extreme Wind Warning text
appears in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.

504.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text windowin | DR #870
TTAAi; SAUS43 edit moge. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
505.| Verify the Extreme Wind Warning text contains the The BASIS FOR WARNING and
Extreme Wind Warning Template Parameters CALLS TO ACTION exist in the
selected. Extreme Wind Warning statement.
506.| Verify the Extreme Wind Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
507.| Verify the Extreme Wind Warning text contains the The counties are listed in the Extreme | DR #869
counties encompassed by the polygon. Wind Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
508.| Verify the Extreme Wind Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.CON.KOAX.EW.W.xxxx.Y YMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
509.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
510.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
511.| Verify the text warning contains a presence of closing | The Extreme Wind Warning text
$3. contains a presence of closing $$.
512.| In the text window, replace the ‘**NAME/INITIALS**!" | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL click the ‘Send’ button.
513.| MB1 click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'
window (not in edit mode).
514.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
515.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX
window closes.
516.| MBL1 click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button and select ‘Extreme Wind
Warning'. Then MB1 click the ‘FOLLOWUP’
dropdown menu.
Verify a line similar to the following appears:
‘COR.KOAX.EW.W.xxxx(CON)
Continuing/Canceling an Extreme Wind Warning (CON/CAN)
517.] Inthe WarnGen GUI, MB1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Then MBL click ‘Extreme Wind Warning'. menu.
518.| MBL1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
519.| MBL click the ‘CON’ option. The vector and polygon of the original
warning appear on the main pane.
520.| Modify the warning polygon to remove at least one The Extreme Wind Warning text
county from the original warning polygon. appears in a ‘Text Warngen’ window.
Select additional warning bulletins. An ‘AWIPS Header Block’ window
Then MBL1 click the ‘Create Text’ button. appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
521.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAi; SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
522.| Verify the Extreme Wind Warning text contains the The BASIS FOR WARNING and
Extreme Wind Warning Template Parameters CALLS TO ACTION exist in the
selected. Extreme Wind Warning statement.
523.| Verify the Extreme Wind Warning statement text The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
524.| Verify the Extreme Wind Warning text contains the The counties are listed in the Extreme | DR #869
counties encompassed by the polygon. Wind Warning statement.
Verify cities near the warning vector are included in | The cities near the warning vector are
the pathcast. included in the warning.
525.| Verify the Extreme Wind Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The 2
lines of VTEC code should be in the following format:
/0.CAN.KOAX.EW.W.xxxx.Y YMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/0.CON.KOAX.EW.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(uTC).
526.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
527.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
528.| Verify the text warning contains a presence of closing | The Extreme Wind Warning text
$3. contains a presence of closing $3.
529. In the text window, replace the ‘"™*NAME/INITIALS**!" | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
530.| MB1 click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'’
window (not in edit mode).
531.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
532.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX
window closes.
533.| MB1 click the WarnGen button in the toolbar, select Verified.
the ‘Other’ radio button and select ‘Extreme Wind
Warning'. Then MB1 click the ‘FOLLOWUP’
dropdown menu.
Verify two lines similar to the following appear:
‘COR.KOAX.EW.W.xxxx(CON)'
‘COR.KOAX.EW.W.xxxx(CANY
Reissuing an Extreme Wind Warning (NEW)
534.| In the WarnGen GUI, MBL1 click on the ‘Other"radio | ‘Update List' appears in the dropdown
button. Then MB1 click ‘Extreme Wind Warning'. menu.
535.| From the ‘Update List’ dropdown, select the ‘NEW’ The storm vector and polygon appear.
product. The polygon is editable.
536.| Modify the polygon, duration and for the warning text | The Extreme Wind Warning text
product. appears in a ‘Text Warngen’ window.
Then MBI click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
537.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAii: SAUS43 edit moge. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: EWW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
538.| Verify the Extreme Wind Warning text contains the The BASIS FOR WARNING and
Extreme Wind Warning Template Parameters CALLS TO ACTION exist in the
selected. Extreme Wind Warning statement.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
539.| Verify the Extreme Wind Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
540.| Verify the Extreme Wind Warning text contains the The counties are listed in the Extreme | DR #869
counties encompassed by the polygon. Wind Warning statement.
Verify cities near the warning vector are included in The cities near the warning vector are
the pathcast. included in the warning.
541.| Verify the Extreme Wind Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
[O.NEW.KOAX.EW.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
542.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
543.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
544.| Verify the text warning contains a presence of closing | The Extreme Wind Warning text
$3. contains a presence of closing $$.
545.| In the text window, replace the ‘™NAME/INITIALS*!" | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL click the ‘Send’ button.
546.| MBL click the ‘Cancel' button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'
window (not in edit mode).
547.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/shn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
548.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX
window closes.
549.| MBL click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button, and verify two lines similar to
the following appear:
‘COR.KOAX.EW.W.xxxx(NEW)'
‘NEW.KOAX.EW.W.xxxx’
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Cancelling an Extreme Wind Warning (CAN)
550.| In the WarnGen GUI, MB1 click the ‘Other’ radio The storm vector and polygon appear.
button. From the ‘FOLLOWUP’ dropdown menu, The polygon is uneditable as indicated
select the ‘CAN’ product. by the square vertex points.
The bulletins are grayed out.
551.| MBL click the ‘Create Text' button. The Extreme Wind Warning text
appears in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
552.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAii: SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
553.| Verify the Extreme Wind Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
554.| Verify the Extreme Wind Warning text contains the The counties are listed in the Extreme | DR #869
counties encompassed by the polygon. Wind Warning statement.
555.| Verify the Extreme Wind Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format;
10.CAN.KOAX.EW.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
556.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
557.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
558.| Verify the text warning contains a presence of closing | The Extreme Wind Warning text
$3. contains a presence of closing $$.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
559.| In the text window, replace the ‘**NAME/INITIALS**!" | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL1 click the ‘Send’ button.
560.| MB1 click the ‘Cancel’ button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'
window (not in edit mode).
561.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
562.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX
window closes.
563.| MBL1 click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button, and verify a line similar to the
following appears:
‘COR.KOAX.EW.W.xxxx(CAN)’
564.| Close the WarnGen GUI. The WarnGen GUI closes.
Expiring an Extreme Wind Warning (EXP)
565.| MBL1 click on the ‘WarnGen" button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
566.| Inthe main pane, click and hold MB1 on the ‘Drag A first guess vector appears with the DR #813
me to Storm’ point and drag it to another location point near the center of the line, tick
(ideally on a feature picked up by the radar). marks, and time values at the starting
point, current/endpoint, and arrowhead.
An initial warning area hatched box
appears.
567.| Press the right arrow key on the keyboard once. The oldest radar image in the loop
displays. The point is relabeled ‘Drag
me to Storm’ and appears at the
starting point of the vector.
568.| MBL1 click and hold the ‘Drag me to Storm’ pointand | The vector is redrawn. The spacing
drag it to another location. between the tick marks adjusts
accordingly.
The hatched warning box remains at its
current position.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
569.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
570.| Click MB1 on the ‘Track’ button under the ‘Redraw The hatched box is redrawn on the
Box on Screen from:” section. vector.
571.| MBL1 click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.
Multiple KOAX counties are included in
the polygon.
572.| MBL click on the ‘Warned/Hatched Area’ button The polygon’s vertices are redrawn on
under the ‘Redraw Box on Screen from:’ section. the vector snapping back to the CWA
border while creating additional
vertices.
573.| MBL click on ‘Other’ in the ‘Product type’ section. The selection is made as indicated by
the radio buttons. The BASIS FOR
WARNINGS and CALLS TO ACTION
sections update to display items
applicable for Extreme Wind Warnings.
574.| Select the ‘Duration:’” to 10 min. The duration is set to 10 min. The DR #813
ending time of the warning updates
with the change in duration.
The vector contracts and the time at
the arrowhead modifies.
575.| Using Control and MB1 within the Optional bullets The Extreme Wind Warning text
section, select or deselect items such that the appears in a ‘Text Warngen’ window.
following Extreme Wind Warning Template An ‘AWIPS Header Block’ window
Parameters are highlighted: appears.
BASIS FOR WARNING: Confirmed large
tornado
CALLS TO ACTION: Severe Tornado
CALLS TO ACTION: If caught outside
Then click MB1 on the ‘Create Text’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
576.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAi; SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: EWW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
577.| In the text window, replace the ‘™*NAME/INITIALS**I' | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL click the ‘Send’ button.
578.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'’
window (not in edit mode).
579.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
580.| MBL click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button, and verify the created observing that the ingested warning
warning is able to be expired (EXP). can be expired (EXP).
581.| Select the EXP product. The storm vector and polygon appear.
The polygon is uneditable as indicated
by the square vertex points.
The bulletins are grayed out.
582.| MBL1 click the ‘Create Text' button. The Extreme Wind Warning text
appears in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
583.| In the AWIPS Header Block, verify the following The Extreme Wind Warning text DR #868
selections are set: remains displayed in the text window in | DR #870
TTAAi; SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: SVS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
584.| Verify the Extreme Wind Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
585.| Verify the Extreme Wind Warning text contains the The counties are listed in the Extreme | DR #869
counties encompassed by the polygon. Wind Warning statement.
586.| Verify the Extreme Wind Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
10.EXP.KOAX.EW.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ /
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
587.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
588. | Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
589.| Verify the text warning contains a presence of closing | The Extreme Wind Warning text
$3. contains a presence of closing $$.
590.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Extreme Wind Warning is saved.
line with the user's initials. The text window displays the saved
MBL1 click the ‘Save’ button. warning.
Then MBL click the ‘Send’ button.
591.| MB1 click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAEWWOAX'
window (not in edit mode).
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Test Case WarnGen 2.0 (Draft) DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail

592.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

593.| Close the Text Warngen: OMAEWWOAX window. The Text Warngen: OMAEWWOAX

window closes.
594.| MBL click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button. observing that the expired product
Verify in the Update List dropdown menu that an (EXP) exists in the Update List
expired product (EXP) line similar to the following dropdown menu.
appears:
‘COR.KOAX.EW.W.xxxx(EXP)
595.| Close the WarnGen GUI. The WarnGen GUI closes.

Non-Convective Flash Flood Warning

Issuing a Non-Convective Flash Flood Warning

596.| MBL click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads.

A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.

597.| In the main pane, click- and hold MB1 on the ‘Drag A southwest-northeast oriented vector | DR #813
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,

and arrowhead.

An initial warning area hatched box

appears.
598.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
-Track type: One Storm by the radio buttons.
-Edit: Box and Track
599.| MBL click on ‘Other’ in the ‘Product type’ section. The selection is made as indicated by
Select ‘non-convective FFW’ from the dropdown the radio button. The PRIMARY
menu below the ‘Other’ radio button. CAUSE, DAM FAILURE REPORTED
BY and CALLS TO ACTION sections
update to display items applicable for
Non-Convective Flash Flood Warnings.
The storm motion vector is removed
from the main display, leaving only the
hatched polygon.
600.| Select the ‘Duration:’” to 20 min. The duration is set to 20 min. The DR #813
ending time of the warning updates
with the change in duration.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

601.| MBL1 click and hold on a vertex and dragging it to
another location outside the koax's CWA boundary.
At the same time, ensure that multiple KOAX
counties are included in the warning polygon.

The hatched area expands within the
enclosed box up to the CWA boundary
but does not cross over the CWA
boundary.

Multiple KOAX counties are included in
the polygon.

Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.

602.| In the WarnGen GUI, MB1 click on the
‘Warned/Hatched Area’ button under the ‘Redraw
Box on Screen from:’ section.

The polygon’s vertices are redrawn on
the vector snapping back to the CWA
border while creating additional
vertices.

Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.

603.| MB1 within the Optional bullets section, select items
such that the following Non-Convective Flash Flood
Template Parameters are highlighted:

PRIMARY CAUSE: levee failure

The Non-Convective Flash Flood
Warning text appears in a ‘Text
Warngen’ window.

An ‘AWIPS Header Block’ window

DAM FAILURE REPORTED BY: law appears.
enforcement
CALLS TO ACTION: Do not drive into water
Then click MB1 on the ‘Create Text" button.
604.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868

selections are set:
TTAAIi: SAUS43
CCCC: KOAX
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX

Addressee: 000
Then MB1 click the ‘Enter’ button.

Warning text remains displayed inthe | DR #870
text window in edit mode.

The AWIPS Header Block window
closes.

605.| Verify the Non-Convective Flash Flood Warning text
contains the Non-Convective Flash Flood Template

The PRIMARY CAUSE, DAM
FAILURE REPORTED BY and CALLS

Parameters selected. TO ACTION exist in the Non-
Convective Flash Flood Warning
statement.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
606.| Verify the Non-Convective Flash Flood Warning text | The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header information is correct.
correct header information.
607.| Verify the Non-Convective Flash Flood Warning text | The counties are listed in the Non- DR #869
contains the counties encompassed by the polygon. | Convective Flash Flood Warning
Verify cities in the warning polygon are included in statement.
the pathcast. The cities in the warning polygon are
included in the warning.
608.| Verify the Non-Convective Flash Flood Warning text | The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/O.NEW.KOAX.FF.W.0001.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTe).
609.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
610.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$3. Warning text contains a presence of
closing $3.
611.| Inthe text window, replace the ‘**NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user’s initials. Warning is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
612.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'
window (not in edit mode).
613.| Note the VTEC code (the ‘FF.W.xxxx" portion in
particular). FEW.
614.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
615.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
616.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘non-convective FFW' radio button. observing that the ingested warning
Then MB1 click the ‘Correct/Reissue’ dropdown can be corrected (COR), extended
menu to verify the created waming is able to be (EXT) or reissued (NEW).
corrected (COR), extended (EXT) or reissued (NEW).
Verify three lines similar to the following appear:
NEW.KOAX.FF.W.xxxx
EXT.KOAX.FF.W.xxxx
COR.KOAX.FF.W.xxxx(NEW)
617.| Create another Non-Convective Flash Flood Warning | The new Non-Convective Flash Flood
by repeating steps 579-594, but choosing different Warning displays in the text window.
options within the ‘WarnGen: Operational’ window.
618.| Verify the VTEC code in the warning is different from | The VTEC code from the first warning
the first Non-Convective Flash Flood Warning (e.g., | was persisted. The second Non-
FF.W.0001 becomes FF.W.0002). Convective Flash Flood Warning
contains updated VTEC coding.
619.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
620.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
621.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. Select ‘non- observing that the ingested warning
convective FFW’ from the dropdown menu below the | can be corrected (COR), extended
‘Other’ radio button. (EXT) or reissued (NEW).
Then MBL1 click the ‘Correct/Reissue’ dropdown
menu to verify the created warning is able to be
corrected (COR), extended (EXT) or reissued (NEW).
Verify three lines similar to the following appear:
COR.KOAX.FF.W.xxxx(NEW)
NEW.KOAX.FF.W.xxxx
EXT.KOAX.FF.W.xxxx
Correcting a Non-Convective Flash Flood Warning (COR)
622.| In the WarnGen GUI, from the ‘Correct/Reissue’ The polygon appears.
dropdown, select the ‘COR’ product. The polygon is uneditable as indicated
by the square vertex points.
623.| Change the duration and bulletins to be displayed in | The Non-Convective Flash Flood
the warning text product. Warning text appears in a ‘Text
Then MB1 click the ‘Create Text’ button. Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
624.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868
selections are set: Warning text remains displayed inthe | DR #870
TTAAIi: SAUS43 text window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
625.| Verify the Non-Convective Flash Flood Warning text - | The PRIMARY CAUSE, DAM
contains the Non-Convective Flash Flood Template | FAILURE REPORTED BY and CALLS
Parameters selected. TO ACTION exist in the Non-
Convective Flash Flood Warning
statement.
626.| Verify the Non-Convective Flash Flood Warning text | The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header informationis correct.
correct header information.
627.| Verify the Non-Convective Flash Flood Warning text | The counties are listed in the Non- DR #869
contains the counties encompassed by the polygon. | Convective Flash Flood Warning
Verify cities in the warning polygon are included in statement.
the pathcast. The cities in the warning polygon are
included in the warning.
628.| Verify the Non-Convective Flash Flood Warning text | The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/0.COR.KOAX.FF.W.xxxx.YYMMDDTHHmmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
629.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
630.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$$. Warning text contains a presence of
closing $3.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
631.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user's initials. Warning is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MBL click the ‘Send’ button. warning.
632.| MBL1 click the ‘Cancel’ button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'’
window (not in edit mode).
633.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
634.| MB1 click the WarnGen button in the toolbar, select | Verified.
the Non-Convective Flash Flood radio button, and
verify a line similar to the following appears:
‘COR.KOAX.FF.W.xxxx(NEW)’
635.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
Continuing a Non-Convective Flash Flood Warning (CON) by Issuing a Follow-Up for a
Non-Convective Flash Flood Warning (FFS)
636.| In the WarnGen GUI, MB1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘non-convective FFS’ from the menu.
dropdown menu below the ‘Other’ radio button.
637.| MB1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
638.| MBL1 click the ‘CON’ option. The vector and polygon of the original
warning appear on the main pane.
639.| Modify the warning polygon, but do not remove any | The Non-Convective Flash Flood
counties from the original warning polygon. Statement text appears in a ‘Text
MB1 click the ‘Warned/Hatched Area’ button. Warngen’ window.
Note: The polygon can only be reduced in size. An ‘AWIPS Header Block’ window
Select the following warning bulletins: appears.
PRIMARY CAUSE:
DAM FAILURE REPORTED BY:
CALLS TO ACTION: Turn around...dont
drown
Then MBL click the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
640.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868
selections are set: Statement text remains displayed in DR #870
TTAAIi: SAUS43 the text window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
641.| Verify the Non-Convective Flash Flood Statement The PRIMARY CAUSE, DAM
text contains the Non-Convective Flash Flood FAILURE REPORTED BY and CALLS
Template Parameters selected. TO ACTION exist in.the Non-
Convective Flash Flood Statement text.
642.| Verify the Non-Convective Flash Flood Statement The date and time attributes exist. DR #782
text contains the current date and time attributes and | The header information is correct.
the correct header information.
643.| Verify the Non-Convective Flash Flood Statement The counties are listed in the Non- DR #869
text contains the counties encompassed by the Convective Flash Flood Statement text.
polygon.
644.| Verify the Non-Convective Flash Flood Statement The VTEC code exists and is accurate.
text contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/0.CON.KOAX.FF.W.xxxx.Y YMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(UTC).
645.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
646.| Verify the location and motion of the weather event The location and motion of the weather | DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
647.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$3. Statement text contains a presence of
closing $$.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
648.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user’s initials. Statement is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MBL click the ‘Send’ button. warning.
649.| MBL click the ‘Cancel’ button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX' window
(not in edit mode).
650.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
651.| Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX
window closes.
652.| MBL1 click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button,
Select ‘non-convective FFS’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL click the ‘FOLLOWUP’ dropdown menu.
Verify a line similar to the following appears:
‘COR.KOAX.FF.W.xxxx(CON)
Extending a Non-Convective Flash Flood Warning (EXT)
653.| In the WarnGen GUI, MBL1 click the ‘Other’ radio The polygon appears.
button. Select ‘non-convective FFW’ from the The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. by the square vertex points.
Then MB1 click the ‘Correct/Extend /Reissue’
dropdown menu and select the ‘EXT’ product.
654.| Modify the polygon, the duration and bulletins to be The Non-Convective Flash Flood
displayed in the warning text product. Warning text appears in a ‘Text
Then MBL click the ‘Create Text' button. Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
655.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868
selections are set: Warning text remains displayed inthe | DR #870
TTAAIi: SAUS43 text window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
656.| Verify the Non-Convective Flash Flood Warning text - | The PRIMARY CAUSE, DAM
contains the Non-Convective Flash Flood Template | FAILURE REPORTED BY and CALLS
Parameters selected. TO ACTION exist in the Non-
Convective Flash Flood Warning
statement.
657.| Verify the Non-Convective Flash Flood Warning text | The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header informationis correct.
correct header information.
658.| Verify the Non-Convective Flash Flood Warning text | The counties are listed in the Non- DR #869
contains the counties encompassed by the polygon. | Convective Flash Flood Warning
Verify cities in the warning polygon are included in statement.
the pathcast. The cities in the warning polygon are
included in the warning.
659.| Verify the Non-Convective Flash Flood Warning text | The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
10.EXT.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
660.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
661.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$$. Warning text contains a presence of
closing $3.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
662.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user's initials. Warning is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MBL click the ‘Send’ button. warning.
663.| MBL1 click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'’
window (not in edit mode).
664.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
665.| MB1 click the WarnGen button in the toolbar, select | Verified.
the Non-Convective Flash Flood radio button, MB1
click the ‘Correct/Extend/Reissue’ dropdown menu
and verify a line similar to the following appears:
‘COR.KOAX.FF.W.XXxx(EXT)’
666.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
Continuing/Canceling a Non-Convective Flash Flood Warning (CON/CAN)
667.| In the WarnGen GUI, MB1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘non-convective FFS’ from the menu.
dropdown menu below the ‘Other’ radio button.
668.| MB1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
669.| MBL1 click the ‘CON’ option. The vector and polygon of the original
warning appear on the main pane.
670.| Modify the warning polygon to remove at least one The Non-Convective Flash Flood
county from the original warning polygon. Warning text appears in a ‘Text
Select the following warning bulletins: Warngen’ window.
PRIMARY CAUSE: An ‘AWIPS Header Block’ window
DAM FAILURE REPORTED BY: appears.
CALLS TO ACTION:
Then MBL1 click the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
671.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868
selections are set: Warning text remains displayed inthe | DR #870
TTAAIi: SAUS43 text window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
672.| Verify the Non-Convective Flash Flood Warning text - | The PRIMARY CAUSE, DAM
contains the Non-Convective Flash Flood Template | FAILURE REPORTED BY and CALLS
Parameters selected. TO ACTION exist in the Non-
Convective Flash Flood Warning
statement.
673.| Verify the Non-Convective Flash Flood Warning text | The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header informationis correct.
correct header information.
674.| Verify the Non-Convective Flash Flood Warning text | The counties are listed in the Non- DR #869
contains the counties encompassed by the polygon. -~ | Convective Flash Flood Warning
statement.
675.| Verify the Non-Convective Flash Flood Warning text | The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The 2 lines of VTEC code should be in the
following format:
10.CAN.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
/0.CON.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(uTC).
676.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
677.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$$. Warning text contains a presence of
closing $3.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

678.| In the text window, replace the ‘™*NAME/INITIALS**!
line with the user's initials.

MB1 click the ‘Save’ button.
Then MB1 click the ‘Send’ button.

The Non-Convective Flash Flood
Warning is saved.

The text window displays the saved
warning.

679.| MBL1 click the ‘Cancel’ button and MB1 click the ‘Yes’
button in the message box that states ‘Any unsaved
changes will be lost. Cancel anyway?'.

A Confirm Cancel window opens.
The Confirm Cancel window closes.

The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX' window
(not in edit mode).

680.| Ingest the warning text file into the ‘warning’ endpoint
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

The warning is ingested.

681.| Close the Text Warngen: OMAFFSOAX window.

The Text Warngen: OMAFFSOAX
window closes.

682.| MBL1 click the WarnGen button in the toolbar and

select the ‘Other’ radio button. Select ‘non-

convective FFS’ from the dropdown menu below the

‘Other’ radio button. Then MBL click the

‘FOLLOWUP’ dropdown menu.

Verify two lines similar to the following appear:
‘COR.KOAX.FF.W.xxxx(CON)’

‘COR.KOAX.FF.W.xxxX(CAN)

Verified.

Reissuing a Non-Convective Flash Flood Warning (NEW)

683.| In the WarnGen GUI, MBL1 click on the ‘Other’ radio
button. Select ‘non-convective FFW' from the
dropdown menu below the ‘Other’ radio button.

‘Extend/Reissue’ appears in the
dropdown menu.

684.| From the ‘Extend/Reissue’ dropdown, select the
‘NEW’ product.

The polygon appears.
The polygon is editable.

685.| Modify the polygon, duration and bulletins for the
warning text product.

Then MBL1 click the ‘Create Text’ button.

The Non-Convective Flash Flood
Warning text appears in a ‘Text
Warngen' window.

An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
686.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868
selections are set: Warning text remains displayed inthe | DR #870
TTAAIi: SAUS43 text window in edit mode.
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
687.| Verify the Non-Convective Flash Flood Warning text - | The PRIMARY CAUSE, DAM
contains the Non-Convective Flash Flood Template | FAILURE REPORTED BY and CALLS
Parameters selected. TO ACTION exist in the Non-
Convective Flash Flood Warning
statement.
688.| Verify the Non-Convective Flash Flood Warning text | The date and time attributes exist. DR #782
contains the current date and time attributes and the | The header informationis correct.
correct header information.
689.| Verify the Non-Convective Flash Flood Warning text | The counties are listed in the Non- DR #869
contains the counties encompassed by the polygon. | Convective Flash Flood Warning
Verify cities in the warning polygon are included in statement.
the pathcast. The cities in the warning polygon are
included in the warning.
690.| Verify the Non-Convective Flash Flood Warning text | The VTEC code exists and is accurate.
contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/0.NEW.KOAX.FF.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
691.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
692.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$S. Warning text contains a presence of
closing $$.
693.| In the text window, replace the ‘™*NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user’s initials. Warning is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
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Test C

ase WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
694.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'
window (not in edit mode).
695.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
696.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
697.| MBL1 click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button. Select ‘non-
convective FFW’ from the dropdown menu below the
‘Other’ radio button. Then verify three lines similar to
the following appear:
‘COR.KOAX.FF.W.xxxx(NEW)'
‘NEW.KOAX.FF.W.xxxx’
‘EXT.KOAX.FF.W.xxxX’
Cancelling a Non-Convective Flash Flood Warning (CAN)
698.| In the WarnGen GUI, MB1 click the ‘Other’ radio The polygon appears.
button. Select ‘non-convective FFS' from the The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. From | py the square vertex points.
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ .
The bulletins are grayed out.
product.
699.| MBL1 click the ‘Create Text’ button The Non-Convective Flash Flood
Statement text appears in a ‘Text
Warngen' window.
An ‘AWIPS Header Block’ window
appears.
700.| Inthe AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868
selections are set: Statement text remains displayed in
TTAAii SAUSA3 the text window in edit mode.. DR #870
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
701.| Verify the Non-Convective Flash Flood Statement The date and time attributes exist. DR #782
text contains the current date and time attributes and | The header information is correct.
the correct header information.
702.| Verify the Non-Convective Flash Flood Statement The counties are listed in the Non- DR #869
text contains the counties encompassed by the Convective Flash Flood Statement text.
polygon.
703.| Verify the Non-Convective Flash Flood Statement The VTEC code exists and is accurate.
text contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
/0.CAN.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
704.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
705.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$$. Statement text contains a presence of
closing $$.
706.| In the text window, replace the ‘**NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user’s initials. Statement is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
707.| MBL1 click the ‘Cancel" button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX' window
(not in edit mode).
708.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lfawips/edex/opt/data/shn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
709.| Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX
window closes.
710.| MBL1 click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button.
Select ‘non-convective FFS’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL click the ‘FOLLOWUP’ dropdown menu
and verify a line similar to the following appears:
‘COR.KOAX.FF.W.xxxx(CANY)
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step

Action

Result

Pass/Fail

711.

Close the WarnGen GUI.

The WarnGen GUI closes.

Expiring a Non-Convective Flash Flood Warning (EXP)

712.

MBL1 click on the ‘WarnGen’ button in the tool bar.

The WarnGen application loads.

A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is-in edit mode.

The WarnGen window appears.

713.

In the main pane, click and hold MB1 on the ‘Drag
me to Storm’ point and drag it to another location
(ideally on a feature picked up by the radar).

A southwest-northeast oriented vector
appears with the point near the center
of the line, tick marks, and time values
at the starting point, current/endpoint,

and arrowhead.

An initial warning area hatched box
appears.

DR #813

714.

In the ‘WarnGen’ window, select the following:
-Track type: One Storm
-Edit: Box and Track

The selections are made as indicated
by the radio buttons.

715.

MBL1 click on ‘non-convective FFS’ in the ‘Product
type’ section.

The selection is made as indicated by
the radio button. The PRIMARY

CAUSE, DAM FAILURE REPORTED
BY and CALLS TO ACTION sections
update to display items applicable for

Non-Convective Flash Flood Warnings.

The storm motion vector is removed
from the main display, leaving only the
hatched polygon.

716.

Select the ‘Duration:’ to 15 min.

The duration is set to 15 min. The
ending time of the warning updates
with the change in duration.

DR #813

717.

MBL1 click and hold on a vertex and dragging it to

another location outside the koax's CWA boundary.

At the same time, ensure that multiple KOAX
counties are included in the warning polygon.

The hatched area expands within the
enclosed box up to the CWA boundary
but does not cross over the CWA
boundary.

Multiple KOAX counties are included in
the polygon.

Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
718.| In the WarnGen GUI, MB1 click on the The polygon’s vertices are redrawn on
‘Warned/Hatched Area’ button under the ‘Redraw the vector snapping back to the CWA
Box on Screen from:’ section. border while creating additional
vertices.
Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.
719.| MB1 within the Optional bullets section, select items | The Non-Convective Flash Flood
such that the following Non-Convective Flash Flood | Warning text appears in a ‘Text
Template Parameters are highlighted: Warngen’ window.
PRIMARY CAUSE: An ‘AWIPS Header Block’ window
DAM FAILURE REPORTED BY: appears:
CALLS TO ACTION: Urban flooding...
Then click MB1 on the ‘Create Text' button.
720.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood DR #868
selections are set: Warning text remains displayed in the
TTAAIi: SAUS43 text window in edit mode. DR #870
CCCC: KOAX The AWIPS Header Block window
BBB: NOR closes.
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFW
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
721.| In the text window, replace the ‘*"*NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user’s initials. Warning is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
722.| MBL1 click the ‘Cancel’ button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any.unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?". The warning remains displayed in the
‘Text WarnGen: OMAFFWOAX'
window (not in edit mode).
723.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
724.| Close the Text Warngen: OMAFFWOAX window. The Text Warngen: OMAFFWOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
725.| MBL click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Select ‘non-convective FFS’ from the dropdown can be expired (EXP).
menu below the ‘Other’ radio button.
Then MBL1 click the ‘FOLLOWUP’ dropdown menu to
verify the created warning is able to expired (EXP).
Verify the line similar to the following appears:
EXP.KOAX.FF.W.xxxx
726.| Select the EXP product. The polygon appears.
The polygonis uneditable as indicated
by the square vertex points.
The bulletins are grayed out.
727.| MBL1 click the ‘Create Text button. The Non-Convective Flash Flood
Warning text appears in a ‘Text
Warngen' window.
An ‘AWIPS Header Block’ window
appears.
728.| In the AWIPS Header Block, verify the following The Non-Convective Flash Flood
selections are set: Statement text remains displayed in
TTAAIi: SAUS43 the text window in edit mode.
CCCC: KOAX The AWIPS Header Block window
BBB: NOR e
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FFS
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
729.| Verify the Non-Convective Flash Flood Statement The date and time attributes exist.
text contains the current date and time attributes and | The header information is correct.
the correct header information.
730.| Verify the Non-Convective Flash Flood Statement The counties are listed in the Non-
text contains the counties encompassed by the Convective Flash Flood Statement text.
polygon.
731.| Verify the Non-Convective Flash Flood Statement The VTEC code exists and is accurate.
text contains the VTEC code above the BULLETIN
section. The VTEC code should be in the following
format:
10.EXP.KOAX.FF.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ /
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
732.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
733.| Verify the location and motion of the weather event The location and motion of the weather
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
734.| Verify the text warning contains a presence of closing | The Non-Convective Flash Flood
$$. Statement text contains a presence of
closing $3.
735.| In the text window, replace the ‘**NAME/INITIALS**!" | The Non-Convective Flash Flood
line with the user’s initials. Statement is saved.
MBL1 click the ‘Save’ button. The text window displays the saved
Then MB1 click the ‘Send’ button. warning.
736.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFFSOAX’ window
(not in edit mode).
737.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
738.| Close the Text Warngen: OMAFFSOAX window. The Text Warngen: OMAFFSOAX
window closes.
739.| MBL1 click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button. observing that the expired product
Select ‘non-convective FFS’ from the dropdown (EXP) exists in the Update List
menu below the ‘Other’ radio button. dropdown menu.
Verify in the ‘FOLLOWUP’ dropdown menu that an
expired product (EXP) that appears as follows:
‘COR.KOAX.FF.W.XXXX(EXP)'
740.| Close the WarnGen GUI. The WarnGen GUI closes.
Areal Flood Warning
Issuing an Areal Flood Warning
741.| MBL1 click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
742.| In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector DR #3813
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.
An initial warning area hatched box
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

743.| In the ‘WarnGen’ window, select the following:
-Track type: One Storm
-Edit: Box and Track

The selections are made as indicated
by the radio buttons.

744.] MBL click on ‘Other’ in the ‘Product type’ section.
Select ‘Areal Flood Warning’ from the dropdown
menu below the ‘Other’ radio button.

The selection is made as indicated by
the radio button. The primary cause
other than rain and CALLS TO
ACTION sections update to display
items applicable for Areal Flood
Warnings.

The storm motion vector is removed
from the main display, leaving only the
hatched polygon.

745.| Select the ‘Duration:’ to 20 min.

The_durgtion is set to ZQ min. The DR #813
ending time of the warning updates
with the change in duration.

746.| MBL1 click and hold on a vertex and dragging it to
another location outside the koax's CWA boundary.
At the same time, ensure that multiple KOAX
counties are included in the warning polygon.

The hatched area expands within the
enclosed box up to the CWA boundary
but does not cross over the CWA
boundary.

Multiple KOAX counties are included in
the polygon.

Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.

747.| In the WarnGen GUI, MB1 click on the
‘Warned/Hatched Area’ button under the ‘Redraw
Box on Screen from:’ section.

The polygon’s vertices are redrawn on
the vector snapping back to the CWA
border while creating additional
vertices.

Portions of the county not hatched, as

discussed in step 16, are not included
in the updated polygon.

748.| MB1 within the Optional bullets section, select items
such that the following Areal Flood Template
Parameters are highlighted:

The Areal Flood Warning text appears
in a ‘Text Warngen’ window.

An ‘AWIPS Header Block’ window

primary cause other than rain: Ice Jam appears.
CALLS TO ACTION: Do not drive into water
Then click MB1 on the ‘Create Text button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
749.| In the AWIPS Header Block, verify the following The Areal Flood Warning text remains | DR #868
selections are set: displayed in the text window in edit DR #870
TTAAi; SAUS43 mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
750.| Verify the Areal Flood Warning text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Warning statement.
751.| Verify the Areal Flood Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
752.| Verify the Areal Flood Warning text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
753.| Verify the Areal Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/O.NEW.KOAX.FA.W.0001.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.1C.000000T0000Z.000000TO000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(UTC).
754.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
755. Verify the text warning contains a presence of closing | The Areal Flood Warning text contains
$3. a presence of closing $3.
756.| In the text window, replace the ‘**WARNING The Areal Flood Warning is saved.
BASIS*!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘"*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
757.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFLWOAX'
window (not in edit mode).
758.| Note the VTEC code (the ‘FA.W.xxxx' portion in
particular). FAW.
759.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
760.| Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX
window closes.
761.| MBI click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Areal Flood Warning' radio button. observing that the ingested warning
Then MBL click the ‘Correct/Reissue’ dropdown can be corrgcted (COR), extended
menu to verify the created warning is able to be (EXT) or reissued (NEW).
corrected (COR), extended (EXT) or reissued (NEW).
Verify three lines similar to the following appear:
NEW.KOAX.FA.W.xxxx
EXT.KOAX.FA.W.xXxX
COR.KOAX.FA.W .xxxx(NEW)
762.| Create another Areal Flood Warning by repeating The new Areal Flood Warning displays
steps 724-739, but choosing different options within | in the text window.
the ‘WarnGen: Operational’ window.
763.| Verify the VTEC code in the warning is different from | The VTEC code from the first warning
the first Areal Flood Warning (e.g., FA.W.0001 was persisted. The second Areal
becomes FA.W.0002). Flood Warning contains updated VTEC
coding.
764.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awipsledex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
765.| Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
766.| MBL click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. Select ‘Areal Flood observing that the ingested warning
Warning’ from the dropdown menu below the ‘Other’ | can be corrected (COR), extended
radio button. (EXT) or reissued (NEW).
Then MBL click the ‘Correct/Reissue’ dropdown
menu to verify the created warning is able to be
corrected (COR), extended (EXT) or reissued (NEW).
Verify three lines similar to the following appear:
COR.KOAX.FA.W.xxxx(NEW)
NEW.KOAX.FA.W.xxxx
EXT.KOAX.FA.W.xxxx
Correcting an Areal Flood Warning (COR)
767.| In the WarnGen GUI, from the ‘Correct/Reissuge’ The polygon-appears.
dropdown, select the ‘COR" product. The polygon is uneditable as indicated
by the square vertex points.
768.| Change the duration and bulletins to be displayed in | The Areal Flood Warning text appears
the warning text product. in a ‘Text Warngen’ window.
Then MBL1 click the ‘Create Text’ button. An ‘AWIPS Header Block’ window
appears.
769.| In the AWIPS Header Block, verify the following The Areal Flood Waming text remains | pR #g68
selections are set: displayed in the text window in edit
TTAAIi: SAUS43 '
The AWIPS Header Block window
CCCC: KOAX clases.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLW
Product Designator: OAX
Addressee: 000
Then MB1 click the ‘Enter’ button.
770.| Verify the Areal Flood Warning text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Warning statement.
771.| Verify the Areal Flood Warning text contains the The date and time attributes exist. DR #782
current Qate anq time attributes and the correct The header information is correct.
header information.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
772.| Verify the Areal Flood Warning text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
773.| Verify the Areal Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.COR.KOAX.FA.W xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(uTC).
774.] Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471.9981 4488 text product.
9977...).
775.| Verify the text warning contains a presence of closing | The Areal Flood Warning text contains
$$. a presence of closing $3.
776.| In the text window, replace the ‘"*WARNING The Areal Flood Warning is saved.
BASIS**! a}n.d !--*thlonal description of the path of = | 114 taxt window displays the saved
the flood--I" lines with a word or phrase and the warning
‘T*NAME/INITIALS**!" line with the user’s initials. '
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.
777.| MB1 click the ‘Cancel’ button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved The Confirm Cancel window closes
changes will be lost. Cancel anyway?". _ o o
The warning remains displayed in the
‘Text WarnGen: OMAFLWOAX'
window (not in edit mode).
778.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
779.| MB1 click the WarnGen button in the toolbar, select | Verified.
the Areal Flood radio button, and verify a line similar
to the following appears:
‘COR.KOAX.FAW.xxxx(NEW)
780.| Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Continuing an Areal Flood Warning (CON) by Issuing a Follow-Up for an Areal Flood Warning (FLS)
781.] In the WarnGen GUI, MBL1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Areal Flood Statement’ from the menu.
dropdown menu below the ‘Other’ radio button.
782.| MBL click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
783.| MBL click the ‘CON'’ option. The vector and polygon of the original
warning appear on the main pane.
784.| Modify the warning polygon, but do not remove any | The Areal Flood Statement text
counties from the original warning polygon. appears in a ‘Text Warngen' window.
MBL1 click the ‘Warned/Hatched Area’ button. An ‘AWIPS Header Block’ window
Note: The polygon can only be reduced in size. appears.
Select the following warning bulletins:
primary cause other than rain:
CALLS TO ACTION: Turn around...dont
drown
Then MBL1 click the ‘Create Text’ button.
785.| In the AWIPS Header Block, verify the following The Areal Flood Statement text
\ _ A ) ; .| DR #3868
selections are set: remains displayed in the text window in
TTAAI: SAUS43 edit mode. DR #870
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
786.| Verify the Areal Flood Statement text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Statement text.
787.| Verify the Areal Flood Statement text contains the The date and time attributes exist.
i i . o DR #782
current date and time attributes and the correct The header information is correct.
header information.
788.| Verify the Areal Flood Statement text contains the The counties are listed in the Areal
. DR #869
counties encompassed by the polygon. Flood Statement text.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
789.| Verify the Areal Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.CON.KOAX.FA.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000TO000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(ute).

790.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).

791. Vgrify the location and motion oflthe weather event The Ioca.tion and motion of the Wea}her DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.

792.| Verify the text warning contains a presence of closing | The Areal Flood Statement text
$3. contains a presence of closing $$.

793.| In the text window, replace the ‘**WARNING The Areal Flood Statement is saved.
BASIS**!"and “I--*optional description of the path of | The text window displays the saved
the flood--!" lines with a word or phrase and the warning.

‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.

794.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the

‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).

795.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lawips/edex/opt/data/shn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

796.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX

window closes.

797.| MBL click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button,

Select ‘Areal Flood Statement’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL click the ‘FOLLOWUP’ dropdown menu.
Verify a line similar to the following appears:
‘COR.KOAX.FA.W.xxxx(CON)
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Extending an Areal Flood Warning (EXT)
798.| In the WarnGen GUI, MB1 click the ‘Other’ radio The polygon appears.
button. Select ‘Areal Flood Warning’ from the The ; ; -
‘ L9 polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. by the square vertex points.
Then MBL click the ‘Correct/Extend /Reissue’
dropdown menu and select the ‘EXT’ product.
799.| Modify the polygon, the duration and bulletins to be The Areal Flood Warning text appears
displayed in the warning text product. in a ‘Text Warngen’ window.
Then MBL click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
800.| In the AWIPS Header Block, verify the following The Areal Flood Wamning text remains | pR #g68
selections are set: displayed in the text window in edit
TTAAII: SAUS43 '
The AWIPS Header Block window
CCCC: KOAX closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
801.| Verify the Areal Flood Warning text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Warning statement.
802.| Verify the Areal Flood Warning text contains the The date and time attributes exist. DR #782
current Qate anq time attributes and the correct The header information is correct.
header information.
803.| Verify the Areal Flood Warning text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
804.| Verify the Areal Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
[0.EXT.KOAX.FA.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(UTC).
805. | Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
806.| Verify the text warning contains a presence of closing | The Areal Flood Warning text contains
$S. a presence of closing $3.
807.| In the text window, replace the ‘**WARNING The Areal Flood Warning is saved.
BASIS**| a}n'd !--*thlonal description of the path of The text window displays the saved
the flood--!" lines with a word or phrase and the warning
‘T*NAME/INITIALS**!" line with the user’s initials. '
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
808.| MBI click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved The Confirm Cancel window closes
changes will be lost. Cancel anyway?". . o o
The warning remains displayed in the
‘Text WarnGen: OMAFLWOAX'
window (not in edit mode).
809.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
810.| MB1 click the WarnGen button in the toolbar, select | Verified.
the Areal Flood radio button, MB1 click the
‘Correct/Extend/Reissue’ dropdown menu and verify
a line similar to the following appears:
‘COR.KOAX.FAW.XXxX(EXT)’
811.| Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Continuing/Canceling an Areal Flood Warning (CON/CAN)
812.| In the WarnGen GUI, MBL1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Areal Flood Statement’ from the menu.
dropdown menu below the ‘Other’ radio button.
813.| MBL click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
814.| MBL click the ‘CON'’ option. The vector and polygon of the original
warning appear on the main pane.
815.| Modify the warning polygon to remove at least one The Areal Flood Warning text appears
county from the original warning polygon. in a ‘Text Warngen’ window.
Select the following warning bulletins: An ‘AWIPS Header Block’ window
primary cause other than rain: appears.
CALLS TO ACTION:
Then MBL1 click the ‘Create Text’ button.
816.| In the AWIPS Header Block, verify the following The Areal Flood Waming text remains | pR #g68
selections are set: displayed in the text window in edit
i mode DR #870
TTAAIi: SAUS43 '
_ The AWIPS Header Block window
CCCC: KOAX “loses.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL click the ‘Enter’ button.
817.| Verify the Areal Flood Warning text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Warning statement.
818.| Verify the Areal Flood Warning text contains the The date and time attributes exist. DR #782
current Qate anq time attributes and the correct The header information is correct.
header information.
819.| Verify the Areal Flood Warning text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Warning statement.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
820.| Verify the Areal Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The 2
lines of VTEC code should be in the following format:
10.CAN.KOAX.FA.W.xxxx.YYMMDDTHHmMmZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
/0.CON.KOAX.FA.W xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(UTC).
821.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
822.| Verify the text warning contains a presence of closing | The Areal Flood Warning text contains
$3. a presence of closing $$.
823.| In the text window, replace the ‘**WARNING The Areal Flood Warning is saved.
BASIS*I an.d “!--*thlonal description of the path of | 114 taxt window displays the saved
the flood--I" lines with a word or phrase and the warning
‘T*NAME/INITIALS**!" line with the user’s initials. '
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.
824.| MB1 click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved The Confirm Cancel window closes
changes will be lost. Cancel anyway?". _ o o
The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
825.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
826.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/T010-0005 / 21 Nov. 2008 99

Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.

HARD COPY UNCONTROLLED




Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
827.| MB1 click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button. Select ‘Areal Flood
Statement’ from the dropdown menu below the
‘Other’ radio button. Then MBL click the
‘FOLLOWUP’ dropdown menu.
Verify two lines similar to the following appear:
‘COR.KOAX.FA.W.xxxx(CON)’
‘COR.KOAX.FA.W.xxxx(CAN)’
Reissuing an Areal Flood Warning (NEW)
828.| In the WarnGen GUI, MB1 click on the ‘Other’ radio | ‘Extend/Reissue’ appears in the
button. Select ‘Areal Flood Warning’ from the dropdown menu.
dropdown menu below the ‘Other’ radio button.
829.| From the ‘Extend/Reissue’ dropdown, select the The polygon appears.
‘NEW' product. The polygon is editable.
830.| Modify the polygon, duration and bulletins for the The Areal Flood Warning text appears
warning text product. in a ‘Text Warngen’ window.
Then MBL click the ‘Create Text’ button. An ‘AWIPS Header Block’ window
appears.
831.| In the AWIPS Header Block, verify the following The Areal Flood Warning text remains
, . , . C DR #8368
selections are set: displayed in the text window in edit
TTAAi SAUS43 mode. | DR #870
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
832.| Verify the Areal Flood Warning text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Warning statement.
833.| Verify the Areal Flood Warning text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
834.| Verify the Areal Flood Warning text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Warning statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
835. | Verify the Areal Flood Warning text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
[O.NEW.KOAX.FA.W.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
836.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
837.| Verify the text warning contains a presence of closing | The Areal Flood Warning text contains
$$. a presence of closing $3.
838.| In the text window, replace the ‘"*WARNING The Areal Flood Warning is saved.
BASIS™!"and "I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warmning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
839.| MBI click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. . I .
The warning remains displayed in the
‘Text WarnGen: OMAFLWOAX'
window (not in edit mode).
840.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
841.| Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX
window closes.
842.| MBL1 click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button. Select ‘Areal Flood
Warning’ from the dropdown menu below the ‘Other’
radio button. Then verify three lines similar to the
following appear:
‘COR.KOAX.FAW.xxxx(NEW)
‘NEW.KOAX.FA.W . xxxx’
‘EXT.KOAX.FA.W.XXXX'
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
Cancelling an Areal Flood Warning (CAN)
843.| In the WarnGen GUI, MB1 click the ‘Other’ radio The polygon appears.
button. Select ‘Areal Flood Statement’ from the ; ; -
The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. From by thr()e s)(lq%are vertex points.
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ .
product. The bulletins are grayed out.
844.| MB1 click the ‘Create Text' button. The Areal Flood Statement text
appears in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
845.| In the AWIPS Header Block, verify the following The Areal Flood Statement text DR #868
selections are set: remains displayed in the text window in DR #870
TTAAii; SAUS43 Rt mode-
_ The AWIPS Header Block window
CCCC: KOAX closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
846.| Verify the Areal Flood Statement text contains the The date and time attributes exist. DR #782
current Qate anq time attributes and the correct The header information is correct.
header information.
847.| Verify the Areal Flood Statement text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Statement text.
848.| Verify the Areal Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.CAN.KOAX.FA.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(utC).
849.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
850. | Verify the text warning contains a presence of closing | The Areal Flood Statement text
$3. contains a presence of closing $$.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
851.| In the text window, replace the ‘"*WARNING The Areal Flood Statement is saved.
BASIS*| a}n'd !--*thlonal description of the path of The text window displays the saved
the flood--I" lines with a word or phrase and the warning
‘T*NAME/INITIALS**!" line with the user’s initials. '
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
852.| MBL1 click the ‘Cancel’ button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | tha confirm ghncalflindow closes
changes will be lost. Cancel anyway?". . B o
The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
853.| Ingest the warning text file into the ‘warning’ endpoint | The warningis ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
854.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
855.| MBL click the WarnGen button in the toolbar, select | Verified.
the ‘Other’ radio button.
Select ‘Areal Flood Statement’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL1 click the ‘FOLLOWUP’ dropdown menu
and verify a line similar to the following appears:
‘COR.KOAX.FA.W.xxxx(CAN)’
856.| Close the WarnGen GUI. The WarnGen GUI closes.
Expiring an Areal Flood Warning (EXP)
857.| MBL click on the ‘WarnGen' button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
858.| In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector | pR #g13
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.
An initial warning area hatched box
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
859.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
Track type: One Storm by the radio buttons.
-Edit: Box and Track
860.| MB1 click on ‘Areal Flood Statement’ in the ‘Product | The selection is made as indicated by
type’ section. the radio button. The primary cause
other than rain and CALLS TO
ACTION sections update to display
items applicable for Areal Flood
Warnings.
The storm motion vector is removed
from the main display, leaving only the
hatched polygon.
861.| Select the ‘Duration:’ to 15 min. The duration is set to 15 min. The DR #813
ending time of the warning updates
with the change in duration.
862.| MBL1 click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX but does not cross over the CWA
counties are included in the warning polygon. boundary.
Multiple KOAX counties are included in
the polygon.
Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
863.| In the WarnGen GUI, MBL1 click on the The polygon’s vertices are redrawn on
‘Warned/Hatched Area’ button under the ‘Redraw the vector snapping back to the CWA
Box on Screen from:’ section. border while creating additional
vertices.
Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.
864.| MB1 within the Optional bullets section, select items | The Areal Flood Warning text appears
such that the following Areal Flood Template in a ‘Text Warngen’ window.
Parameters are highlighted: An ‘AWIPS Header Block’ window
primary cause other than rain: appears.
CALLS TO ACTION: Urban flooding...
Then click MB1 on the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail

865.| In the AWIPS Header Block, verify the following The Areal Flood Warning text remains | pR #868
selections are set: displayed in the text window in edit

i mode DR #870
TTAAIi: SAUS43 ' .
CCCC: KOAX Ilr;e; eAsW|PS Header Block window
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLW
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.

866. | In the text window, replace the ‘"*WARNING The Areal Flood Warning is saved.
BASIS™!"and "I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warmning.

‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.

867.| MBI click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. . I .

The warning remains displayed in the
‘Text WarnGen: OMAFLWOAX'
window (not in edit mode).

868.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(lawips/edex/opt/data/shn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

869.| Close the Text Warngen: OMAFLWOAX window. The Text Warngen: OMAFLWOAX

window closes.

870.| MBL click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Select ‘Areal Flood Statement’ from the dropdown can be expired (EXP).
menu below the ‘Other’ radio button.

Then MBL click the ‘FOLLOWUP’ dropdown menu to
verify the created warning is able to expired (EXP).
Verify the line similar to the following appears:
EXP.KOAX.FA.W.xxxx
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
871.| Select the EXP product. The polygon appears.
The polygon is uneditable as indicated
by the square vertex points.
The bulletins are grayed out.
872.| MBI click the ‘Create Text' button. The Areal Flood Warning text appears
in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
873.| In the AWIPS Header Block, verify the following The Areal Flood Statement text
selections are set: remains displayed in the text window in
TTAAii: SAUS43 edit mode. |
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
874.| Verify the Areal Flood Statement text contains the The date and time attributes exist.
current date and time attributes and the correct The header information is correct.
header information.
875.| Verify the Areal Flood Statement text contains the The counties are listed in the Areal
counties encompassed by the polygon. Flood Statement text.
876.| Verify the Areal Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
10.EXP.KOAX.FA.W.xxxx.000000T0000Z-
YYMMDDTHHmMmZ /
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(uTC).
877.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g:, LAT...LON 4471 9981 4488 text product.
9977...).
878.| Verify the location and motion of the weather event The location and motion of the weather
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
879.| Verify the text warning contains a presence of closing | The Areal Flood Statement text
$$. contains a presence of closing $$.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
880.| In the text window, replace the ‘**WARNING The Areal Flood Statement is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
881.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
882.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
883.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
884.| MBL click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button. observing that the expired product
Select ‘Areal Flood Statement’ from the dropdown (EXP) exists in the Update List
menu below the ‘Other’ radio button. dropdown menu.
Verify in the ‘FOLLOWUP’ dropdown menu that an
expired product (EXP) that appears as follows:
‘COR.KOAX.FA.W.xxxX(EXP)’
885.| Close the WarnGen GUI. The WarnGen GUI closes.
Areal Flood Advisory
Issuing an Areal Flood Advisory
886.| MBI click on the ‘WarnGen’ button in the tool bar. The WarnGen application loads.
A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.
887.| In the main pane, click and hold MB1 on the ‘Drag A southwest-northeast oriented vector | pR #g13
me to Storm’ point and drag it to another location appears with the point near the center
(ideally on a feature picked up by the radar). of the line, tick marks, and time values
at the starting point, current/endpoint,
and arrowhead.
An initial warning area hatched box
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
888.| In the ‘WarnGen’ window, select the following: The selections are made as indicated
Track type: One Storm by the radio buttons.
-Edit: Box and Track
889.| MBI click on ‘Other’ in the ‘Product type’ section. The selection is made as indicated by
Select ‘Areal Flood Advisory’ from the dropdown the radio button. The primary cause
menu below the ‘Other’ radio button. other than rain and CALLS TO
ACTION sections update to display
items applicable for Areal Flood
Advisories.
The storm motion vector is removed
from the main display, leaving only the
hatched polygon.
890.| Select the ‘Duration: to 3:00 hours. The duration is set to 3:00 hours. The | pR #813
ending time of the warning updates
with the change in duration.
891.| MBL click and hold on a vertex and dragging it to The hatched area expands within the
another location outside the koax's CWA boundary. | enclosed box up to the CWA boundary
At the same time, ensure that multiple KOAX EUt dges not cross over the CWA
counties are included in the warning polygon. ounaary.
Multiple KOAX counties are included in
the polygon.
Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
892.| In the WarnGen GUI, MB1 click on the The polygon’s vertices are redrawn on
‘Warned/Hatched Area’ button under the ‘Redraw the vector snapping back to the CWA
Box on Screen from:* section. border while creating additional
vertices.
Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.
893.| MB1 within the Optional bullets section, selectitems | The Areal Flood Advisory text appears
such that the following Areal Flood Template in a ‘Text Warngen’ window.
Parameters are highlighted: An ‘AWIPS Header Block’ window
if not generic flood advisory: hydrologic appears.
Hydrologic conditions/causes if applicable:
snow melt
CALLS TO ACTION: Urban flooding
Then click MB1 on the ‘Create Text' button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
894.| In the AWIPS Header Block, verify the following The Areal Flood Advisory text remains | pR #868
selections are set: displayed in the text window in edit
i mode. DR #870
TTAAIi: SAUS43
_ The AWIPS Header Block window
CCCC: KOAX closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
895.| Verify the Areal Flood Advisory text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Advisory statement.
896.| Verify the Areal Flood Advisory text contains the The date and time attributes exist. DR #782
current Qate anq time attributes and the correct Miae header inform BN is correct.
header information.
897.| Verify the Areal Flood Advisory text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Advisory statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
898.| Verify the Areal Flood Advisory text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.NEW.KOAX.FA.Y.0001.YYMMDDTHHmMmMZ-
YYMMDDTHHmmZ/
/00000.0.1C.000000T0000Z.000000TO000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(UTC).
899.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
900. | Verify the text warning contains a presence of closing | The Areal Flood Advisory text contains
$$. a presence of closing $3.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
901.| In the text window, replace the ‘" WARNING The Areal Flood Advisory is saved.
BASIS™!"and “I--*optional description of the path of | The text window displays the saved
the flood--!" lines with a word or phrase and the warning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.

902.| MB1 click the ‘Cancel’ button and MB1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. . . . :

The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(notin edit mode).

903.| Note the VTEC code (the ‘FA.Y.xxxx" portion in
particular). FAY.

904.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

905.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX

window closes.

906.| MBL click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Areal Flood Advisory’ radio button. observing that the ingested warning
Then MBL click the ‘Correct/Reissue’ dropdown can be corrected (COR), extended
menu to verify the created warmning is able to be (EXT) or reissued (NEW).
corrected (COR), extended (EXT) or reissued (NEW).

Verify three lines similar to the following appear:
NEW.KOAX.FA.Y Xxxx
EXT.KOAX.FA.Y .Xxxx
COR.KOAX.FA.Y . xxxx(NEW)

907.| Create another Areal Flood Advisory by repeating The new Areal Flood Advisory displays
steps 869-884, but choosing different options within | in the text window.
the ‘WarnGen: Operational’ window.

908. | Verify the VTEC code in the warning is different from | The VTEC code from the first warning
the first Areal Flood Advisory (e.g., FA.Y.0001 was persisted. The second Areal
becomes FA.Y.0002). Flood Advisory contains updated VTEC

coding.

909.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually

ingested for display in WarnGen. Direct save to

ingest will be implemented in a later TO.)
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
910.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
911.| MBI click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. Select ‘Areal Flood observing that the ingested warning
Advisory' from the dropdown menu below the ‘Other’ | can be corrected (COR), extended
radio button. (EXT) or reissued (NEW).
Then MBL click the ‘Correct/Reissue’ dropdown
menu to verify the created warning is able to be
corrected (COR), extended (EXT) or reissued (NEW).
Verify three lines similar to the following appear:
COR.KOAX.FA.Y xxxx(NEW)
NEW.KOAX.FA.Y .xxxx
EXT.KOAX.FA.Y .xxxx
Correcting an Areal Flood Advisory (COR)
912.| In the WarnGen GUI, from the ‘Correct/Reissue’ The polygon appears.
dropdown, select the ‘COR’ product. The polygon is uneditable as indicated
by the square vertex points.
913.| Change the duration and bulletins to be displayedin | The Areal Flood Advisory text appears
the warning text product. in a ‘Text Warngen’ window.
Then MBL click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
914.| In the AWIPS Header Block, verify the following The Areal Flood Advisory text remains | nn 4868
selections are set: displayed in the text window in edit
TTAAIi: SAUS43 mode. | DR #870
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
915.| Verify the Areal Flood Advisory text contains the The primary cause other than rain and
Areal Flood Template Parameters selected. CALLS TO ACTION exist in the Areal
Flood Advisory statement.
916.| Verify the Areal Flood Advisory text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
917.| Verify the Areal Flood Advisory text contains the The counties are listed in the Areal DR #3869
counties encompassed by the polygon. Flood Advisory statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
918.| Verify the Areal Flood Advisory text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.COR.KOAX.FA.Y xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
919.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
920.| Verify the text warning contains a presence of closing | The Areal Flood Advisory text contains
$$. a presence of closing $3.
921.| In the text window, replace the ‘**WARNING The Areal Flood Advisory is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘T*NAME/INITIALS*!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.
922.| MBL1 click the ‘Cancel button and MB1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
923.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awipsledex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
924.| MBL click the WarnGen button in the toolbar, select | Verified.
the Areal Flood radio button, and verify a line similar
to the following appears:
‘COR.KOAX.FA.Y xxxx(NEW)'
925.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
Continuing an Areal Flood Advisory (CON) by Issuing a Follow-Up for an Areal Flood Advisory (FLS)
926.| In the WarnGen GUI, MB1 click on the ‘Other’ radio | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Areal Flood Statement’ from the menu.
dropdown menu below the ‘Other’ radio button.
927.| MB1 click on the ‘FOLLOWUP’ dropdown menu and | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
928.| MBL click the ‘CON'’ option. The vector and polygon of the original
warning appear on the main pane.
929.| Modify the warning polygon, but do not remove any | The Areal Flood Statement text
counties from the original warning polygon. appears in a ‘Text Warngen’ window.
MBL1 click the ‘Warned/Hatched Area’ button. An ‘AWIPS Header Block’ window
Note: The polygon can only be reduced in size. appears.
Select the following warning bulletins:
e If not generic flood advisory:
e Hydrologic conditions/causes if applicable:
e CALLS TO ACTION: Turn around...dont
drown
Then MBL1 click the ‘Create Text’ button.
930.| In the AWIPS Header Block, verify the following The Areal Flood Statement text DR #868
selections are set: remains displayed in the text window in
o TTAAI: SAUS43 edit mode. DR#870
e CCCC: KOAX The AWIPS Header Block window
closes.
e BBB:NOR
e BBB Version: A (grayed out)
e WSFO ID: OMA
e Product Category: FLS
e  Product Designator: OAX
e Addressee: 000
Then MBL1 click the ‘Enter’ button.
931.| Verify the Areal Flood Statement text contains the The if not generic flood advisory,
Areal Flood Template Parameters selected. Hydrologic conditions/causes if
applicable, and CALLS TO ACTION
exist in the Areal Flood Statement text.
932.| Verify the Areal Flood Statement text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
933. Verify the Areal Flood Statement text contains the The counties are listed in the Areal DR #869
counties encompassed by the polygon. Flood Statement text.
934.| Verify the Areal Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.CON.KOAX.FA.Y xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
935.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
936.| Verify the location and motion of the weather event The location and motion of the weather DR #782
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
937.| Verify the text warning contains a presence of closing | The Areal Flood Statement text
$3. contains a presence of closing $$.
938.| In the text window, replace the ‘**WARNING The Areal Flood Statement is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
939.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
940.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
941.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
942.| MBL click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button,
Select ‘Areal Flood Statement’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL click the ‘FOLLOWUP’ dropdown menu.
Verify a line similar to the following appears:
e ‘COR.KOAX.FA.Y.xxxx(CON)
Extending an Areal Flood Advisory (EXT)
943.| In the WarnGen GUI, MB1 click the ‘Other’ radio The polygon appears.
button. Select ‘Areal Flood Advisory’ from the The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. by the square vertex points.
Then MBL1 click the ‘Correct/Extend /Reissue’
dropdown menu and select the ‘EXT’ product.
944.| Modify the polygon, the duration and bulletins to be The Areal Flood Advisory text appears
displayed in the warning text product. in a ‘Text Warngen’ window.
Then MBL1 click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
945.| In the.AWIPS Header Block, verify the following T.he Areal .FIood Advispry text remains DR #868
selections are set: displayed in the text window in edit
o  TTAAii SAUS43 mode. DR#870
e CCCC: KOAX The AWIPS Header Block window
closes.
e BBB:NOR
e BBB Version: A (grayed out)
e WSFO ID: OMA
e Product Category: FLS
e  Product Designator: OAX
e Addressee: 000
Then MBL1 click the ‘Enter’ button.
946.| Verify the Areal Flood Advisory text contains the The if not generic flood advisory,
Areal Flood Template Parameters selected. Hydrologic conditions/causes if
applicable, and CALLS TO ACTION
exist in the Areal Flood Advisory
statement.
947.| Verify the Areal Flood Advisory text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
948.| Verify the Areal Flood Advisory text contains the The counties are listed in the Areal DR #3869
counties encompassed by the polygon. Flood Advisory statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
949.| Verify the Areal Flood Advisory text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
[10.EXT.KOAX.FA.Y xxxx.YYMMDDTHHmMmZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(uTC).
950.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
951.| Verify the text warning contains a presence of closing | The Areal Flood Advisory text contains
$$. a presence of closing $3.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
952.| In the text window, replace the ‘**WARNING The Areal Flood Advisory is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
953.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway? The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
954.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
955.| MB1 click the WarnGen button in the toolbar, select Verified.
the Areal Flood radio button, MB1 click the
‘Correct/Extend/Reissue’ dropdown menu and verify
a line similar to the following appears:
‘COR.KOAX.FA.Y xxxx(EXT)’
956.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
Continuing/Canceling an Areal Flood Advisory (CON/CAN)
957.| In the WarnGen GUI, MBL1 click on the ‘Other’ radio = | ‘FOLLOWUP’ appears in the dropdown
button. Select ‘Areal Flood Statement’ from the menu.
dropdown menu below the ‘Other’ radio button.
958.| MBL1 click on the ‘FOLLOWUP’ dropdown menuand | The list includes the ‘CON’ and ‘CAN’
verify the ‘CON’ and ‘CAN’ options are available. options.
959.| MBL click the ‘CON’ option. The vector and polygon of the original
warning appear on the main pane.
960.| Modify the warning polygon to remove at least one The Areal Flood Advisory text appears
county from the original warning polygon. in a ‘Text Warngen’ window.
Select the following warning bulletins: An ‘AWIPS Header Block’ window
if not generic flood advisory: appears.
Hydrologic conditions/causes if applicable:
CALLS TO ACTION:
Then MBL1 click the ‘Create Text’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
961.| In the AWIPS Header Block, verify the following The Areal Flood Advisory text remains DR #868
selections are set: displayed in the text window in edit
TTAAi: SAUS43 mode. | DR#870
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
962.| Verify the Areal Flood Advisory text contains the The if not generic flood advisory,
Areal Flood Template Parameters selected. Hydrologic conditions/causes if
applicable, and CALLS TO ACTION
exist in the Areal Flood Advisory
statement.
963.| Verify the Areal Flood Advisory text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
964.| Verify the Areal Flood Advisory text contains the The counties are listed in the Areal DR #3869
counties encompassed by the polygon. Flood Advisory statement.
965.| Verify the Areal Flood Advisory text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The 2
lines of VTEC code should be in the following format:
10.CAN.KOAX.FA.Y.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
/0.CON.KOAX.FA.Y.xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
/00000.0.DM.000000T0000Z.000000T0000Z.
000000T0000Z.00/
Where the date and time attributes in the VTEC code
match the warning'’s start and end dates and times
(uTC).
966.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
967.| Verify the text warning contains a presence of closing | The Areal Flood Advisory text contains
$$. a presence of closing $3.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
968.| In the text window, replace the ‘**WARNING The Areal Flood Advisory is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL1 click the ‘Send’ button.
969.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
970.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
971.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
972.| MBL click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button. Select ‘Areal Flood
Statement’ from the dropdown menu below the
‘Other’ radio button. Then MBL click the
‘FOLLOWUP’ dropdown menu.
Verify two lines similar to the following appear:
e ‘COR.KOAX.FA.Y xxxx(CON)’
o 'COR.KOAX.FA.Y xxxx(CANY
Reissuing an Areal Flood Advisory (NEW)
973.| In the WarnGen GUI, MB1 click on the ‘Other’ radio | ‘Extend/Reissue’ appears in the
button. Select ‘Areal Flood Advisory’ from the dropdown menu.
dropdown menu below the ‘Other’ radio button.
974.| From the ‘Extend/Reissue’ dropdown, select the The polygon appears.
‘NEW' product. The polygon is editable.
975.| Modify the polygon, duration and bulletins for the The Areal Flood Advisory text appears
warning text product. in a ‘Text Warngen’ window.
Then MBI click the ‘Create Text' button. An ‘AWIPS Header Block’ window
appears.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
976.| In the AWIPS Header Block, verify the following The Areal Flood Advisory text remains DR #868
selections are set: displayed in the text window in edit
TTAAi: SAUS43 mode. | DR#870
CCCC: KOAX The AWIPS Header Block window
closes.
BBB: NOR
BBB Version: A (grayed out)
WSFO ID: OMA
Product Category: FLS
Product Designator: OAX
Addressee: 000
Then MBL1 click the ‘Enter’ button.
977.| Verify the Areal Flood Advisory text contains the The if not generic flood advisory,
Areal Flood Template Parameters selected. Hydrologic conditions/causes if
applicable, and CALLS TO ACTION
exist in the Areal Flood Advisory
statement.
978.| Verify the Areal Flood Advisory text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
979.| Verify the Areal Flood Advisory text contains the The counties are listed in the Areal DR #3869
counties encompassed by the polygon. Flood Advisory statement.
Verify cities in the warning polygon are included in The cities in the warning polygon are
the pathcast. included in the warning.
980.| Verify the Areal Flood Advisory text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
IO.NEW.KOAX.FA.Y xxxx.YYMMDDTHHmMmMZ-
YYMMDDTHHmMmZ/
Where the date and time attributes in the VTEC code
match the warning’s start and end dates and times
(UTC).
981.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
982.| Verify the text warning contains a presence of closing | The Areal Flood Advisory text contains
$$. a presence of closing $3.
983.| In the text window, replace the ‘**WARNING The Areal Flood Advisory is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.
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Test C

ase WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
984.| MBL click the ‘Cancel button and MBL1 click the ‘Yes' | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?'. The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).
985.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
986.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
987.| MBL click the WarnGen button in the toolbar and Verified.
select the ‘Other’ radio button. Select ‘Areal Flood
Advisory' from the dropdown menu below the ‘Other’
radio button. Then verify three lines similar to the
following appear:
o ‘COR.KOAX.FA.Y.xxxx(NEW)
o ‘NEW.KOAX.FA.Y xxxx’
o 'EXT.KOAX.FA.Y.Xxxx'
Cancelling an Areal Flood Advisory (CAN)
988.| In the WarnGen GUI, MB1 click the ‘Other’ radio The polygon appears.
button. Select ‘Areal Flood Statement’ from the The polygon is uneditable as indicated
dropdown menu below the ‘Other’ radio button. From | by the square vertex points.
the ‘FOLLOWUP’ dropdown menu, select the ‘CAN’ The bulletins are grayed out.
product.
989.| MBL click the ‘Create Text' button. The Areal Flood Statement text
appears in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
990.| In the AWIPS Header Block, verify the following The Areal Flood Statement text DR #868
selections are set: remains displayed in the text window in
e TTAAIir SAUS43 edit mode. | DR #870
o CCCC: KOAX The AWIPS Header Block window
closes.
e BBB:NOR
e BBB Version: A (grayed out)
e WSFOID: OMA
e Product Category: FLS
e  Product Designator: OAX
e Addressee: 000
Then MBL1 click the ‘Enter’ button.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
991.| Verify the Areal Flood Statement text contains the The date and time attributes exist. DR #782
current date and time attributes and the correct The header information is correct.
header information.
992.| Verify the Areal Flood Statement text contains the The counties are listed in the Areal DR #3869
counties encompassed by the polygon. Flood Statement text.
993.| Verify the Areal Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.CAN.KOAX.FA.Y .xxxx.000000T0000Z-
YYMMDDTHHmMmMZ/
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(UTC).
994.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
995.| Verify the text warning contains a presence of closing | The Areal Flood Statement text
$$. contains a presence of closing $3.
996.| In the text window, replace the ‘**WARNING The Areal Flood Statement is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘**NAME/INITIALS**!" line with the user's initials.
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.
997.| MBL click the ‘Cancel button and MBL1 click the ‘Yes" | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX' window
(not in edit mode).
998.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/fawips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
999.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
1000.| MB1 click the WarnGen button in the toolbar, select Verified.
the ‘Other’ radio button.
Select ‘Areal Flood Statement’ from the dropdown
menu below the ‘Other’ radio button.
Then MBL1 click the ‘FOLLOWUP’ dropdown menu
and verify a line similar to the following appears:
o ‘COR.KOAX.FA.Y xxxx(CANY
1001.| Close the WarnGen GUI. The WarnGen GUI closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result

Pass/Fail

Expiring an Areal Flood Advisory (EXP)

1002.| MBL1 click on the ‘WarnGen’ button in the tool bar.

The WarnGen application loads.

A ‘Drag me to Storm’ labeled point
displays in the center of the CAVE
display. This point is in edit mode.
The WarnGen window appears.

1003.| In the main pane, click and hold MB1 on the ‘Drag
me to Storm’ point and drag it to another location
(ideally on a feature picked up by the radar).

A southwest-northeast oriented vector
appears with the point near the center
of the line, tick marks, and time values
at the starting point, current/endpoint,

and arrowhead.

Aninitial warning area hatched box
appears.

DR #813

1004.| In the ‘WarnGen’ window, select the following:
-Track type: One Storm
-Edit: Box and Track

The selections are made as indicated
by the radio buttons.

1005.| MBL1 click on ‘Areal Flood Statement’ in.the ‘Product
type’ section.

The selection is made as indicated by
the radio button. The if not generic
flood advisory, Hydrologic
conditions/causes if applicable, and
CALLS TO ACTION sections update to
display items applicable for Areal Flood
Advisories.

The storm motion vector is removed
from the main display, leaving only the
hatched polygon.

1006.| Select the ‘Duration:’ to 3:00 hours.

The duration is set to 3:00 hours. The
ending time of the warning updates
with the change in duration.

DR #813

1007.| MB1 click and hold on a vertex and dragging it to
another location outside the koax’s CWA boundary.
At the same time, ensure that multiple KOAX
counties are included in the warning polygon.

The hatched area expands within the
enclosed box up to the CWA boundary
but does not cross over the CWA
boundary.

Multiple KOAX counties are included in
the polygon.

Note: If the polygon encompasses a
portion of a county less than a
specified percentage of the size of a
county, the portion will not be hatched.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action

Result Pass/Fail

1008.| In the WarnGen GUI, MB1 click on the
‘Warned/Hatched Area’ button under the ‘Redraw
Box on Screen from:’ section.

The polygon’s vertices are redrawn on
the vector snapping back to the CWA
border while creating additional
vertices.

Portions of the county not hatched, as
discussed in step 16, are not included
in the updated polygon.

1009.| MB1 within the Optional bullets section, select items
such that the following Areal Flood Template
Parameters are highlighted:

e if not generic flood advisory:
e Hydrologic conditions/causes if applicable:

e CALLSTO ACTION:
Then click MB1 on the ‘Create Text button.

The Areal Flood Advisory text appears
in a ‘Text Warngen’ window.

An ‘AWIPS Header Block’ window
appears.

1010.| In the AWIPS Header Block, verify the following
selections are set:

e TTAAIi: SAUS43

e CCCC: KOAX

e BBB:NOR

e BBB Version: A (grayed out)
e WSFO ID: OMA

e Product Category: FLS

e Product Designator: OAX

e Addressee: 000
Then MB1 click the ‘Enter’ button.

The Areal _FIood Advispry text remains DR #868
displayed in the text window in edit
mode. DR #870
The AWIPS Header Block window
closes.

1011.| In the text window, replace the ‘"*WARNING
BASIS**!" and “I--*optional description of the path of
the flood--!" lines with a word or phrase and the
‘*NAME/INITIALS**!" line with the user’s initials.

MBL click the ‘Save’ button.
Then MB1 click the ‘Send’ button.

The Areal Flood Advisory is saved.

The text window displays the saved
warning.

1012.| MBL1 click the ‘Cancel’ button and MBL1 click the ‘Yes’
button in the message box that states ‘Any unsaved
changes will be lost. Cancel anyway?'.

A Confirm Cancel window opens.
The Confirm Cancel window closes.

The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(not in edit mode).

1013.| Ingest the warning text file into the ‘warning’ endpoint
(/awips/edex/opt/data/sbn/warning).

(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)

The warning is ingested.

1014.| Close the Text Warngen: OMAFLSOAX window.

The Text Warngen: OMAFLSOAX
window closes.
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
1015.| MBL1 click the WarnGen button in the toolbar and The warning is ingested as verified by
select the ‘Other’ radio button. observing that the ingested warning
Select ‘Areal Flood Statement’ from the dropdown can be expired (EXP).
menu below the ‘Other’ radio button.
Then MBL click the ‘FOLLOWUP’ dropdown menu to
verify the created warning is able to expired (EXP).
Verify the line similar to the following appears:
o EXP.KOAX.FA.Y.xxxx
1016.| Select the EXP product. The polygon appears.
The polygon is uneditable as indicated
by the square vertex points.
The bulletins are grayed out.
1017.| MBI click the ‘Create Text' button. The Areal Flood Advisory text appears
in a ‘Text Warngen’ window.
An ‘AWIPS Header Block’ window
appears.
1018.| In the AWIPS Header Block, verify the following The Areal Flood Statement text
selections are set: remains displayed in the text window in
o  TTAAii SAUS43 edit mode. |
e CCCC: KOAX The AWIPS Header Block window
closes.
e BBB:NOR
e BBB Version: A (grayed out)
e WSFO ID: OMA
e Product Category: FLS
e Product Designator: OAX
e Addressee: 000
Then MB1 click the ‘Enter’ button.
1019.| Verify the Areal Flood Statement text contains the The date and time attributes exist.
current date and time attributes and the correct The header information is correct.
header information.
1020.| Verify the Areal Flood Statement text contains the The counties are listed in the Areal
counties encompassed by the polygon. Flood Statement text.
1021.| Verify the Areal Flood Statement text contains the The VTEC code exists and is accurate.
VTEC code above the BULLETIN section. The VTEC
code should be in the following format:
/0.EXP.KOAX.FA.Y .xxxx.000000T0000Z-
YYMMDDTHHmMmZ /
Where the date and time attributes in the VTEC code
match the warning's start and end dates and times
(uTC).
1022.| Verify the Lat/Lon coordinates appear in the text The Lat/Lon information exists in the
warning product (E.g., LAT...LON 4471 9981 4488 text product.
9977...).
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

Step Action Result Pass/Fail
1023.| Verify the location and motion of the weather event The location and motion of the weather
exists below the LAT...LON line in the text warning event exists below the LAT...LON line.
product.
1024.| Verify the text warning contains a presence of closing | The Areal Flood Statement text
$$. contains a presence of closing $$.
1025.| In the text window, replace the **WARNING The Areal Flood Statement is saved.
BASIS**!" and “I--*optional description of the path of | The text window displays the saved
the flood--I" lines with a word or phrase and the warning.
‘T*NAME/INITIALS**!" line with the user’s initials.
MBL1 click the ‘Save’ button.
Then MBL click the ‘Send’ button.
1026.| MBL1 click the ‘Cancel’ button and MBL1 click the ‘Yes’ | A Confirm Cancel window opens.
button in the message box that states ‘Any unsaved | The Confirm Cancel window closes.
changes will be lost. Cancel anyway?" The warning remains displayed in the
‘Text WarnGen: OMAFLSOAX’ window
(notin edit mode).
1027.| Ingest the warning text file into the ‘warning’ endpoint | The warning is ingested.
(/awips/edex/opt/data/sbn/warning).
(Note: The created warning needs to be manually
ingested for display in WarnGen. Direct save to
ingest will be implemented in a later TO.)
1028.| Close the Text Warngen: OMAFLSOAX window. The Text Warngen: OMAFLSOAX
window closes.
1029.| MBL1 click the WarnGen button in the toolbar, select | The warning is ingested as verified by
the ‘Other’ radio button. observing that the expired product
Select ‘Areal Flood Statement’ from the dropdown (EXP) exists in the Update List
menu below the ‘Other’ radio button. dropdown menu.
Verify in the ‘FOLLOWUP’ dropdown menu that an
expired product (EXP) that appears as follows:
o ‘COR.KOAX.FA.Y.xxxx(EXP)
1030.| Close the WarnGen GUI. The WarnGen GUI closes.
End of TO10 Test
Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/T010-0005 / 21 Nov. 2008 125

Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.

HARD COPY UNCONTROLLED




Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

50 TO8 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)

CAVE_TO8 013 CAVE shall contain a WarnGen capability

CAVE TO8 013.1 A 'WarnGen: Operational' GUI shall display when the WarnGen
button is selected from the menu bar

CAVE_TO8 013.3 WarnGen shall allow the user to designate the type of warning

CAVE TO8 013.4 WarnGen shall allow the user to select to warn on a single storm

CAVE_TO8 0135 WarnGen shall allow the user to select to warn on a line of storms

CAVE_TO8 013.5.2 WarnGen shall allow the user to issue a Severe Thunderstorm
Warning for a line of storms

CAVE_TO8 013.5.3 WarnGen shall allow the user to issue a Tornado Warning for a
single storm

CAVE _TO8 013.16 WarnGen shall allow the user to designate the duration of the
warning

CAVE TO8 013.18 WarnGen shall allow the user to establish a storm track

CAVE_TO8 013.19 WarnGen shall allow the user to establish a warning area

CAVE TO8 013.19.1 WarnGen shall allow the user to redraw the warning box in CAVE
using MBL1 in the WarnGen: Operational window

CAVE_TO8 013.20 WarnGen shall allow the user to select optional text bullets to be
included in the warning text

CAVE_TO8_013.22 WarnGen shall allow the user to send the warning information to
the text window

CAVE_TO8 013.28 WarnGen shall allow the user to Create the Text using MB1 on the
‘Create Text' button

CAVE_TO8 013.28.1 WarnGen shall translate the storm path into text describing the
speed and direction of the storm, and the counties and cities
affected by the warning

CAVE _TO8 013.28.2 WarnGen shall generate the warning text that includes any
optional bullets selected

CAVE_TO8 013.28.3 WarnGen text warning shall contain correct header information

CAVE_TO8 013.28.4 WarnGen text warning shall contain proper UGC and VTEC codes

CAVE _TO8 013.28.5 WarnGen text warning shall maintain time and Time Zone
consistency

CAVE_T08_013.28.6 WarnGen text warning shall contain correct product type

CAVE TO8 013.28.8 WarnGen text warning shall contain a presence of closing $$

CAVE_TO8 013.31 CAVE shall have the ability to overlay WarnGen on displayed
weather data

CAVE_TO8 013.32 CAVE shall contain the Warning by Polygon functionality

CAVE_TO8 013.32.1 CAVE shall draw a hatched area encompassed by the drawn
polygon

CAVE TO8 013.32.2 The hatched area shall be described by the LAT...LON
coordinates in the text warning product
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Test Case WarnGen 2.0 (Draft) DCN AWP.TE.SWCTR/T010-0005

Number Description Test Step(s)
CAVE_TO08 013.32.3 WarnGen shall not allow the warned area to cross over CWAs
CAVE TO8 013.32.8 WarnGen shall encode the location and motion of the weather
event below the LAT...LON line in the text warning product
CAVE_TO8 013.33 WarnGen shall be activated by using MB1 on the yellow WarnGen
button on the CAVE menu bar
EDEX_T08 019.16 EDEX shall implement VTEC coding through WarnGen
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Test Case WarnGen 2.0 (Draft)

DCN AWP.TE.SWCTR/T010-0005

6.0 TO9 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)
SYSR2094 The AWIPS system shall implement the Text Product Decoder for
warnings.
The AWIPS System shall create the SVR - Severe Thunderstorm
Warning product as produced by the Public and Fire Weather Services
SYSR3054 WarnGen Application.
The AWIPS System shall create the SVS - Severe Weather Statement
product as produced by the Public and Fire Weather Services WarnGen
SYSR3055 Application.
The AWIPS System shall create the TOR - Tornado Warning product as
produced by the Public and Fire Weather Services WarnGen
SYSR3056 Application.
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Test Case WarnGen 2.0 (Draft) DCN AWP.TE.SWCTR/T010-0005

7.0 TO10 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)
SYSR TBD
SYSR
SYSR
SYSR
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Test Case Hazards Grids (Draft) DCN AWP.TE.SWCTR/T010-0006

1.0 SCOPE
See TO10 Software Test Plan.
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Test Case Hazards Grids (Draft) DCN AWP.TE.SWCTR/T010-0006

20 APPLICABLE DOCUMENTS

2.1 Source Documents
e GHG Monitor

2.2 Reference Documents

e Software Test Plan for the Advanced Weather Interactive Processing System
Project, Contract #DG133W-05-CQ-1067, January 2009.

e The Silver Spring NWS AWIPS 1 test bed application.
e Rational RequisitePro.
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Test Case Hazards Grids (Draft) DCN AWP.TE.SWCTR/T010-0006

3.0 TEST CASE DESCRIPTION

This test case demonstrates the capabilities in GFE that involve creating Hazards grids through
the Make Hazard dialog, separating hazards and merging hazards.

3.1  Assumptions, Constraints, and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX, and pgAdmin Il are running.
e Data has been ingested.

e Actions, Results, and Requirements highlighted in yellow indicate requirements
and/or capabilities to be included in the scope of future task orders. They are included
here for purposes of continuity and traceability with the original AWIPS | test case
documents.

3.2 Recommended Hardware
See TO10 Software Test Plan.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs
The results outlined in section 4.0 are met.
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Test Case Hazards Grids (Draft)

DCN AWP.TE.SWCTR/T010-0006

4.0 TEST SCENARIO
Step # Action Result Pass/Fail

1. In CAVE, Mouse Button (MB) 1 click on the | The Open Perspective dialog appears.
Perspectives icon = and select ‘Other’.

2. MBL1 click ‘GFE’. Then MBL1 click ‘OK’. The Open Perspective dialog closes.

The GFE Perspective loads in CAVE.

3. From the Main Menu, select ‘Hazards’ -> The MakeHazard dialog box appears.
‘MakeHazard'.

4, From the MakeHazard dialog box, select The selections are' made and saved. The
an available hazard from the hazard list. MakeHazard dialog remains open.

Then MBL click and drag over the adjacent
forecast zone map to select a forecast
zone(s) for the hazard. Adjust the forecast
start and end times (automatically set an
hour apart) for the hazard at the column to
the right. MB1 click ‘Run’ to save the
selections.

5. Repeat step 4 to create a second hazard. | The selections are made and saved. The
MBL1 click ‘Run/Dismiss’ to save the MakeHazard dialog closes.
selections.

6. From the Main Menu, MB1 click ‘Hazards' - | The Hazards merge.
> ‘MergeHazards’ to merge the Hazards on
the main display.

7. From the Main Menu, MB1 click the ‘Save | The changes are saved.

Forecast’ icon H . The Save Forecast
dialog box appears. MBL1 click ‘Save
Forecast' to save changes made to the
main display.

8. From the Main Menu, select ‘Products’ -> | The Formatter Launcher dialog box appears.
‘Formatter Launcher'.

9. From the Formatter Launcher dialog box, | A message displays in the text area.
select ‘Products’ -> ‘Hazard’ -> <the The VTEC code is present.

Hazard created above>. Then MB1 click
the ‘Run Formatter'icon é«“’l} to run the
Formatter Launcher. Verify that there is a
message and that the VTEC code displays.

10. Close the Formatter Launcher dialog. The Formatter Launcher dialog closes.

11. In the Grid Manager, MB3 click and hold The blank grid in the Grid Manager fills in with
on a blank grid in the Hazards parm at a a gray grid (highlighted yellow since it is the
time in the future. selected grid). The grid is locked by the user
Then select ‘Create From Scratch’ from the | as indicated by the green highlight.
popup menu.
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Test Case Hazards Grids (Draft) DCN AWP.TE.SWCTR/T010-0006

Step # Action Result Pass/Fail
12. MBL1 click the Edit Areas tool on the tool The Edit Areas tool is activated.
bar. An edit area is drawn in the Spatial Editor.

Then draw a shape on the grid in the
Spatial Editor.

13. MB3 click and hold on the colorbar. Inthe | The Define Discrete dialog appears.
popup menu, select ‘Set Pickup Value...".

14. Select a hazard from the dropdown menu. | The edit area is assigned the selected
Then MBL click the ‘Assign Value’ button. | hazard.

15. Draw a second edit area in the Spatial An edit area is drawn in the Spatial Editor.
Editor.

16. In the Define Discrete dialog, select a The edit area is assigned the selected
different hazard. Then MBL1 click the hazard.

‘Assign Value’ button.

17. Draw a third edit area in the Spatial Editor. | An edit area is drawn in the Spatial Editor.

18. In the Define Discrete dialog, select a The edit area is assigned the selected
different hazard. Then MBL1 click the hazard.
‘Assign Value’ button.

19. Close the Define Discrete dialog. The Define Discrete dialog closes.

20. Remove the edit area from the Spatial The edit area is removed from the display.
Editor by MBL1 clicking the ‘Clear Edit Area’
button.

21. From the menu bar, MB1 click ‘Hazards' -> | The Hazards separate into individual parms,

‘SeparateHazards’ to separate the Hazards | one for each hazard.
on the main display.

22. MBL1 click on the Pencil Tool on the The Pencil Tool is activated.
toolbar.

23. Modify the hazards by MB1 dragging the The hazards are modified.
cursor from inside the hazard area
elsewhere, and releasing MB1 after
returning to the hazard area.

24, From the menu bar, MBL1 click ‘Hazards' -> | The Hazards merge.
‘MergeHazards’ to merge the Hazards on
the main display.

25. Verify all hazards merged successfully. Verified.
End of Test
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50 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)

SYSR TBD

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR
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1.0 SCOPE
See TO10 Software Test Plan.
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20 APPLICABLE DOCUMENTS

2.1 Source Documents
e TO8 Text Display Edit 1.0

2.2 Reference Documents

e TO10 Software Test Plan for the Advanced Weather Interactive Processing
System Project, Contract #DG133W-05-CQ-1067, January 2009.
e Section 4 of the AWIPS D-2D User’s Manual Build 8.1
e Existing AWIPS 1 test procedures:
— Baseline_TextDB_OBS8.1
— Checkout_4.3.9 TextWorkstation_OB8.1
— Checkout_Text_Message_OB8.1
— Checkout_TextWorkstation_OB8.1
— Baseline_ TextWKS 1.3.12.1 V1-E
— TextWks 1.3.12.1
e The Silver Spring NWS AWIPS | test bed application.
e Release OB8.2 of the Weather Event Simulator (WES).
e Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

This test case, a replication of the TO8 test case of the same name, demonstrates the capability of
CAVE to receive, recall, and display text products received via a live data feed (TO8 used
“canned data”). This test case also demonstrates the capability to edit text products.

3.1  Assumptions, Constraints, and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX, and pgAdmin 111 are running.
e Data has been ingested.
e The Text Workstation has been started.
e The workstation is attached to a working printer.

e TOI10 testing repeats steps 1-47 with a live data feed. This test procedure was
modified to remove the steps to create a text product required for prior tests.
With a live data feed, these steps are not necessary.

e Actions, Results, and Requirements highlighted in yellow indicate
requirements and/or capabilities to be included in the scope of future task
orders. They are included here for purposes of continuity and traceability with
the original AWIPS 1 test case documents.

e Text Generalization Pattern is deferred to a future TO, pending guidance from
NWS (GSD).

3.2 Recommended Hardware
See Software Test Plan, Section 2.2.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs
e The text data will be displayed in the Text Window within CAVE.
e Data will be printed from an attached printer.
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4.0 TEST SCENARIO
Step Action Result Pass/Fail
Begin TO10 Test
1. Under the CAVE menu, click on ‘New' and The Text Workstation control window and Text
select ‘Text Workstation'. 1 window open.
2. Select the ‘AFOS Browser’ button in the ‘Text | The Text 1 Browser window opens.
1" window.
3. In the Text 1 Browser window, select: The selections in the Node section change
Origin: Central accordingly.
Class: Public
4, In the Text 1 AFOS Browser window, selecta | The Node and Ctgry become highlighted.
combination of available Nodes and Ctgry that | Selections appear in the Designator and
return items in the Designator column. Display sections. The Node-Ctgry combination
appears in the AFOS Cmd: command line in
the Text 1 window and ‘ALL:" appears in the
DISPLAY section.
5. Select an available item (one with a time and | The item and its associated time become DR #797
date or labeled as LATEST) in the Designator | highlighted. The Designator item is also added
section. in the AFOS Cmd: command line in the Text 1
window.
6. Select ‘ALL:" in the display section. Then The selected product is displayed in the Text 1
select Load and Continue. window. The product name appears in the
Text 1 window title. The AFOS Browser
remains open.
7. Repeat steps 5-7 for another product. The selected product displays in the text
Then click the ‘Load and Continue’ button. window. The previously displayed text product
was removed from the text display.
8. Click on *‘Accum’. The ‘Accum’ box becomes selected.
9. Repeat steps 5 and 6 for another product. The selected product is added (Accum.) to the
Then click the ‘Load and Close’ button. text product displayed in the Text 1 window.
The product name appears in the Text 1
window title. The AFOS Browser closes.
10. Unselect the *Accum’ option. The text window clears the text product.
Then click the ‘Clear’ button.
11. In the AFOS Cmd: line, enter OMAMTROMA'. | The product is returned in the text window.
Then press the ‘Enter’ key.
12. Click the ‘Clear’ button. The text window clears the text product.
13. Enter only a portion of a valid TTAAii CCCC An error message is returned stating no
(e.g., SAUS43) and press the ‘Enter’ key. product in the database matches the request.
14, Click the ‘OK’ button. The message closes.
15, Click the ‘WMO Search’ button. A ‘Warning’ box appears asking the user to fill
in the TTAAIl and CCCC and press ENTER.
16. Click the ‘OK’ button. The ‘Warning’ window closes.
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Step Action Result Pass/Fail

17. Enter a valid TTAAIi CCCC (e.g., SAUS43 The text product displays in the text window.
KOAX) and press the ‘Enter’ key.

18. Click the ‘Clear’ button. The text window clears the text product.

19. Enter a valid AWIPS ID (e.g., TOROMA) into | The text product displays in the text window.
the ‘AWIPS ID’ text box. Then press the
‘Enter’ key.

20. Click the ‘Clear’ button. The text window clears the text product.

21. In the Text 1 window, select the Enter Editor | The Text 1 window becomes divided into a
button. header section and a text section. A Header

Block window also opens.

22. Enter ‘TST for the WSFO ID, Product A warning message appears that the ‘Product
Category and Product Designator in the Designator TSTTSTTST is not in the list of
‘Header Block’ window. Then click the ‘Enter’ | valid products. Use it anyway?’
button.

23. Click the ‘Yes’ button. The ‘Header Block’ window closes. TSTTST
appears in the header section. The user is in
edit mode.

24, Create a message of 3 sentences in the text | The text is entered into the text window. The

window. Ensure return was used after each text wraps within the window.
sentence and at least one line is greater than

85 characters where the line wraps

automatically.

25. Click and drag the mouse over a section of The highlighted section is removed from the
the text. Then click the ‘Cut’ button. text product.

26. In a different area of the text product, click the | The cut portion of the text is pasted into the
‘Paste’ button. text product.

27. Click and drag the mouse over the entire text | The space within the text created by the
message. Enter/Return button is filled in.

Then click the ‘Fill" button.

28. Click and drag the mouse over a section of The highlighted section is copied.
the text. Then click the ‘Copy’ button.

29. In a different area of the text product, click the | The copied portion of the text is pasted into
‘Paste’ button. the text product.

30. Click ‘Options’ in the menu bar, select ‘Font The font size increases in size.

Size', and select ‘Large’.

31 Click ‘INS’ from the edit menu bar. Choose ‘INS’ changes to ‘OVR'.
‘Overstrike Mode’.

32. Place the cursor within the text and type a The text entered over the existing text.
word.

33. Click the ‘Save’ button. The message is saved as the AFOS Cmd:

TSTTSTTST.

34, Click the ‘Cancel’ button. A ‘Confirm Cancel’ window appears stating
‘Any unsaved changes will be lost. Cancel
anyway?'.
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Step Action Result Pass/Fail
35. Click the ‘Yes’ button. The ‘Confirm Cancel’ window closes. The text
window exits from edit mode.
36. Click the ‘Clear’ button. The text window clears the text product.
37. In the AFOS Cmd: line, enter TSTTSTTST'. The saved message is returned in the text
Then press the ‘Enter’ key. window.
38. Click the ‘Clear’ button. The text window clears the text product.
39. Open the ‘Text 2’ window. A second text window opens.
40, From the ‘Text Workstation’ window, click on The ‘Text 1" and ‘Text 2’ windows become
‘Windows'. hidden.
Then click on ‘Hide All'.
41. From the ‘Text Workstation’ window, click on | All text windows become visible.
‘Windows'.
Then click on ‘Show All'.
42, In one of the text windows, click ‘File’ and The text window closes.
select ‘Close’.
43. In another text window, display an available The text product displays in the text window.
text product.
44, Print the text product by clicking on ‘File"and | The text product prints from an attached
selecting ‘Print All" printer.
45, Clear the text window. The text product displays.
Then request an available text product via
AFOS Browser.
46. Edit the text product. Then save the edits. The text product is modified and saved.
47. Clear the text window. The text window clears.
Then request the edited product to verify the | The text product displays the modifications.
edits were saved.
48, From the ‘Text Workstation’ window, select All opened text windows and the ‘Text
File'. Workstation’ window close.
Then select ‘Exit'.
End of TO10 Test
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50 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)

CAVE_TO8 004 CAVE shall contain a Text Editor with the look and feel, and ALL
functionality of the current AWIPS 1 text editor

CAVE_TO8_004.1 The Text Editor shall contain an AFOS Browser

CAVE_TO8_004.1.1 The AFOS Browser shall allow the user to display text products in the
text window by selecting the Node, Category and Designator.

CAVE_TO8 004.1.5 The AFOS Browser shall allow the user to Load the selected text
product while keeping the AFOS Browser open for further use.

CAVE_TO8_004.1.6 The AFOS Browser shall allow the user to display the selected text
product and close the AFOS Browser.

CAVE_TO8 004.2 The Text Editor shall provide a print capability.

CAVE_TO8_004.2.1 The print capability shall allow the user to create a hard copy of all
text in the Text Window (Print All) using the menu bar.

CAVE_TO8_004.4 The Text Editor shall provide a text/bulletin editing capability.

CAVE_TO8 _004.9 The user shall be able to close out the Text Editor Window.

CAVE_TO8 004.11 The Text Editor shall provide the capability to Autowrap.

CAVE_TO8 _004.12 The Text Editor shall provide the capability to change font size.

CAVE_TO8 004.13 The Text Editor shall provide the capability to overstrike using the
menu bar.

CAVE_TO8_004.24 The Text Editor shall contain WMO Search Dialog Box that indicates
to the user to fill in the TTAAIi and/or CCCC and press ENTER.

CAVE_TO8_004.25 The Text Editor shall allow the user to open the Text Editor function.

CAVE_TO8_004.26 The Text Editor shall allow the user to opt to accumulate text by
appending subsequent text product retrievals to the display window.

CAVE_TO8_004.28 The Text Editor shall allow the user to clear the Text Display window.

CAVE_TO8_004.29 The Text Editor shall retrieve/display the AFOS product in the Text
Display Window via the AFOS Cmd text window.

CAVE_TO8_004.30 The Text Editor shall retrieve/display the AFOS product in the Text
Display Window via the WMO TTAAIii CCCC text window.

CAVE_TO8 004.31 The Text Editor shall retrieve/display the AFOS product in the Text
Display Window via the AWIPS ID text window.

CAVE_TO8_004.32 The Text Editor shall launch the AWIPS Header Block GUI when the
user enters the edit mode.

CAVE_T08_004.33 The text editor function shall display edit functions in a menu bar
fashion.

CAVE_T08 004.33.1 The menu bar in the edit window shall provide the capability to save
text.

CAVE_T08_004.33.2 The menu bar in the edit window shall provide the capability to cut
out text.

CAVE_T08 004.33.3 The menu bar in the edit window shall provide the capability to copy
text.
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Number Description Test Step(s)
CAVE_T08 004.33.4 The menu bar in the edit window shall provide the capability to paste
text.
CAVE_T08_004.33.5 The menu bar in the edit window shall provide the capability to
remove hard returns from selected text (Fill).
CAVE_T08 004.33.6 The menu bar in the edit window shall provide the capability to edit a
bulletin header.
CAVE_T08_004.33.8 The menu bar in the edit window shall provide the capability to cancel
out of the editor function (cancel).
CAVE_T08_004.33.10 The menu bar in the edit window shall provide the capability to
overstrike text.
CAVE_TO8_004.36 The Text Workstation shall allow the user to exit a Text Workstation.
CAVE_TO8_004.37 The Text Workstation shall allow the user to open a Text Workstation.
CAVE_TO8_004.38 The Text Workstation shall allow the user to "Hide All" workstation
screens.
CAVE_TO8_004.39 The Text Workstation shall allow the user to "Show All" workstation
screens.
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1.0 SCOPE
See TO10 Software Test Plan.
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20 APPLICABLE DOCUMENTS

2.1 Source Documents
e None

2.2 Reference Documents

e Legacy NWS Test Cases: Baseline. HYDRO_WHFS_Hydroview (OB8.3);
Baseline. HYDRO_WHFS_Hydroview _0OB8.1,
Baseline_ HYDRO_PointData.Control; Checkout_4.4.2_Hydroview_OB8.1.

e Software Test Plan for the Advanced Weather Interactive Processing System
Project, Contract #DG133W-05-CQ-1067, January 2009.

e The Silver Spring NWS AWIPS 1 test bed application.
e Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

The purpose of this Test Procedure is to test and verify the functionality found within the current
version of the WHFS Hydrologic Data Viewer application known as Hydroview. Also
demonstrated in this test case is the Point Data Control functionality. As new functionality is
added to this application, these test procedures will be updated to contain the steps required to
test this new functionality.

3.1  Assumptions, Constraints, and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX, and pgAdmin 111 are running.
e Data has been ingested.

e Actions, Results, and Requirements highlighted in yellow indicate
requirements and/or capabilities to be included in the scope of future task
orders. They are included here for purposes of continuity and traceability with
the original AWIPS 1 test case documents. Note that Pan and Zoom
capabilities highlighted in yellow will be demonstrated following an approach
consistent with current CAVE capabilities. Differences in approach from
AWIPS | Hydroview may result in a variance or later revision.

3.2 Recommended Hardware
See TO10 Software Test Plan.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs
The results outlined in section 4.0 are met.
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4.0 TEST SCENARIO
Step # Action Result Pass/Fail
1. In CAVE, Mouse Button (MB) 1 click on the | The Hydro Perspective displays in CAVE.
Perspectives icon and select ‘Hydro’ from
the dropdown menu if available. If not
available, select ‘Other...". Then select
‘Hydro’ from the Open Perspective dialog.
2. From the ‘MapData’ pull-down menu, select | The Point Data Control window opens and
‘Point Data Control...". the stations display in the Hydroview main
window.
3. MB1 click the ‘Close’ button. The Point Data Control window closes.
4. From the ‘Help’ pull-down menu, select An About window displaying the
‘About’. application’s name, version number and
date is shown.
5. On the About window, MB1 click the ‘OK’ The About window closes.
button.
6. From the ‘Help’ pull-down menu, select This window displays a legend for Station
‘Map Legend'. icons and colors. These are the station
icons and colors used by the Point Data
Control option. Note: To make sure some
stations exist in the Hydroview main
window.
7. MB1 click the ‘Close’ button from the The Station Legend window closes.
Station Legend window.
8. From the File pull-down menu, select ‘Save | The Save as GIF window launches.
as Gif'.
9. In the Save as GIF window, use the Filter The Save as GIF window closes.
and Directories selection boxes to choose a
directory to save a GIF screen capture. In
the Selection box, enter the name of the file
to save the screen capture to (including the
directory) followed by the *.gif' file
extension. For best results move the Save
as GIF window off of the Hydroview display.
MBL1 click the ‘OK’ button.
10. In a terminal, go to the directory where the | The Hydroview screen capture displays.
screen capture was saved. Use the
“display” command to display the GIF file.
11. From the ‘File’ pull-down menu, select ‘Print | The Hydroview image is sent to the printer
Image’. specified by the whfs_printcommand_LX
token.
12. From the ‘File’ pull-down menu, select ‘Print | The Hydroview image is sent to the printer

Reverse Image'.

specified by the whfs_printcommand_LX
token. The image will be displayed in
reverse video (i.e., black as white and white
as black).
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Step # Action Result Pass/Fail
13. From the ‘Tools’ pull-down menu, select The center of the geographic display is
‘Point Zoom’ -> ‘Out’. zoomed out.
14, From the ‘Tools’ pull-down menu, select The center of the geographic display is
‘Point Zoom’ -> ‘I’ zoomed in.
15. Draw a rectangle on the geographic display | The geographic display zooms in on the
by holding down the MB1. Then from the rectangular area drawn.
‘Tools’ pull-down menu, select ‘Areal
Zoom'.
16. From the ‘Tools’ pull-down menu, select The display returns to its previous zoom
‘Areal Zoom’ again. level.
17. From the ‘Tools’ pull-down menu, select The geographic display moves North.
‘Pan’ ->‘Up'.
18. From the ‘Tools’ pull-down menu, select The geographic display moves South.
‘Pan’ -> ‘Down’.
19. From the ‘Tools’ pull-down menu, select The geographic display moves East.
‘Pan’ -> ‘Right.
20. From the Tools pull-down menu, select The geographic display moves West.
‘Pan’ -> ‘Left'.
21. From the ‘Tools’ pull-down menu, select The cursor changes from an arrow into a
‘Recenter'. leftward pointing hand that indicates that
recenter functionality is active.
22. MBL1 click on an area that is not in the The display is recentered on the selected
center of the display. area.
23. From the ‘Tools’ pull-down menu, select The geographic display returned to its
‘Recenter’ again. Then MB1 click on the previous viewing state and center.
area that was originally at the center of the
display.
24, From the ‘Tools’ pull-down menu, select A tool bar appears just below the row of pull-
‘Tool Bar'. down menus. The icons shown perform the
same functions as the Zoom and Pan
options found in the Tools pull-down menu.
25. From the ‘Tools’ pull-down menu, select The tool bar disappears.
‘Tool Bar’ again.
26. From the ‘Tools’ pull-down menu, select Alphanumeric text annotations on the
‘Set Font' -> ‘Small’. Hydroview GUI display in their default,
startup size.
27. From the ‘Tools’ pull-down menu, select Alphanumeric text annotations on the
‘Set Font' -> ‘Very Small’. Hydroview display become smaller when
compared to previous size.
28. From the ‘Tools’ pull-down menu, select Alphanumeric text annotations on the

‘Set Font' -> ‘Miniscule’,

Hydroview display become smaller when
compared to previous size. This is the
smallest font size.
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Step # Action Result Pass/Fail
29. From the ‘Tools’ pull-down menu, select Alphanumeric text annotations on the
‘Set Font' -> ‘Normal'. Hydroview display become normal in font
size.
30. From the ‘Tools’ pull-down menu, select Alphanumeric text annotations on the
‘Set Font' -> ‘Large’. Hydroview display become larger.
3L From the ‘Tools’ pull-down menu, select Alphanumeric text annotations on the
‘Set Font' -> ‘Very Large'. Hydroview display become larger than
previous size. This is the largest font size.
32. From the ‘Projections’ pull-down menu, The geographic map displays a Polar
select ‘Polar Stereographic'. Stereographic projection.
33. From the ‘Projections’ pull-down menu, The geographic map displays a HRAP
select ‘HRAP'. projection.
34. From the ‘Projections’ pull-down menu, The geographic map displays a Flat Latitude
select ‘Flat Lat/Lon’. / Longitude projection.
35. From the ‘Overlays’ pull-down menu, select | No streams or lakes are shown on the
‘Streams/Lakes’ -> ‘No Streams/Lakes'. geographic display.
36. From the ‘Overlays’ pull-down menu, select | All major streams and lakes are shown on
‘Streams/Lakes’ -> ‘Major Streams/Lakes’. | the geographic display if defined in the
Overlay Configuration file.
37. From the ‘Overlays’ pull-down menu, select | All streams and lakes are shown on the
‘Streams/Lakes’ -> ‘All Streams/Lakes'. geographic display if defined in the Overlay
Configuration file.
38. From the ‘Overlays’ pull-down menu, select | This toggles the displaying of Basin
‘Basin Boundaries'. Boundary outlines on the geographic display
if defined in the Overlay Configuration file.
39. From the ‘Overlays’ pull-down menu, select | This toggles the displaying of County
‘Counties’. outlines on the geographic display if defined
in the Overlay Configuration file.
40. From the ‘Overlays’ pull-down menu, select | This toggles the displaying of CWA outlines
‘County Warning Areas’. on the geographic display if defined in the
Overlay Configuration file.
41. From the ‘Overlays’ pull-down menu, select | This toggles the displaying of RFC
‘RFC Boundaries'. Boundary outlines on the geographic display
if defined in the Overlay Configuration file.
42. From the ‘Overlays’ pull-down menu, select | This toggles the displaying of State Borders
‘States’. on the geographic display if defined in the
Overlay Configuration file.
43. From the ‘Overlays’ pull-down menu, select | This toggles the displaying of Zones on the
‘Zones'. geographic display if defined in the Overlay
Configuration file.
44, From the ‘Overlays’ pull-down menu, select | This toggles the displaying of City locations

‘Cities/Towns'.

on the geographic display if defined in the
Overlay Configuration file.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
45, From the ‘Overlays’ pull-down menu, select | All Highways will be shown on the
‘Highways/Roads’ -> ‘Highways'. geographic display if defined in the Overlay
Configuration file.
46. From the ‘Overlays’ pull-down menu, select | No Highways or Roads are shown on the
‘Highways/Roads’ -> 'None'. geographic display.
47. From the ‘Overlays’ pull-down menu, select | This toggles the display of the HRAP grid on
‘HRAP'. the geographic display if defined in the
Overlay Configuration file.
48. From the ‘Overlays’ pull-down menu, select | This toggles the display of Latitude and
‘Lat/Lon Lines'. Longitude lines on the geographic display if
defined in the Overlay Configuration file.
49, From the ‘Overlays’ pull-down menu, select | This toggles the display of Time Zone
‘Time Zones'. boundaries on the geographic display if
defined in the Overlay Configuration file.
50. From the ‘Overlays’ pull-down menu, select | This toggles the display of Radar locations
‘Radar Locations'. on the geographic display if defined in the
Overlay Configuration file.
51. From the ‘Overlays’ pull-down menu, select | This toggles the display of the outline of a
‘Radar Rings'. Radar’s coverage area on the geographic
display if defined in the Overlay
Configuration file.
52. On the ‘Overlays’ menu, the grayed out No Action.
Basin Names listed below will be
implemented in a future build:
‘Hydro Service Areas’
‘Topography’
‘Maps Foreground’
53. Double MBL1 click on a station icon on the The selected station is enclosed in a red
geographic display. square.
54, From the ‘MapData’ pull-down menu, select | The Station List window appears. The entry
‘Station Selection’. for the station enclosed in the red square on
the Hydroview display is highlighted in the
Station Selection list.
55. From the ‘Station List’, select another The station entry in the Station List becomes
station. highlighted. A red rectangle is drawn around
the station’s location on the Hydroview
display.
56. In the ‘Station List’ window, double MB1 The time series control window is shown.
click on a station.
57. On the ‘Hydroview' display, double MB1 A red rectangle is drawn around that station
click on another station. on the Hydroview display.
58. From the ‘Station List’ window, scroll down | The search feature will find the station in the

the station list, select another station and
then use the ‘Search’ text box to find the
station selected in step 59.

list, highlight its entry in the station list and
draw a red rectangle around its location on
the Hydroview display.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

59. From the ‘Station List’ window, MB1 click The Station List window closes.
the ‘Cancel’ button.

60. From the ‘MapData’ pull-down menu, select | This queries the IHFS database and
‘Refresh Data’. updates the station data shown on the

Hydroview display.

61. From the ‘MapData’ pull-down menu, select | The Dam Display Control window opens.
‘Dam Locations’.

62. Select the ‘Map Data’ push-button on the Dam icons along with their names display
Dam Display Control window. on the geographic window.

63. The Dam Display Control window provides | The Dam icons are selectively displayed
the option to filter the displayed Dams by based on their volume, the dam volume
volume. Enter a value in the threshold threshold value and filter option chosen.
volume text box (e.g. 100000) and then try
each of the filters by options: greater than,
equal to, less than, and All.

Each time a filter option is changed, MB1
click the ‘Map Data’ button.

64. The Dam Display Control window allows The displayed dams are limited to the
the displayed dams to be limited within a defined latitude/longitude box.
specific area on the Hydroview display.

This is controlled by a user-selectable
center point and a latitude/longitude box
centered on this point. Try modifying the
‘lat/lon center point’ value and the ‘lat/long
offsets’. Toggle the ‘enable’ button and
select ‘Map Data'.

65. Select different combinations of the filters The Data is selectively displayed based on
(Id, Name and Icon) in the Dam Display the filter chosen for 1d, Name and Icon
Control window. This allows the display to | filters.
show or hide the Id, Name, and Icon.

66. Place the mouse pointer over a dam The DamCrest application is launched for
location, click and hold MB3 and select the selected dam.

‘DamCrest’ from the popup menu. Output Manager window opens.

67. On the Dam Crest application window, MB1 | The Dam Crest application is closed.
click ‘Close’ from the File pull-down menu.

68. Select the ‘Clear Data’ push-button on the | The Dams will be cleared from the
Dam Display Control window. geographic display.

69. From the Dam Display Control window, The Dam Display Control window closes.
MBL1 click the ‘Close’ button.

70. From the ‘MapData’ pull-down menu, select | The Display Best Estimate QPE window
‘Best Estimate QPE'. opens.

71. From the Display Best Estimate QPE A MPE generated 1 hour Best Estimate

window, MB1 click the ‘Show Data’ button.

QPE field displays in the Hydroview GUI.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

72. From the Display Best Estimate QPE A time lapse of 6 hours worth of MPE Best
window, MBL1 click the ‘Time Lapse’ button | Estimate QPE fields displays in the
and use the duration slider bar to set the Hydroview GUI.
duration to 6 hours. MB1 click the ‘Show
Data’ button.

73. From the Display Best Estimate QPE The time lapse stops and enters manual
window, MBL1 click the ‘|<<’ button adjacent | time lapse mode. The oldest QPE field in
to the time lapse toggle button. the time lapse is shown in the Hydroview

display (the time of the product is shown in
the lower left corner of the display).

74. From the Display Best Estimate QPE Each time the ‘<’ button is clicked, the
window, MBL1 click the ‘<’ button to previous QPE frame in the time lapse is
manually step backwards through each displayed.
frame of the time lapse.

75. From the Display Best Estimate QPE Each time the > button is clicked, the next
window, MBL1 click the > to manually step | QPE frame in the time lapse is displayed.
forward through each frame of the time
lapse.

76. From the Display Best Estimate QPE The automatic time lapse resumes.
window, MBL1 click the restart timelapse
button to restart the automatic time
lapse.

77. From the Display Best Estimate QPE The time lapse stops. The Hydroview
window, MB1 click the ‘End Lapse’ button. | display shows the Best Estimate QPE field

which was displayed before the time lapse
was started.

78. From the Display Best Estimate QPE An accumulation of 24 1-hour Best Estimate
window, MBL1 click the ‘Accumulate’ toggle | QPE fields displays in the Hydroview GUI.
button. Set the duration slider bar to ‘24'.

MBL click the ‘Show Data’ button.

79. From the Display Best Estimate QPE The 24 hour accumulation is displayed as
window, select ‘Basin’ from the ‘Display As’ | basin averaged precipitation amounts.
combo box. MB1 click the ‘Show Data’
button. Use the grid, zone and county
filters.

80. From the Display Best Estimate QPE The displayed data should have changed
window, select ‘day adjust’ and ‘hour adjust’ | according to the data and time selected.
arrow buttons to increment / decrement the
date and time. MB1 click ‘Show Data’.

81 From the Display Best Estimate QPE The QPE data are cleared from the MPE
window, MBL1 click the ‘Clear Data’ button. | display.

82. From the Display Best Estimate QPE The Display Best Estimate QPE window
window, MBL click the ‘Close’ button. closes.

83. From the ‘MapData’ pull-down menu, select | The Flash Flood Guidance window opens.

‘Flash Flood Guidance'.
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Step # Action Result Pass/Fail

84. Select a product from the top or near the A color map of zones displays, showing the
top of the list, and MB1 click ‘Select’. current Flash Flood threat across the area.

Warm colors are threats; cool colors are not
threats. If the RFC for the WFO does not
produce FFG data, the color for missing
displays.

85. Select the ‘FFG Mode Gridded' toggle A color map displays showing the Flash
button and select ‘WFQ’ in the ‘FFG area’ Flood threat across the area for the WFO.
filter. Select a product from the scroll list
and MB1 click ‘Select'.

86. With the ‘FFG Mode Gridded’ toggle button | A color map displays showing the Flash
set, change the ‘FFG area’ to ‘RFC’. Select | Flood threat across the area for the RFC.

a product from the list.

87. With the ‘FFG Mode Gridded’ toggle button | The color map shows the Flash Flood threat
set, choose different durations from the for the selected duration.
‘Dur’ filter. Select products from the list.

88. With the ‘FFG Mode Gridded’ option set, The color map shows the flash flood threat
select a product from the list. Test by displayed on an HRAP grid when the
choosing ‘Basin’ once and ‘Grid’ next time | Display As filter is ‘Grid’. The color map
in the ‘Display As' filter option. shows the flash flood threat displayed as

averaged basin values when the Display As
filter is ‘Basin’.

89. Set the ‘FFG Mode’ to ‘Areal’. The product list will update with areal FFG

products.

90. With FFG Mode set to Areal, choose The areal values display in the Hydroview
different Areal Types (Zone, County, Basin, | viewer based on the selected Areal Type
All) and select products to display for them. | filter and the selected product from the FFG

product list. The areal values display as
colored numbers. The colors of the numbers
correspond to the FFG color product legend.

91. With the ‘FFG Mode’ set to ‘Areal’, select The areal FFG values display for the
different durations from the ‘Dur FFG’ selected duration.
option and display FFG products for them.

92. With the ‘FFG Mode’ set to ‘Areal’, select a | The Areal FFG labels displayed on the
product from the list and test by Hydroview map are based on the toggle
selecting/deselecting the toggle buttons for | selection of the ‘ld" and ‘Value'. If ‘ld" is only
‘Id" and ‘Value’. selected then only Ids will be displayed. This

holds the same with ‘Value’ toggle button. If
both ‘Id" and ‘Value’ are selected then both
Ids and Values display.

93. MB1 click the ‘Clear’ button in the Flash The FFG data are cleared from the
Flood Guidance window. Hydroview geographic display.

94. MB1 click the ‘Close’ in the Flash Flood The Flash Flood Guidance window closes.
Guidance window.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

95. From the ‘LiveData’ pull-down menu, select | The Time Series Control window opens in
‘Time Series Graphs/Tables'. Station Selection mode with the station

selected inside the red square on the
Hydroview Display highlighted in the station
list.

96. MBL1 click the ‘Close’ button in the Time The Time Series Control window closes.
Series Control window.

97. From the ‘LiveData’ pull-down menu, select | The SSHP application launches for the
‘Site Specific Headwater Model'. selected station. If that station is not

configured for SSHP, an error dialog
appears. Select the ‘OK’ button to close the
dialog.

98. Select the ‘Exit Application’ push-button on | The SSHP application closes.
the SSHP Control window.

99. From the ‘LiveData’ pull-down menu, select | The Alert and Alarm Data Values window
‘Alert and Alarms Data’. opens. The scroll list shows the alert/alarm

data. Also details for the item that is
highlighted in the list will appear in the all
appropriate text areas that is below the
scroll list.

100. | Select different values for the show filter: The scroll list will have only forecast data if
‘All’ ‘Forecast’ is selected, only observed data if
‘Observed’ ‘Observed’ is selected and both observed
‘Forecast’ and forecast data if ‘All’ is selected.

101. | Select different values for the show filter: The scroll list will have only alert data if
‘Alert&Alarm’ ‘Alert’ is selected, only alarm data if ‘Alarm’
‘Alert’ is selected and both alert and alarm data if
‘Alarm’ ‘Alert/Alarm’ is selected.

102. | Select different values for the exceeding The scroll list will have only rate-of-change
filter: data if ‘Rate-Of-Change’ is selected, only
‘Any Limit data that has exceed upper limit if ‘Upper
‘Rate-Of-Change’ Limit' alarm is selected, only data that is
‘Upper Limit lower than the set lower limit if ‘Lower limit’
‘Lower Limit is selected and all exceeded data if ‘Any
‘Diff Limit' Limit' is selected.

103. | Select ‘Sort By Time'. The data in the scroll list is displayed with

their order sorted by validtime.

104. | Select ‘Sort By Location’. The data in the scroll list is displayed with

their order sorted by location id.

105. | Select any item from the scroll list and MB1 | A dialog asking confirmation to delete
click the ‘Delete’ button. appears. If you select ‘Yes', that item will be

deleted.

106. | Select ‘Tabular Time Series and Graphical | The Time Series Control window opens in
Time Series’ to bring up Time Series Station Selection mode with the selected
window. station highlighted.
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DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

107. | Select the ‘Close’ push-button on the Alert | The Alert and Alarm Data Values window
and Alarm Data Values window. closes.

108. | From the ‘LiveData’ pull-down menu, select | The Questionable and Bad Data window
‘Questionable and Bad Data’. opens. Scroll List showing the questionable

and bad data displays in the window. The qc
description for the item that is highlighted in
the list appears in the bottom QC
Description box.

109. | Select ‘Filter By Location’ and enter a The scroll list has only the data that is
location id. Press the Enter key on the pertaining to the location id provided. If there
keyboard after entering the location id. is not questionable and bad data found for

that location id, it will give the message
stating the data is unavailable.

110. | Select different values for element from the | The scroll list has only the data that is
available values: pertaining to the selection made. If
‘Height' Temperature is selected, only temperature
‘Temperature’ data is displayed and so on.

‘Ground’
‘Ice’

111. | Enter the number of days (say 11) in the The scroll list has the data that is pertaining
test box available for last days. to the past 11 days.

112. | Select ‘Sort By Location’. The scroll list has the data sorted based on

location id.

113. | Select ‘Sort By Time"'. The scroll list has the data sorted based on

observation time.

114, | Select ‘Sort By Shef Quality'. The scroll list has the data sorted based on

shef quality (the SQ column).

115. | Select ‘Sort By Quality Code’. The scroll list has the data sorted based on

quality code (the QC column).

116. | Highlight an item in the scroll list and MB1 | The item is set to have its value missing and
click ‘Set Missing'. the item is removed from the scroll list

displayed.

117. | Highlight an item in the scroll list and MB1 | The item is moved to rejecteddata table in
click ‘Delete Selected'. the database and the type field in the table

has its value as ‘M’ (meaning it is manually
sent to rejecteddata table and not through
shefdecode). The item is removed from the
scroll list displayed.

118. | Select ‘Tabular Time Series and Graphical | The Time Series Control window opens in
Time Series’ to bring up Time Series Station Selection mode with the selected
window. station highlighted.

119. | Select the ‘Close’ push-button on the The Questionable and Bad Data window
Questionable and Bad Data window. closes.

120. | From the ‘LiveData’ pull-down menu, select | The Data Trash Can window opens. The
‘Rejected Data Trash Can'. scroll list has the rejected data displayed.
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Step # Action Result Pass/Fail

121. | Select ‘Filter By Location’ and enter a The scroll list has only the rejected data that
location id. is pertaining to the location id provided.

122. | Select ‘Filter By Physical Element’ and The scroll list has only the rejected data that
select any physical element from the is pertaining to the physical element
physical element scroll list. selected.

123. | Uncheck the ‘Location’ toggle button. The scroll list has the data sorted based on
Select ‘Sort By Location'. location id.

124. | Select ‘Sort By Time'. The scroll list has the data sorted based on

observation time.

125. | Select the ‘Reject Type’ option to be either: | The scroll list has only the data that is
‘All manually rejected using the questionable
‘Auto’ and bad data window and MB1 clicking the
‘Manual’ ‘Delete Selected’ button if the reject type

option is ‘Manual'. The list will have only the
data that is entered into rejecteddata table
by shefdecode (automatic data) if the reject
type is ‘Auto’. The list will have both the
manual and auto data from the rejecteddata
table if the reject type option is ‘All’.

126. | Highlight an item in the scroll list and MB1 | The selected data are moved to its
click Move Selected to Data Tables'. respective data table and the entry is

removed from rejecteddata table.

127. | Highlight an item in the scroll list and MB1 | The selected data is deleted from the
click ‘Delete Selected'. rejecteddata table and the entry is removed

from the scroll list.

128. | MB1 click the ‘Delete All' button. A confirmation window appears asking
whether you want to delete all the data in
the Rejected Data Trash Bin. This will delete
all records from RejectedData table in the
database.

129. | Select ‘Close’ in the Data Trash Can The Data Trash Can window closes.

window.

130. | From the ‘LiveData’ pull-down menu, select | The Station Reporting Status window
‘Station Reporting Status/Latest opens, showing the station ID, the station
Observations’. name, when the last observation was made,

and when the latest data were received.
This window updates if the shef_post_latest
token is set to ‘ON’ in the
lawips/hydroapps/.Apps_defaults_site file.

131. | From the ‘List’ options, select ‘All Locations | This results in the display of all the location
With Latest Data’. with their latest data information in the scroll

list.

132. | From the ‘List’ option, select ‘Only The ‘Hours Ago’ command line becomes
Locations With Latest Data Older Than'. active.
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133. | Inthe ‘Hours Ago’ command line, type ‘12 | All stations which have not reported in last
Hours'. Then press the ‘Enter’ key on the 12 hours display.
keyboard.

134. | Inthe 'Sort’ option, select ‘By Time'. The list is sorted by Observation Time (2),

with the most recent time at the top.

135. | Inthe ‘Sort’ option, select ‘By Location’. The list is sorted by Location Id.

136. | In the Station Reporting Status window, The Latest Data for Selected Station list in
selected different stations in the top the bottom of the Station Reporting Status
window. window updates to display the latest data

elements received for that station. For
reference purposes, the current time field
updates to show the current time. Also,
information about the station’s telemetry and
dcp reporting status can also be seen in the
bottom of the window.

137. | Inthe Station Reporting Status window, The list of stations for which latest
select locations without any latest data. observation data is not found in the

database is shown in the scroll list.

138. | Select the ‘Close’ push-button on the The Station Reporting Status window
Station Reporting Status window. closes.

139. | From the ‘LiveData’ pull-down menu, select | The Point Precipitation Accumulations
‘Point Precipitation Accumulations’. window opens.

140. | Select the ‘Load Data’ push-button. Data is listed in the scrolled window based

on the criteria selected.

141. | The up and down arrow buttons are used to | Data is listed in the scrolled window based
change the date and time to specify the end | on the time and other criteria selected in the
time. Change the end time using the arrows | window.
and select ‘Load Data’.

142. | Select ‘Filter By HSA' button and select one | Data is listed based on the HSA selected in
or more item from the HSA scroll list and the scroll list and other criteria selected in
select ‘Load Data’. the window.

143. | Select the ‘Filter By Data Source’ button Data is listed based on the items selected in
and select one or more item from the ‘PC’ | the scroll list and other criteria selected in
or ‘PP’ scroll list. Then select ‘Load Data'. the window.

144. | Select option ‘Show Details’. Then select The summary has additional information
‘Load Data’. about the displayed data report in brief.
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Step # Action Result Pass/Fail

145. | Select option ‘Add PP Reports as Needed'. | The summary shows the PP summed

Select ‘Load Data’. values which (if not selected) would
otherwise be reported as MSG (missing) if
there is no direct report for the mentioned
duration window. The summed values are
nothing but the value obtained by adding all
PP reports available within that duration.
Also, if the ‘Show Details’ options is
selected, the reported summed PP values
shows (24.0s) at the end of the line, which
would have been (0.0s) meaning MSG if
there is no PP report and the ‘Add PP
Report As Needed' is deselected.

146. | Select ‘Sort By Location’. MB1 click the The report is sorted by the location id.

‘Load’ data button.

147. | Select ‘Sort by Value'. The report is sorted by their value with the
highest value in the top.

148. | Select ‘Other’ in the duration scroll listand | The report is based on the value supplied in

type a number (say 7) in the text box and the text box.

select load data. (No fraction values, even if | If there is any other item selected in the

providing only the whole number before the | duration scroll list (say 24) along with
decimal point, will be considered) ‘Other’, the report will have values for both
24hr and 7 hr durations.

149. | Select ‘By Location’ and enter a locationid | The report displays for the location id

in the text box provided. Then select the mentioned. The report has additional

‘Load Data’ button. information about the individual data
reported in the specified duration with their
reported time, quality code efc.

150. | Select ‘Save and Close.’ A window for choosing the directory and file
name to save the report appears. Specify
the filename along with its path. The report
is saved in that file.

151. | Select ‘Print’. The report is printed.

152. | Select the ‘Close’ push-button on the Point | The Point Precipitation Accumulations

Precipitation Accumulations window. window closes.
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153. | Select a station by double MB1 clicking on | The Station Profile window opens for the
a station in the map. From the ‘LiveData’ selected station.
pull-down menu, select ‘Station Profile’. The window has an elevation graph showing

the river stream on which the selected
station (gage) is located. It will also show
other stations (gages) that are located on
this stream. The graph also shows the latest
observation for any of the gages located on
the stream. The window has different
stations that are located on this stream
being listed on the station option. Upon
selection of any station from this station
option, the window shows its name, reach,
action and flood stage information.

154. | Select the ‘Close’ push-button on the The Station Profile window closes.

Station Profile window.

155. | From the ‘LiveData’ pull-down menu, select | The River Summary window opens. The list
‘River Summary'. of streams (rivers) displays in the scroll list.

156. | Select an item in the scroll list. A flood stage map displays for the selected

stream. This shows the flood, stage (red),
warning stage (yellow), action stage (green)
for all the stations located on this stream.
The graph also shows the value (blue) for
the station if available.

157. | Select different values for stage basis: The value (blue) color on the graph shows
‘Max Obs/Fcst’ the max of obs/fcst if the ‘Max Obs/Fcst’
‘Observed’ option is selected, the observed value if the
‘Forecast’ ‘Observed’ option is selected, or the

forecast value if the ‘Forecast’ option is
selected. The blue color does not appear if
the value is not found.

158. | Select the ‘Close’ push-button on the River | The River Summary program closes.
Summary program.

159. | Select a station by double MB1 clicking on | The Staff Gage window opens for that
a station in the map. From the station. The window has a graph that shows
‘ReferenceData’ pull-down menu, select the flood stage, action stage, warning stage,
‘Staff Gage'. record stage, minor stage, major stage,

bank full stage etc about the gage. The
window also shows the name, basin, state,
etc information for that station selected.

160. | Select the ‘Close’ push-button from the The Staff Gage window closes.
bottom of the Staff Gage window.

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/T010-0008 / 21 Nov. 2008 16

Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.
HARD COPY UNCONTROLLED




Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

161. | Select a station by double MB1 clicking on | The Impact Statement window opens for
a station in the map. From the that station. The impact window shows the
‘ReferenceData’ pull-down menu, select impact value, impact pe, begin date, end
‘Impact Statement Gage'. data, tendency of the impact in the scroll list

if data is found. On selecting an item in the
scroll list, the characteristics display for that
statement below the scroll list. The impact
also displays in the text box in the bottom of
the window.

162. | Select the ‘Cancel’ push-button from the The Impact Statement window closes.
bottom of the Impact Statement window.

163. | Select a station by double MB1 clicking on | The Low Water Statement window opens for
the station in the map. From the that station. The window shows a list of
‘ReferenceData’ pull-down menu, select lower and upper limits of a river physical
‘Low Water Statement’. element in the scrolled list in the top of the

window. Selecting an entry in this list shows
low water impact details in the information
block in the lower window.

164. | Select the ‘Close’ button on the Low Water | The Low Water Statement window closes.
Statement window.

165. | Select a station by double MB1 clicking on | The Rating Curve window opens for that
a station in the map. From the station. The window shows the rating curve
‘ReferenceData’ pull-down menu, select stage vs. flow graph. This graph is based on
‘Rating Curve’'. the shift value that is highlighted in the list

box at the bottom of the screen, which has
the shift value, shift data and its status
(active-T inactive-F). The window shows the
stage and discharge values in two different
scroll lists: one with shift value applied and
the other without shift value. The window
also shows the flood stage and record flood
stage on top of screen for the selected
station.

166. | Place the mouse at any point on the graph. | This results in showing the stage and flow
Click and hold MB1 and keep moving the (KCFS) values displayed on the top left
mouse. corner of the window. The value is in

correspondence to the mouse point on the
map.

167. | Select the ‘Close’ push-button from the The Rating Curve window closes.
bottom of the Rating Curve window.

168. | Select a station by double MB1 clicking on | The Data Sources window opens for that
a station in the map. From the station.

‘ReferenceData’ pull-down menu, select
‘Data Sources'.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

169. | Select different values for the type option: | The data pertaining to the station selected
‘Observer and the type selected displays. In case of
‘DCP’ the scroll lists shown, the applicable value
‘Telemetry’ for the station and type are highlighted.

170. | Select the ‘Close’ push-button from the The Data Sources window closes.
bottom of the Data Sources window.

171. | Select a station by double MBL1 clicking on | The Contacts window opens for that station.
a station in the map. From the The contact window specifies the contact
‘ReferenceData’ pull-down menu, select information for this station display in their
‘Contacts’. order of escalation (1- to be the highest in

the hierarchy in person of contact list for that
station) in scroll list. All the available contact
information for the item that is highlighted in
the scroll list is shown in the information
portion of the window.

172. | Select the ‘Close’ push-button from the The Contacts window closes.
bottom of the Contacts window.

173. | Select a station by double MB1 clicking on | The Crest History window opens for that
a station in the map. From the station. The window shows the stage vs.
‘ReferenceData’ pull-down menu, select year of occurrence map.

‘Crest History'.

174. | Choose different options for filter crests by | The map displayed changes accordingly
selecting the following options: and the data displayed in the right side of
Al the window also changes appropriately.
‘Above Action Stage’

‘Below Action Stage’

175. | MB1 click on an X’ on the map. The data displayed in the right side of the

window changes appropriately.

176. | Choose different options for the sort crests | The scroll list showing stage, flow, date and
by option: time is sorted based on date if ‘Date’ is
‘Stage’ selected, stage if ‘Stage’ is selected, or flow
‘Date’ if ‘Flow' is selected.

‘Flow’

177. | Select the ‘Close’ push-button from the The Crest History window closes.
bottom of the Crest History window.

178. | Select a station by double MBL1 clicking on | The E-19 Report window opens for that
a station in the map. From the station.

‘ReferenceData’ pull-down menu, select
‘Text Reports’.

179. | Scroll through the various types of reports | Different reports display as different report
in the Report option menu and try selecting | option items are selected.
them.

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0008 / 21 Nov. 2008 18

Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.
HARD COPY UNCONTROLLED




Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
180. | With report option menu at E-19, scroll Different reports display as different values
through the various values in page option selected for page option.
menu and try selecting them. (Page option
is shown only for E-19 report option.)
181. | Select a report option value to be sorted This shows the report of all the stations
station list. sorted based on location id.
182. | Change the sort by option to: The report of all the stations are sorted
‘Name’ based on the location name if ‘Name’ is
‘County’ selected, county if ‘County’ is selected,
‘Basin’ basin if ‘Basin’ is selected, or observer
‘Observer name if ‘Observer’ is selected.
183. | Select the report option value to be ‘Station | This shows the report of all the stations
Class'. detailing the station class information.
184. | Select report option value to be ‘Service This shows the report of all the stations
Backup'. detailing the list of stations sorted by station
id.
185. | Change the sort by option to: This shows the report of all the stations
‘Station’ sorted based on the station id if ‘Station’ is
WEQ’ selected, based on WFO if ‘WFO' is
‘HSA' selected, based on HSA if HSA' is selected.
186. | Select ‘Save'. A dialog showing the file name with the path
displays, asking for confirmation to save.
MBL1 clicking the report saves the file. If
cancel is selected, the dialog window
closes.
187. | Set the report option value to ‘E-19'. Select | The report content window displays.
‘Print’. The item prints.
Select the contents that are needed inthe | The window closes.
printed report. Then select ‘Print’ to print
the report. Select ‘Close’ to close this
window.
188. | Select the ‘Close’ push-button from the The Report window closes.
bottom of the Report window.
189. | From the ‘Product’ pull-down menu, select | The Product Viewer window opens.
‘Product Viewer'.
190. | From the ‘List’ option, select ‘Text Products | A list of products displays in the Product
in Database’. Information section.
191. | If any products appear in the Product The Product chosen display below.
Information section, select one.
192. | Select the ‘Close’ push-button from the The Product Viewer window closes.
bottom of the Product Viewer window.
193. | Zoom into an area of interest by using MB2 | The selected area of the map is enlarged
or the ‘Zoom’ and ‘Recenter’ tools from the | and shows a greater level of detai.
‘Tools’ menu.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
194. | MB3 click and hold on the Hydro The Hydro Perspective closes.
Perspective tab and select ‘Close’.
End of Hydroview Test
Start of Point Data Control Test
195. | In CAVE, Mouse Button (MB) 1 click on the | The Hydro Perspective displays in CAVE.
Perspectives icon and select ‘Hydro’ from
the dropdown menu if available. If not
available, select ‘Other...". Then select
‘Hydro’ from the Open Perspective dialog.
196. | From the ‘MapData’ pull-down menu, select | The Point Data Control window opens and
‘Point Data Control...". the stations display in the Hydroview main
window.
197. In the Presets/Query Mode Frame, MB1 The Ad Hoc radio button is red.
click on the Ad Hoc radio button
198. | Inthe Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘River’. * in the second combo hox (PE) depend on
what PE’s are in the ingestfilter (look for it
in Hydrobase) table with a value of ‘T’ for
*In the second combo box (PE), the PEs | the ingest column.
that appear are the same ones that are in
the ingestfilter table. This is true for Steps | Some of the common PEs are:
3-22. The elements that are listed in Action e Primary
Steps 3-22 display in the same order in the e HA-Reading Height
first combo box. For example: e HB - Depth below Sfc
* River e HC - Ceiling Height
e Ram e HD - Head Height
* Snow e HE - Regulating Gate
° el e HG - River Stage
e HI-Stage Trnd Indicator
e HP - Pool Elevation
e HQ - Distance to River
e HS - Spillwy Forebay El
e HT - Tailwater Elev
e QC - Runoff Volume
e QD - Canal Divers. Dsch
e QI -Inflow Discharge
e QR -River Discharge
e QT - Total Discharge
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
199. In the Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Rain’. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.
Some of the common PEs are:
e PCandPP
e PC Precip Accumulator
e PP Precip Increment
e PR Precip Rate
e PT Precip Type
200. In the Elements frame, MBL1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Snow'. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.
Some of the common PEs are:
e SA Areal Snowfall
e SD Snow Depth
e SF New Snowfall
e SR Snow Report
e SS Snow Density
e ST Snow Temp at Depth
e SW Snow Water Equiv
201. | Inthe Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Temperature’. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.
Some of the common PEs are:
o TA Air Temperature
e TB Soil Temp at Depth
e TD Dew Point Temp
e TE Air Temp at Elev
e TM Wet Bulb Temperature
o TP Panwater Temp
e TS Soil Temp at Sfc
e TV Veg Soil Temp
e TW Water Temperature
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Test Case Hydroview (Draft) DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
202. In the Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Agriculture’. in the second combo box (PE) depend on

what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e AD Reserved
e AF Sfc Frost Intensity
e AM Sfc Dew Intensity
e AT Time Below 25 deg F
e AU Time Below 32 deg F
o AW Leaf Wetness Time

203. | Inthe Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Evaporation’. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e EP Evap Pan Increment
e ET Evap Trans Total
e EV Evap Lake Computed

204. | Inthe Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘FishCount'. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e FS Steelhead Fish Count

205. In the Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Ground'. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e GD Frost Penetr Depth
e GR Frost Report
e GS Ground State
e GT Sfc Frost Thawed Dep
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Test Case Hydroview (Draft) DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
206. In the Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Ice’. in the second combo box (PE) depend on

what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e |C Ice Cover
e |E Extentoflce
IO Extent of Open Water

e [R Ice Report
e IT Ice Thickness
207. In the Elements frame, MBL1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Lake’. in the second combo box (PE) depend on

what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are;
e LA Lake Surface Area
e LS Lake Storage Volume

208. In the Elements frame, MBL1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Moisture’. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T for the ingest column.

Some of the common PEs are:
e Ml Moisture Index
e MM Wood Moisture
e MS Soil Moisture Amount
e MT Wood Temperature

209. In the Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘GateDam’. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e NN Spillway Gate Number
e NO Spec. Gate Opening
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step #

Action

Result

Pass/Fail

210.

In the Elements frame, MB1 click on the
first combo box and select ‘Pressure’.

In the Elements frame, the PEs that appear
in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
o PA Atmospheric Pressure
e PD 3-hour Press Change
e PE Press Characteristic
e PL Sea level Pressure

211.

In the Elements frame, MB1 click on the
first combo box and select ‘Radiation’.

In the Elements frame, the PEs that appear
in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e RI Incoming Radiation
e RP Possible Radiation
e RT Total Radiation Time
e RW Totl Solar Radiation

212.

In the Elements frame, MB1 click on the
first combo box and select ‘Weather’.

In the Elements frame, the PEs that appear
in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e XC Total Sky Cover
e XP Past Weather
e XR Relative Humidity
e XV Visibility
e XW Present Weather

Contract DG133W-05-CQ-1067 / DCN AWP.TE.SWCTR/TO10-0008 / 21 Nov. 2008
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this document.
HARD COPY UNCONTROLLED

24




Test Case Hydroview (Draft) DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
213. In the Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Wind'. in the second combo box (PE) depend on

what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e UC Accumulated Wind
e UD Wind Direction
e UG Wind Gust Speed
e UL Wind Travel Length
e UP Peak Wind Speed
e UQ Wind Direct & Speed
e UR Wind Dir at Peak Spd
e US Wind Speed

214. | Inthe Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘Power’. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e VB Battery Voltage
o VE Energy Gener Total

215. | Inthe Elements frame, MB1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘WaterQuality'. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
o WV Water Velocity

216. In the Elements frame, MBL1 click on the In the Elements frame, the PEs that appear
first combo box and select ‘YUnique’'. in the second combo box (PE) depend on
what PE’s are in the ingestfilter table with a
value of ‘T’ for the ingest column.

Some of the common PEs are:
e YA 15m Per Above Stage
e YC Random Rep Seq Num
e YF Forward Power

e YG
e YH
e Y|
e Y]
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
217. | Ifthe shef_procobs token value in the If the token value of shef_procobs is set to
Apps_defaults_site file is set to OFF, the ‘OFF’, the PEs that appear in the second
first combo box in the Elements frame will | combo box (PE) in the Elements frame
have an option called ‘Processed'. depend on what PE’s are in the ingestfilter
table with a value of ‘T’ for the ingest
If the token value is set to ‘ON’, the first column.
combo box will not have an option called
‘Processed’. Some of the common PEs are:
e |R Ice Report
e PP Precip Increment
e QR River Discharge
e S| Snow Depth on Ice
e TA Air Temperature
218. In the Value/Time frame, MB1 click on the | When the up arrow is clicked, the day is
up and down arrow of the first set of arrows | increased. For example, 2006-01-22 18:00
on the left side. changes to 2006-01-23 18:00.
When the down arrow is clicked, the day is
decreased. For example, 2006-01-23 18:00
changes to 2006-01-22 18:00.
219. In the Value/Time frame, MB1 click on the | When the up arrow is clicked, the hour is
up and down arrow of the second set of increased. For example, 2006-01-22 18:00
arrows on the right side. changes to 2006-01-22 19:00.
When the down arrow is clicked, the hour is
decreased. For example, 2006-01-22 19:00
changes to 2006-01-22 18:00.
220. | Inthe Value/Time frame, MB1 click on the | In the Value Is combo box, the default
‘Value Is’ combo box. value is Latest Value. The following options
are also available:
e Latest Value
e Value for Selected Time
e Min Value in Window
e Max Value in Window
o Value Change in Window
221, In the Elements frame, select ‘Temperature’ | When the check box next to the
in the first combo box on the left. ‘Type/Source’ button is checked, data
In the Elements frame, select ‘TA Air values display in the Hydroview GUI
Temperature’ in the second combo box on | displaying temperature data.
the right.
In the Filtering frame, MBL1 click on the
check box next to the button labeled
‘Type/Source’.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
222. | Inthe Filtering frame, MB1 click on the When the ‘Type/Source’ button is clicked, a
‘Type/Source’ button. window appears displaying type sources.
The list of type sources come from the
ingestfilter table. Some of the common
Type/Sources for Temperature are:
e RG GOES
e RZ Nonspecific Observed
223. | Inthe Type/Source popup window, MB1 If 'RG’ was selected, any values that have a
click on ‘RG GOES, if available. (If not type/source of ‘RZ’ disappear. Some of the
available, then select any single values displayed in the Hydroview GUI
type/source.) MB1 click on ‘Apply’. disappear. This occurs if there are some
Then MBL1 click on the ‘Close’ button. values displayed that have a Type/Source
of ‘RZ".
If a different type/source was selected, any
values that do not have that particular
type/source disappear from the GUI
When the ‘Close’ button is clicked, the
Type/Source popup window closes.
224. | Inthe Filtering frame, enable the checkbox | When the checkbox is checked, some
next to the ‘Service Area...” button. values displayed disappear from the GUI.
MBL1 click on the ‘Service Area...” button. When the ‘Service Area..." button is clicked,
Select the first HSA and make sure all of a window appears displaying a list of HSAs.
the other HSAs are unselected. When the first HSA is selected and the
MBI click ‘Apply’. ‘Apply’ button is clicked, the values
Then MB1 click the ‘Close’ button. displayed on the map are for stations
whose HSA is the same as the HSA the
user selected in the popup window.
When the ‘Close’ button is clicked, the
Service Area popup window closes.
225. In the Filtering frame, enable the checkbox | When the checkbox is checked, all of the
next to the ‘Data Source...” button. values displayed disappear from the GUI.
MBL1 click on the ‘Data Source..." button. When the ‘Data Source..." button is clicked,
Select two of the options which appear in a new window appears displaying a list of
the popup window (Observer and DCP) and | telem types. This list includes all of the
MB1 click ‘Apply’. telem types from the telmtypes table and as
Then MBL click the ‘Close’ button. well as ‘Observer’, ‘DCP’ and ‘undefined’.
When the first two options (‘Observer’ and
‘DCP’) are selected and the ‘Apply’ button
is clicked, some of the values display on
the GUI. The values that display have a
telem_type value of ‘Observer’ or ‘DCP’ in
the stnclass table.
When the ‘Close’ button is clicked, the
‘Data Source..." popup window closes.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

226. In the Elements frame, MB1 click on the left | When ‘River’ is selected in the left combo
combo box and select ‘River’. At the bottom | box in the Elements frame, the right combo
of the GUI, MB1 click on the ‘Map’ button. | box in the Elements frame is set to

‘Primary’. When the ‘Map’ button is clicked,
the GUI updates with river data for all the
stations not filtered out.

227. | Inthe Display frame, check the box labeled | The icons in the display change to 1 of 5
‘Color River Icons:'. colors:

e Light green - river stage/flow for
the station is below the
action/flood levels

o Yellow - river stage/flow for the
station is at or above the action
level but below the flood level

e Red - river stage/flow for the
station is at or above the flood
level

e Gray - stage/flow data could not
be retrieved for the station

e Dark green —the station has a
value but the action/flood stage
data are not available in the
RiverStatus table.

228. | Inthe Display frame, MBL1 click on the The values that display in the GUI are the
‘River Color/Value Based On:’ combo box | observed values for each station for that
and select ‘Observed Value'. particular date/time.

229. | Inthe Display frame, MB1 click on the The values that display in the GUI are the
‘River Color/Value Based On:’ combo box | largest forecast values for each station for
and select ‘Forecast Value'. each station for that particular date/time.

230. | Inthe Display frame, MB1 click on the The value that displays in the GUI for each
‘River Color/Value Based On:’ combo box | station is the maximum of the forecast or
and select ‘Max (Obs, Fcst)'. the observed value.

231. | Inthe Display frame, MB1 click on the The value that displays in the GUI for each
‘Display Values As:’ combo box and select | station is just the raw data value which
‘Raw Value'. comes from the database.

232. | Inthe Display frame, MBL1 click on the The values that display in the GUI for each
‘Display Values As:’ combo box and select | station are the raw data values and the
‘Raw Value/Flood Level'. flood stage. The flood stage/level is the

value of the fs field which is located in the
Riverstat table. If a flood stage/level is not
defined for a station, an ‘M’ displays above
the raw data value. The flood stage/level
value displays above the raw data value.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail

233. | Inthe Display frame, MB1 click on the The values that display in the GUI for each
‘Display Values As:’ combo box and select | station are the raw data values and a
‘Raw Value/Stage Flow'. derived stage or flow value. The derived

value is a flow if the raw value is a stage
and vice versa. If a derived value is not
defined for a station, an ‘M’ displays above
the raw data value. The derived value
displays above the raw data value.

234. | Inthe Display frame, MB1 click on the If the value is not missing, the value that
‘Display Values As:’ combo box and select | displays in the GUI for each station is the
‘Flood Depart’. current stage value minus the flood stage

value. This value is the Flood Stage
departure. If a flood stage is not defined for
a particular station, then the station data is
missing.

235. | Inthe Display frame, MB1 click on the The values that display in the GUI for each
‘Display Values As:’ combo box and select | station are the flood stage departure and
‘Flood Depart/Level'. the flood stage/level. The flood stage/level

displays on top of the flood depart value. If
a flood stage/level is not defined for a
particular station, then the station data is
missing.

236. | Inthe Display frame, MB1 click on the The Point Data Tabular Display appears
‘Display Values As:' combo box and select | showing all the stations not filtered out and
‘Raw Value'. the values that are currently displayed in
MBL click on the ‘Tabulate" button. the GUI.

237. | Inthe Point Data Tabular Display window, | When the ‘Time Series Graph’ button is
MBL1 click on the first station listed that has | clicked, the Time Series loads.
non-missing data. The time series for the selected station
MBL click on the ‘Time Series Graph'’ displays in a graphical format.
button and select ‘Graph’ button.

Close the Time Series Display and Control.

238. | Inthe Point Data Tabular Display window, | When the Time Series Table button is
MBL1 click on the ‘Time Series Table’ clicked, Time Series loads.
button. The time series for the selected station
Close the Time Series Tabular Time Series | displays in a tabular format.
and Control.

239. | Inthe Point Data Tabular Display window, | The data displayed in the table prints.

MBL1 click on the ‘Print’ button.
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Test Case Hydroview (Draft)

DCN AWP.TE.SWCTR/T010-0008

Step # Action Result Pass/Fail
240. | Inthe Point Data Tabular Display window, | When the ‘Save’ button is clicked, a dialog
MBL1 click on the ‘Save’ button. window appears allowing the user to
Enter ‘test_save.pdc’ in the ‘Selection’ specify a location and filename.
textbox. When the ‘OK’ button is clicked, the report
MBL1 click the ‘OK’ button. is saved to the file “test_save.pdc” in the
specified save directory
(awips/hydroapps/whfs/local/data/report).
The report contains data that is identical to
the data displayed in the Point Data
Tabular Display window.
241. | Inthe Point Data Tabular Display window, | The Point Data Tabular Display window
MB1 click on the ‘Close’ button. closes and control is returned to the Point
Data Control GUI.
242, In the Point Data Control GUI, MB1 click on | When the ‘Unmap’ button is clicked, all of
the ‘Unmap’ button. the values displayed in the Hydroview GUI
are removed (unmapped).
243. | Inthe Point Data Control GUI, MB1 click on | When the ‘Map’ button is clicked, all of the
the ‘Map’ button. station values that are currently not filtered
out are mapped to the Hydroview GUI. The
stations and data displayed are the same
ones that were displayed during Step 48.
244, In the Point Data Control window, MB1 click | The Point Data Control window closes.
on the ‘Close’ button.
245, MB3 click and hold on the Hydroview The Hydroview Perspective closes.
Perspective tab and select ‘Close’.
246.  Test - Time Step Mode
247. In CAVE, MBL1 click on the Perspectives The Hydro Perspective displays in CAVE.
icon and select ‘Hydro’ from the dropdown
menu if available. If not available, select
‘Other...". Then select ‘Hydro’ from the
Open Perspective dialog.
248. From the ‘MapData’ pull-down menu, The Point Data Control window opens and
select ‘Point Data Control...". the stations display in the Hydroview main
window.
249, In the Presets/Query Mode Frame, MB1 The ‘Time Step’ radio button is filled in. The
click on the ‘Time-Step’ radio button. GUI changes in the ‘Elements’,
‘Value/Time', ‘Filtering’ and ‘Display’
sections.
250. In the Elements frame, MBL1 click on the The available selections listed are:
first combo box, the ‘Element Type Combo | ‘River’, ‘Rain’, ‘Snow’, ‘Temperature’,
Box'. ‘Humidity’ and ‘Wind'.
251. In the Elements First Combo Box, select The selected element in the Elements
‘River'. Second Combo Box is ‘STAGE/POOL'.
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252. MBL click on the ‘Elements Second Combo | The available selections listed are:

Box’ (right one). ‘STAGE/POOL’, ‘FLOW/STORAGE',
‘DEPTH ABOVE FLOOD STAGE' and
‘PERCENT OF FLOOD FLOW.'.

253. In the Elements frame, MB1 click on the The selected element in the Element
‘Element Type Combo Box’ (left one) and | Combo Box is INSTANTANEOUS'.
select ‘Rain’.

254. MBL1 click on the ‘Element Combo Box’ The available selections listed are:

(right one). ‘INSTANTANEOUS', ‘1-HOUR PRECIP
TOTAL', ‘3-HOUR PRECIP TOTAL', ‘6-
HOUR PRECIP TOTAL' and ‘24-HOUR
TOTAL (122).

255, In the Elements frame, MBL1 click on the The selected element in the Element
‘Element Type Combo Box’ and select Combo Box is ‘SNOW WATER EQUIV'.
‘Snow’.

256. MBL1 click on the ‘Element Combo Box’ The available selections listed are:

(right one). ‘SNOW WATER EQUIV' and ‘SWE - 24
HOUR CHANGE'.

257. In the Elements frame, MBL1 click on the The selected element in the Element
‘Element Type Combo Box' and select Combo Box is TEMPERATURE'.
‘Temperature’.

258. MB1 click on the ‘Element Combo Box’ The available selections listed are:

(right one). ‘TEMPERATURE’, ‘TEMP. 24 HOUR
CHANGE', ‘MAX TEMP’ and ‘MIN TEMP'.

259. In the Elements frame, MBL1 click on the The selected element in the Element
‘Element Type Combo Box’ and select Combo Box is ‘DEWPOINT'.

‘Humidity'.

260. MB1 click on the ‘Element Combo Box’ The available selections listed are:

(right one). ‘DEWPOINT’, ‘DEWPT - 24 HR CHANGE'
and ‘RELATIVE HUMIDITY".

261. In the Elements frame, MBL1 click on the The selected element in the Element
‘Element Type Combo Box’ and select Combo Box is ‘WIND SPEED'.

‘Wind'.

262. MBL1 click on the ‘Element Combo Box’ The available selections listed are:

(right one). ‘WIND SPEED’ and ‘WIND DIRECTION'.

263. In the Value/Time frame, MB1 click on the | When the up arrow is clicked, the day is
up and down arrow of the first set of arrows | increased. For example, 2006-01-22 18:00
on the left side. changes to 2006-01-23 18:00.

When the down arrow is clicked, the day is
decreased. For example, 2006-01-23 18:00
changes to 2006-01-22 18:00.
The data displayed on the Map changes.
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264, In the Value/Time frame, MB1 click on the | When the up arrow is clicked, the hour is
up and down arrow of the second set of increased. For example, 2006-01-22 18:00
arrows on the right side. changes to 2006-01-22 19:00.
When the down arrow is clicked, the hour is
decreased. For example, 2006-01-22 19:00
changes to 2006-01-22 18:00.
The data displayed on the Map changes.
265. In the Elements section, choose the When the ‘Type/Source’ button is clicked, a
‘Temperature’ element type. window appears displaying type sources.
The list of type sources come from the
In the Filtering frame, make sure the ingestfilter table. Some of the common
‘Type/Source’ check box is checked. Type/Sources for Temperature are:
e GOES-RG
MBL1 click on the ‘Type/Source..." button. e LARC-RP
e SNOTEL -RM
e ALERT-RR
e METAR-RZ
266. In the Type/Source popup window, MB1 If 'RG’ was selected, any values that have a
click on ‘GOES - RG'. Then MB1 click on | type/source of ‘RZ’ disappear. (Verify by
‘Apply’. turning on the Display Section’s Param
Code button.) Some of the values
displayed in the Hydroview GUI disappear.
This occurs if there are some values
displayed that have a Type/Source of ‘RZ".
267. MBL1 click the ‘Close’ button in the The Type/Source dialog closes.
Type/Source dialog.
268. In the Filtering frame, enable the checkbox | If the associated checkbox is checked,
next to the ‘Service Area..." button. some values displayed disappear from the
MB1 click on the ‘Service Area...' button. | GUI.
Select the first HSA and make sure all of When the ‘Service Area..." button is clicked,
the other HSAs are unselected. a window appears displaying a list of HSAs.
MBL1 click on ‘Apply’. When the first HSA is selected and the
‘Apply’ button is clicked, the values
displayed on the map is for stations whose
HSA is the same as the HSA the user
selected in the popup window.
2609. MBL1 click ‘Close’ in the Service Area The Service Area dialog closes.
dialog.
270. In the Elements section, select the ‘RIVER’ | In the Filtering Section, there appears a
Element Type. ‘Stations:” option menu with ‘All" as the
default.
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271. In the Filtering Section, deselect all Only plain stream locations display.
Type/Source and Service Area checkboxes | Triangles with NO rectangles are plain
(to make sure that stations are not stream locations.
unnecessarily being filtered out).
In the Display Section, check the ‘Icon’
checkbox.
Choose the ‘Stream’ option under the
‘Stations’ option in the Filtering section.
272. In the Filtering Section, select the Only standard reservoir locations display.
‘Reservoir’ option. Triangles with rectangles under them
represent reservoirs.
273.  Test - Common Filter and Display Options Procedure
274. | Inthe Filtering frame, uncheck the ‘Show Only Forecast points display. A station is a
NonFcstPts’ checkbox. forecast point if the station’s entry in the
StnClass table has the character F in its
disp_class field. A forecast point has a
circle on top of the triangle.
275. | Check the ‘Show NonFcstPts’ checkbox. All points that were filtered out from the
previous steps are displayed.
276. | Inthe Filtering frame, uncheck the ‘Show Only stations with non-missing values
Missing’ checkbox. display in the GUI.
277. | Check the ‘Show Missing’ checkbox. Stations with missing values display in the
GUI (with ‘M’ for the value if that displays).
278. | Inthe Filtering frame, enter 25’ in the When the ‘Show Pts With:" combo box is
textbox next to the ‘Value' combo box. set to ‘Value >=', any value that is greater
MB1 click on the ‘Value’ combo box and than or equal to 25 displays in the GUI.
select ‘Value >=", When the ‘Value’ combo box is set to
MB1 click on the ‘Value’ combo box and ‘Value <=, any value that is less than or
select ‘Value <='. equal to 25 displays in the GUI.
In the Filtering frame, MBL1 click on the When the ‘Value’ combo box is set to ‘Any
‘Value’ combo box and select ‘Any Value'. Value', all data values that are not filtered
out display again in the GUI.
279. | Enter ‘100’ in the textbox next to the ‘Elev’ | When the ‘Elev’ combo box is set to ‘Elev
combo box. >=', any station that has an elevation
MBL1 click on the’ Elev’ combo box and greater than or equal to 100 display in the
select ‘Elev >=". GUL
MBL1 click on the ‘Elev’ combo box and When the ‘Elev’ combo box is set to ‘Elev
select ‘Elev <='. <=', any station that has an elevation less
MB1 click on the ‘Elev’ combo box and than or equal to 100 display in the GUL.
select ‘Any Elev'. When the ‘Elev’ combo box is set to ‘Any
Elev', all data values that are not filtered out
display again in the GUI.
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280. In the Display frame, check and uncheck When a box for a data element is checked,

the following buttons. that data element display on the map.

‘Value, Id, Name, Icon Name’ A maximum of one of ‘Time’, ‘Elevation’, or

‘Time, Elevation, Param Code’ ‘Param Code’ can be selected at a time.
The rest of the buttons can be selected in
any combination.

281. | MBI click on the ‘Tabulate’ button. The Point Data Tabular Display appears
showing all the stations not filtered out and
the values that are currently displayed in
the GUI.

282. | Inthe Point Data Tabular Display window, | When the ‘Time Series Graph’ button is

MBL1 click on the stations that have non- clicked, the Time Series loads. The time
missing values. series for the selected station displays in a
MBL1 click on the ‘Time Series Graph’ graphical format.
button.
Close the Time Series Display window.
283. | Inthe Point Data Tabular Display window, | The data displayed in the table prints.
MBL1 click on the ‘Print’ button.
284. | Inthe Point Data Tabular Display window, | When the ‘Save’ button is clicked, a dialog
MBL1 click on the ‘Save’ button. window appears allowing the user to
Enter ‘test_save.pdc’ in the ‘Selection’ specify a location and filename.
textbox. When the ‘OK’ button is clicked, the report
MBL1 click on ‘OK’. is saved to the file ‘test_save.pdc’ in the
specified save directory
(awips/hydroapps/whfs/local/data/report).
The report contains data that is identical to
the data displayed in the Point Data
Tabular Display window.
285. | Inthe Point Data Tabular Display window, | The Point Data Tabular Display window
MB1 click on the ‘Close’ button. closes and control is returned to the Point
Data Control GUI.
286. | Inthe Point Data Control GUI, MB1 click on | When the ‘Unmap’ button is clicked, all of
the ‘Unmap’ button. the values displayed in the Hydroview GUI
are removed (unmapped).
287. | Inthe Point Data Control GUI, MB1 click on | When the ‘Map’ button is clicked, all of the
the ‘Map’ button. station values that are currently not filtered
out are mapped to the Hydroview GUI.
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Action

Result

Pass/Fail

288.

Set the following options. Apply and close
filter dialogs as needed.

In the Presets/Query Mode frame,
the ‘Query Mode' is set to ‘Ad
Hoc'.
In the Elements frame, the
‘Element Type’ (left) combo box is
set to ‘River’.
In the Elements frame, the
‘Element’ (right) combo box is set
to ‘Primary’.
In the Value/Time frame, the
‘Value Filters’ combo box is set to
‘Latest Value'.
In the Filtering frame, the
‘Type/Source’ button is
unchecked.
In the Filtering frame, the ‘Service
Area...’ checkbox is checked.

0 Select the first HSA.
In the Filtering frame, the ‘Data
Source...’ checkbox is checked.
In the ‘Data Source...’, the dialog
box is set to select ‘Observer
Only'.
In the Filtering frame, the ‘Show

NonFcstPts’ checkbox is checked.

In the Filtering frame, the ‘Show
Missing’ checkbox is unchecked.
In the Filtering frame, the two
Show Pts with combo boxes are
set to ‘Any Value’ and ‘Any Elev'.
The corresponding text boxes are
desensitized.

In the Display frame, the ‘Value’,
‘ID" and ‘Icon’ checkboxes are
checked.
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Pass/Fail

289.

Continued from step 92:

Set the following options. Apply and close
filter dialogs as needed.

e The ‘Name’ checkbox is
unchecked.

¢ Inthe Display frame, the ‘Time’
and ‘Elevationand Param Code’
radio buttons are unchecked.

e Inthe Display frame, the ‘Color
River Icons’ checkbox are
checked.

¢ Inthe Display frame, the ‘River
Color/Value Based On:' combo
box is set to ‘Max(Obs, Fcst)’

o Inthe Display frame, the ‘Display
Values As:’ combo box is set to
‘Raw Value'.

e Inthe Point Data Control GUI,
MB1 click on the ‘Save..." button.

The Save Present Options dialog appears.

290.

Enter ‘test_set’ in the ‘Uniqueld:’ textbox
under the New Information section.
Enter ‘test option set’ in the ‘Description:’
textbox.

Enter ‘2" in the ‘Rank:’ textbox.

MB1 click on the ‘Ok’ button.

When the 'Ok’ button is clicked, the Save
Preset Options dialog box closes and the
option set is saved to the pointdatapresets
table in the IHFS database.

291,

In the Point Data Control window, MB1 click
on the ‘Close’ button.

MB3 click and hold on the Hydroview tab.
Select ‘Close’.

The Point Data Control GUI and Hydroview
Perspective close.

292.

MBL1 click on the Perspectives icon and
select ‘Hydro’ from the dropdown menu if
available. If not available, select ‘Other...".
Then select ‘Hydro’ from the Open
Perspective dialog.

The Hydro Perspective displays in CAVE.

293.

From the ‘MapData’ pull-down menu, select
‘Point Data Control...".

The Point Data Control window opens and
the stations display in the Hydroview main
window.
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294. | Inthe Presets/Query Mode frame, change | When ‘test option set’ is selected in the
the value of the ‘Selected Preset:’ combo ‘Selected Preset:’ combo box, all of the
box to ‘test option set'. following is set in the GUI:
o Inthe Presets/Query Mode frame,
the ‘Selected Preset:’ combo box
displays ‘test option set'.
e The other settings are the same
as mentioned in Action Steps 92
and 93.
295. | Inthe Presets/Query mode frame, MB1 When the ‘Delete’ button is clicked, the
click on the ‘Delete’ button. preset is deleted and removed from the
pointdatapresets table upon the relaunch of
Hydroview.
296. In the Point Data Control window, MB1 click | When the ‘Close’ button is clicked, the
on the ‘Close’ button. Point Data Control GUI closes.
297. | Exit the Hydroview Perspective. The Hydroview Perspective closes.
End of Point Data Control Test
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5.0

REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number

Description

Test Step(s)

SYSR

TBD

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR

SYSR
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1.0 SCOPE
See TO10 Software Test Plan.
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20 APPLICABLE DOCUMENTS

2.1 Source Documents
e None.

2.2 Reference Documents

e Legacy NWS Test Cases: Baseline_Hydrobase (OB8.3);
Baseline_Hydrobase _OB8.1; Hydrologic Database;
Check _Out_4.4.1 Hydrobase OB8.1.

e Software Test Plan for the Advanced Weather Interactive Processing System
Project, Contract #DG133W-05-CQ-1067, January 2009.

e The Silver Spring NWS AWIPS 1 test bed application.
e Rational RequisitePro.
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3.0 TEST CASE DESCRIPTION

This test case demonstrates that AWIPS provides the capability to execute the WFO Hydrologic
Forecast System (WHFS) Hydrologic Database Manager (HydroBaseMgr). Hydrobase allows a
WFO to manage the IHFS database that supports hydrologic forecasting.

3.1  Assumptions, Constraints, and Preconditions
e TO10 software has been installed successfully.
e CAVE, EDEX and pgAdmin Il are running.
e Data has been ingested .

e Actions, Results, and Requirements highlighted in yellow indicate
requirements and/or capabilities to be included in the scope of future task
orders. They are included here for purposes of continuity and traceability with
the original AWIPS 1 test case documents.

3.2 Recommended Hardware
See TO10 Software Test Plan.

3.3  Test Inputs

Section 4.0 contains the test procedures for this test case. Sections 2.2 — 2.9 of the TO10
Software Test Plan contain general test inputs applicable to all TO10 test cases.

3.4  Test Outputs
The results outlined in section 4.0 are met.
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4.0 TEST SCENARIO
Step # Action Result Pass/Fail
1. In CAVE, Mouse Button (MB) 1 click on the | The Hydro Perspective displays in CAVE.
Perspectives icon and select ‘Hydro’ from
the dropdown menu if available. If not
available, select ‘Other...". Then select
‘Hydro’ from the Open Perspective dialog.
2. Under the ‘HydroApps’ menu, select the The HydroBase window opens, listing all of
‘Launch Hydrobase..." option. the forecast points in the site-specific
database for the WFO.
3. From the ‘Sort By’ option, select each of the | The list is sorted according to the criteria
following options in succession: selected.
‘Station’
‘Name'
‘State, County’
4, Search for a station (e.g., BLUC1) by using | As each letter is added, the search is further
the Search box in the lower right side of the | defined.
panel.
5. Select ‘Add Location’ from the Location The Add Location window opens with a
menu. template to add new locations. The Add
Location window is on the Geophysical
Page option.
6. Add a new location named ‘AWIP2’. See None.
Appendix (end of document) image 1 for
input.
7. Select ‘Apply’ and ‘OK'. The new location is added to the listing of
forecast points in the HydroBase window.
8. Select ‘Modify Location’ from the Location The Modify Location window opens with
menu. [See App. A, Fig. 1] the data just entered.
9. Select Cancel. Window closes.
10. Select Contacts from the Location menu. The Contacts window opens.
11. MB1 click on New. Add the Contact and Contacts are added.
Phone information shown in Appendix
image 2. Then MBL click on ‘Apply'. NOTE: Select New before each entry and
Apply after each entry.
12. Select Ok to close the window. Window closes.
13. Reopen the window by selecting Contacts Contacts are there. The window closes.
from the Location menu to verify that the
information was added. Then select ‘Close’.
[See App. A, Fig. 2]
14, From the River Gage menu, select ‘River The River Gage window opens.

Gage'.
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Step # Action Result Pass/Fail
15. With the ‘Page’ option set to ‘Geophysical’, | See Appendix image 3.
add information to this window from
Appendix image 3. NOTE: Application may crash if the Date of
Rating field is left blank with the Page option
set to Additional Info (DR #19887).
16. Select ‘Apply’ and ‘OK’ to close the window. | The data is added and window closes.
17. Select ‘River Gage’ under the River Gage The data is verifies as saved on the system.
menu to reopen it. Verify that the information
was added. [See App. A, Fig. 3]
18. Select ‘Cancel'. The window closes.
19. From the ‘River Gage’ menu, select ‘Crest The window opens.
History’ to display the Crest History window.
20. MB1 click ‘New'. Add information to this See Appendix Image 4 and Image 5.
window from Appendix Image 4 and Image
5. Then MBL click on ‘Apply". NOTE: Select ‘New’ before each entry and
‘Apply’ after each entry.
21. Select ‘OK’ to close the window. Information is saved and the window closes.
22. Select ‘Crest History’ from the ‘River Gage' | The data is verified as saved and the
menu to verify that the information was window closes.
added. Then select ‘Close’. [See App. A,
Figures 4 and 5.]
23. From the ‘Location’ menu, select The County/Zone UGC window opens. This
‘County/Zone UGC'. window contains counties affected for the
forecast point plus all of the available
counties in the area.
24, Add information to this window by selecting | The data is added.
the county names in the ‘Available’ section
and selecting the ‘Add’ button.
25. Select ‘Apply’ and ‘OK’ to close the window. | The data saved and the window closes.
26. Select ‘County/Zone UGC’ from the The data is verified as saved.
‘Location’ menu to reopen the window.
Verify that the information was added.
27. Select ‘Cancel'. The window closes.
28. Select ‘Flood Category’ from the ‘River The Flood Category window opens, showing
Gage' menu. definitions of the following flood types:
Major, Moderate, and Minor.
29. Add information to this window from The data is added.
Appendix image 6.
30. Select 'OK’ to apply and close the window. | The data is saved and the window closes.
31 Select ‘Crest History’ from the ‘River Gage’ | The flood stage categories are depicted as
menu. [See App. A, Figure 6.] colored lines (See Image 7 in the Appendix
for an example).
32. Select ‘Close’. The window closes.
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Step # Action Result Pass/Fail
33. From the ‘River Gage’ menu, select the The Impact Statement window opens with
‘Impact Statement’ option. [See App. A, Fig. | the following types of information: Impact
7] Value, Impact PE, Begin, End, and
Tendency.
34. MB1 click on ‘New’. Add information to this | The data is added.
window from Appendix image 8. Then MB1
click on ‘Apply". NOTE: Select ‘New’ before each entry and
‘Apply’ after each entry.
35. Select ‘'OK’ to close the window. The data is saved and the window closes.
36. Select ‘Impact Statement’ from the ‘River The data is verified as saved and the
Gage’ menu to verify that the data were window closes.
added. Then select ‘Cancel’. [See App. A,
Fig. 8]
37. Select a Reservoir in the Hydrologic The station is selected.
Database.
BDBC1 is an example of a reservoir on Note: Point Data Control on Hydroview may
TBDW, WINC3 on TBW3. Other systems be used to locate other reservoirs.
will have other stations selected.
38. Select ‘Reservoir’ from the ‘Reservoir’ The Reservoir window opens with
menu. information on the selected reservoir.
39. Select ‘Cancel'. The window closes.
40. From the ‘Setup’ on the menu bar option The Reference Fields window opens
(right side of menu bar, next to Help), select | containing a ‘Fields’ option and ‘Add’,
the ‘Reference Fields’ option. ‘Update’, and ‘Delete’ buttons.
41. Select ‘OK’ from the Reference Fields The window closes.
window.
42. Select ‘AWIP2’ from the HydroBase window. | ‘AWIP2' is selected.
43. Select ‘Rating Curve’ from the ‘River Gage’ | The Rating Curve window opens. Verify that
menu. flood stage is a red line and the record flood
stage is a blue line.
44, Select ‘Close’. The window closes.
45, Select ‘Flood Report’ from the ‘Reports’ The Flood Report window opens with a flood
menu. report for the Area of Responsibility.
46. Select ‘Last 12 Months’ from the ‘Reporting | A graphic history of flooding displays.
Period’ option.
471. Select ‘Close’ from the Flood Report The window closes.
window.
48. Select ‘AWIP2’ from the listing of forecast The Data Ingest Filter window opens.

points, and select ‘Ingest Filter' from the
‘Data Ingest’ menu.
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Test Case Hydrobase (Draft)

DCN AWP.TE.SWCTR/T010-0009

Step # Action Result Pass/Fail

49. Select ‘New'. In the ‘NEW Item’ section, add | The data is added.

the following:

Location: AWIP2

Physical Element : HT Tailwater Elev
Duration: Instantaneous (0)

TypeSource: GOES (RG)

Extremum: Null Character (2)

Also, toggle on the ‘Master Switch’ button.

50. Select ‘Apply’. ‘AWIP2' appears highlighted in the Ingest
Filter Contents for Locations section.

ol Select ‘OK'. The window closes.

52. In the HydroBase window, select ‘Station The Station List Filter Options window

List Filter Options’. opens.

53. Select an HSA under ‘Filter by HAS'. The item is selected.

54. Select ‘Apply’. The stations in the HydroBase window are
filtered. Only stations in counties with the
selected responsible WFO are shown.

95. Select ‘Exit’ from the ‘File’ menu of the The HydroBase window closes.

HydroBase window.
End of Test
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50 REQUIREMENTS VERIFICATION TRACEABILITY MATRIX (RVTM)

Number Description Test Step(s)

SYSR TBD

SYSR

SYSR

SYSR
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APPENDIX A. FIGURES

e Add Location

Figure 2. Step 13
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